
User Manual

Dynamix 2500 Data Collector
Catalog Numbers  1441-DYN25, 1441-DYN25-Z



Important User Information
Solid-state equipment has operational characteristics differing from those of electromechanical equipment. Safety 
Guidelines for the Application, Installation and Maintenance of Solid State Controls (publication SGI-1.1 available from 
your local Rockwell Automation sales office or online at http://www.rockwellautomation.com/literature/) describes some 
important differences between solid-state equipment and hard-wired electromechanical devices. Because of this difference, 
and also because of the wide variety of uses for solid-state equipment, all persons responsible for applying this equipment 
must satisfy themselves that each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Allen-Bradley, Rockwell Software, Rockwell Automation, Dynamix, Enpac, Emonitor, Datapac, and TechConnect are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, 
property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the 
consequence

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that 
dangerous voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that 
surfaces may reach dangerous temperatures.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

http://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf
http://www.rockwellautomation.com/literature/


Summary of Changes

This manual contains new and updated information. Changes throughout this 
revision are marked by change bars, as shown to the right of this paragraph.

New and Updated 
Information

This table contains the changes made to this revision.

Topic Page

Calibration 27

Updating the Operating System 34
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Preface

This manual covers the Dynamix™ 2500 data collector module which is used for 
predictive maintenance using noise and vibration analysis.

When using the Dynamix 2500 data collector, you can do the following:
• Create lists of measurement definitions.
• Load lists from Emonitor® into the Dynamix 2500 data collector.
• Use an 80 Khz fmax, Route and Offroute.
• Collect magnitude, process, spectrum, time, and phase data.
• View selected alarms.
• Select inspection codes to store with a measurement.
• Define and collect unscheduled measurements
• Unload the data from the Dynamix 2500 data collector directly into the 

Emonitor database.
• View the high resolution, up to 25,600 lines on the data collector.

Optional Extension 
Modules

These are the optional extension modules for the Dynamix 2500 data collector:

• 1441-DYN25-4C, 4-Channel Activation (1)

The 4-channel activation lets you take 3 and 4 channel magnitude, time 
waveform, spectra, and Offroute measurements.

• 1441-DYN25-MBMP Bump Test 
A bump test (or hammer test) determines the natural frequencies of a 
machine or a structure. 

• 1441-DYN25-MBAL Balancing 
Balancing application resolves single-plane, two-plane, and static-couple 
balances with high precision. 

• 1441-DYN25-MFRF Frequency Response Function 
The FRF test lets you determine the natural frequencies of a machine as 
well as sophisticated information about the frequency response of the 
structure being tested.

• 1441-DYN25-MREC Time Recorder 
The Time Recorder test uses a the instrument as a data recorder for real-
time data acquisition and analysis. 

• 1441-DYN25-MRUC Run Up Coast Down 
The RUCD test records and analyzes data from intermittent events and 
transient vibration signals from non-steady state machines.

See Additional Resources on page 12 for a listing of available publications.

(1) This is an activation license for the Dynamix 2500 data collector.
Rockwell Automation Publication 1441-UM001B-EN-P - September 2012 9



Preface
Dynamix 2500 Data 
Collector and the Emonitor 
Software

The terminology in the data collector and the software differ in several ways. 
This table illustrates the differences.

Software Compatibilities The Dynamix 2500 data collector requires the following software versions.

USB Driver and Communication Software
• USB communication with Microsoft Windows 2000 and Windows XP is 

supported using Microsoft ActiveSync software version 4.5 or greater
• USB communication with Microsoft Windows 7 is supported using 

Microsoft Mobile Device Center
• Microsoft Windows 7 32 bit and/or Microsoft Windows 7 64 bit are 

supported

Operating System
• Microsoft Windows 2000 (SP4) with ActiveSync software 
• Microsoft Windows XP (SP3) with ActiveSync software
• Microsoft Windows 7 with Mobile Device Center software installed

Document Conventions These are document conventions used in this manual.

• The Dynamix 2500 data collector is referred to as a data collector and an 
instrument in this manual.

• The different versions of the Emonitor software are Enterprise, Factory, 
and Workstation. These are all are referred to as the Emonitor software in 
this manual.

• The Emonitor software screen captures are from version 3.4 and reference 
the Enpac 2500 data collector. The next version of the Emonitor software 
and this manual will reflect the name Dynamix 2500 data collector.

Table 1 Terminology Differences 

Dynamix 2500 Terminology Emonitor Terminology

Offroute
Measurements that are taken but are not 
downloaded on to the instrument from Emonitor.
These measurements can be upload to Emonitor.

Unscheduled measurements
Measurements that are not defined in the list of 
measurements downloaded by Emonitor. 
These measurements are unscheduled.

Route
The Dynamix 2500 data collector uses the term 
route’ to refer to a list loaded in the data 
collector.

List
The Emonitor software uses the term ‘list’ for an 
ordered set of measurement definitions. 
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Preface
Using Online Help The Emonitor software and the Dynamix 2500 data collector each include online 
help:

• Emonitor Online Help
The Emonitor online help is available from the Emonitor Help menu or by 
pressing F1. 

• Dynamix 2500 Online Help
The Dynamix 2500 data collector online help is available from any screen 
where the Help function appears. Press F1 (Help) to access the online help. 
On some screens that do not display the Help function, pressing Shift(0) 
provides access also to the Help. 

Help Screen

Press F1 (Help) to access online help from any screen where the Help function is 
displayed on the screen. 

1. Press F1 (Help) to access the online help. 

The Help Contents screen appears. 

2. Select the topic for which you want to view and press F1 (Goto). 

3. When you are finished viewing the topic, press F1 (Contents) to return to 
the Help Contents screen or press F4 (Esc) to exit the online help. 

To highlight a topic, use the 
Up or Down arrows.
Rockwell Automation Publication 1441-UM001B-EN-P - September 2012 11



Preface
Additional Resources These documents contain additional information concerning related products 
from Rockwell Automation®. 

You can view or download publications at
http://www.rockwellautomation.com/literature. To order paper copies of 
technical documentation, contact your local Allen-Bradley® distributor or 
Rockwell Automation sales representative.

Resource Description

Bump Test Extension Module for the Dynamix 2500 
Data Collector User Manual,
publication 1441-UM002

Describes how determine natural (or resonant) 
frequencies of a machine or structure. 

Frequency Response Function Extension Module 
for the Dynamix 2500 Data Collector User Manual, 
publication 1441-UM003

Describes how to determine the natural 
frequencies of a machine or structure using 
modal hammer.

Balancing Extension Module for the Dynamix 2500 
Data Collector User Manual,
publication 1441-UM004

Describes the direct method to balance your 
rotating machinery in one or two planes.

Time Recorder Extension Module for the Dynamix 
2500 Data Collector User Manual, 
publication 1441-UM005

Describes how to use the data collector as a 
data recorder for real-time data acquisition, 
post processing, and analysis.

Run Up Coast Down Extension Module for the 
Dynamix 2500 Data Collector User Manual, 
publication 1441-UM006

Describes how to record and analyze data from 
intermittent events and transient vibration 
signals from nonsteady state machines.

Emonitor User’s Guide, publication
EMONTR-UM001

Describes data management for predictive 
maintenance services.

Dynamix 2500 Data Collector Kit Release Notes, 
publication 1441-RN001

Provides important information on the latest 
updates, for example, firmware, certifications, 
warnings, and hardware changes for the data 
collector.

Dynamix 2500 Data Collector Optional Extension 
Modules Release Notes, publication 1441-RN002

Provides important information on how to 
install the Optional Extension Modules onto 
the Dynamix 2500 data collector.

Industrial Automation Wiring and Grounding 
Guidelines, publication 1770-4.1

Provides general guidelines for installing a 
Rockwell Automation industrial system.

Product Certifications website, http://www.ab.com Provides declarations of conformity, 
certificates, and other certification details.
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Chapter 1

The Dynamix 2500 Data Collector 

This chapter describes the Dynamix 2500 data collector and explains the 
instrument’s basic and configuration and operation.

The Dynamix 2500 data collector is a real-time multi-channel Fast Fourier 
Transforms (FFT) analyzer and data collector for predictive maintenance and 
machinery vibration diagnostics. It is capable of measuring, processing, displaying 
and storing a wide range of analysis functions. It can operate as a stand alone 
instrument or you can download your measurements to your software application 
for program analysis. 

The combination of the Dynamix 2500 data collector with the Emonitor 
software provides you with the tools for predictive maintenance using noise and 
vibration analysis. The data collector can be used for a variety of other 
applications also, such as balancing or bearing analysis.

A predictive maintenance program helps you decide when equipment needs to be 
serviced or replaced. Part of a complete predictive maintenance program includes 
vibration monitoring. The Emonitor software and the Dynamix 2500 data 
collector let you to perform vibration analysis by collecting data samples.

Topic Page

Safety Information 15

Parts of the Dynamix 2500 Data Collector 17

External Connections 19

Connector A and Connector B Inputs 19

Using the Headphones 20

Connecting to the External Power Adapter 21

Dynamix 2500 Data Collector Kit Parts List 15

Status Indicators 22

Battery Pack 23
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Chapter 1        The Dynamix 2500 Data Collector
With the combination of predictive maintenance software and the Dynamix 
2500 data collector, you can do the following:

• Create lists of measurement definitions for data collection.
• Load lists from the Emonitor software into the Dynamix 2500 data 

collector.
• Collect magnitude, process, spectrum, time, and phase data.
• View selected alarms with the data.

The Dynamix 2500 data collector alerts you when a measurement exceeds 
an alarm.

• Define and collect unscheduled measurements.
• Select inspection codes to store with a measurement, documenting the 

condition of the machine.
• Unload the data from the Dynamix 2500 data collector directly into the 

Emonitor database, along with any inspection codes and unscheduled 
measurements.

In addition, the Emonitor software can optimize your data collection by 
combining measurement definitions at a location. For example, the 
software can combine magnitude and spectrum measurement definitions 
so that the list appears to contain only a single measurement. This lets you 
to collect all three measurements at one time, minimizing the time you 
spend collecting data. 
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The Dynamix 2500 Data Collector        Chapter 1
Safety Information Be aware of these safety precautions.

Optical Ports

Laser Radiation Ports

Dynamix 2500 Data 
Collector Kit Parts List 

This table list the parts list for the data collector kit. 

The Dynamix 2500 data collector, catalog number, 1441-DYN25-Z-2C, is for 
ATEX Zone 2 and IECEx for hazardous environments. This kit contains the 
same parts as the Dynamix 2500 data collector, 
catalog number 1441-DYN25-2C except 1441-DYN25-Z replaces 1441-
DYN25.

IMPORTANT Avoid Water
The Dynamix 2500 data collector is splash and dust resistant. However, 
avoid direct contact with water, wet surfaces, or condensing humidity. 
Keep this instrument away from wet locations, for example, laundry, wet 
basements, swimming pools.

If the data collector subject to these conditions, adverse operation may 
result. Before you use it, let the instrument dry thoroughly before 
operating.

ATTENTION: To avoid damage or injury, place the Dynamix 2500 data 
collector on a solid stable surface when not in use and do not place any 
heavy objects on it. Use only the accessories recommended by Rockwell 
Automation. Keep liquids and foreign objects away from the instrument, 
and never operate it if any liquid or foreign object has entered it.

ATTENTION: When the laser on the data collector is active, viewing the 
laser beam can expose your eyes beyond the maximum permissible 
exposure recommendations and cause harm.

ATTENTION: Class 1 laser product. Laser radiation is present when the 
system is open and interlocks bypassed. Only trained and qualified 
personnel should be allowed to install, replace, or service the instrument.

Table 2 - Dynamix 2500 Data Collector Kit Parts List, 1441-DYN25-2C

Catalog No. Description

1441-DYN25-Z Dynamix 2500 data collector

1441-DYN25-CAP Dust Cap Set for Inputs

1441-DYN25-CD Operating System and Documentation CD

1441-DYN25-PS Global Power Supply

1441-PEN25-BAT Battery

1441-PEN25-CASE-T Transit Case

1441-PEN25-COMS-US Communication Cable USB Power Splitter

1441-PEN25-HS Hand Strap

1441-PEN25-RBS Rubber Bump Sleeve
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Chapter 1        The Dynamix 2500 Data Collector
Dynamix 2500 Data 
Collector Optional Parts 
List 

This table list the optional hardware parts list for the data collector.

Table 3 - Dynamix 2500 Data Collector Optional Parts List

Cat. No. Description

1441-DYN25-CBL2CH 2 Channel Adapter Cable for Connectors A or B 

1441-DYN25-CBLHS Headset Adapter Cable

1441-DYN25-CD Dynamix 2500 Operating System & Info CD

1441-DYN25-M4CH 4 Channel Activation

1441-DYN25-MBAL 2 Plane Balancing Extension Module

1441-DYN25-MBMP Bump Test Extension Module

1441-DYN25-MFRF Frequency Response Extension Module

1441-DYN25-MREC Time Recorder Extension Module

1441-DYN25-MRUC Run Up Coast Down Extension Module

1441-DYN25-PS Global Power Supply

1441-PEN25-BAT Spare Battery

1441-PEN25-CASE-T Transit Case

1441-PEN25-COMS-US Communication Cable USB Power Splitter

1441-PEN25-HS Hand Strap

1441-PEN25-NS Neck Strap

1441-PEN25-RBS Rubber Bump Sleeve

1441-PEN25-Z2-100 100 mV per G Zone II Accel Kit

1441-PEN25-Z2-50 50 mV per G Zone II Accel Kit
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Parts of the Dynamix 2500 
Data Collector

This section describes the basic components of the Dynamix 2500 Data 
Collector including key definitions, hardware connections, and status indicators. 

Figure 1 - The Dynamix 2500 Data Collector Keys
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Table 4 - Dynamix 2500 Data Collector Key Definitions

Keys Definition

Enter The two Enter buttons are on either side of the LCD display. In any screen, 
pressing one of the Enter buttons selects the highlighted option, or 
progresses through data collection screens.

Either left/right Enter key does the following in different situations:

• Same as using the Apply function key.
• Starts collecting data for the current point or accepts the current 

measurement.
• Accepts changes to parameter selections.
• May be referred also as the Fire, Read, and OK key.
• In many screens the Left arrow will take you back one screen as will F4 

(Esc) and the Right arrow will act the same as Enter and go forward. 

Function keys The four function keys used are F1, F2, F3, and F4. The functions change 
depending on the current state of the data collector. 

The data collector displays the current function of the keys in the data 
collector screen. When no text appears above a function key, the key is 
inactive in the current window.

Many functions provide an additional row of function keys. By pressing the 
shift (0) key, the data collector provides another row of function keys, still 
referred to as F1…F4.

For example: When you go to the Setup menu, F1…F4 appear as Help, Cont. 
- (less screen contrast), Cont. + (more screen contrast), and Apply. After 
pressing the shift (0) key, the functions change to Extn Mngr (Extension 
Manager) and Calib (Calibration).

You will notice that if you don’t hold down the shift (0) key for a longer 
period of time the first set of functions reappear.

Up arrow • Moves to the previous field or menu selection.
• Decreases the Y-axis scaling in a signature plot.

Down arrow • Moves to the next field or menu selection.
• Increases the Y-axis scaling in a signature plot.

Left arrow • Displays the previous screen of information if there is more than one 
screen, for example, selecting a point in the Data Collection screen.

• Closes the menu selection on the Setup and Instrument Configuration 
screens.

• Moves the signature cursor to the left.

Right arrow • Displays the next screen of information if there is more than one screen, 
for example, selecting a point in the Data Collection screen.

• Opens the menu selection on the Setup and Instrument Configuration 
screens.

• Moves the signature cursor to the right.

On/Off Turns the instrument on and off.

To turn the instrument off, press and hold the On/Off key for one second.

Numeric Enter alpha/numeric values.

Decimal (.) Check the status of the battery, or type a decimal point in a numeric field.

See Check the Battery Level on page 23 for more information. 

+/- Expand or compress a signature plot on the data collector screen.

0 Acts as a `shift’ key that has multiple uses depending on the current data 
collector operation:

• In a Setup screen numeric input field, the key acts as a zero.
• In all other screens, pressing and holding the key displays alternate 

functions for the function keys.
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External Connections 

The external hardware connections for communication and data collection are 
located on the top panel of the Dynamix 2500 data collector. 

Figure 2 - External Hardware Connections

Connector A and Connector B Inputs

The data collector has two signal inputs (LEMO connectors), connector A and 
B. Headphone access is supported on Connectors A and B.

The measurement Input signal range is ±25 V maximum. Input over voltage 
protection is AC ± 50 V peak, DC ± 50 V. The inputs are protected ±50 V AC 
or DC sustained against high-voltage transients, but trigger range over-voltage 
input levels must be avoided.

Voltage can be DC or AC coupled, while the third option, Accel (ICP) 24 V DC 
@ 2.4mA, is available for direct connection of integrated circuit piezoelectric 
transducers. These settings are specified in the Emonitor software.

See Setting Up Measurements on page 65 for more information. 
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Table 5 - Dynamix 2500 Data Collector Pin Assignments

Pin Connector A Connector B POWER/USB/TRIG

1 Audio Output Audio Output USBV

2 Channel X Channel Y USB+

3 Channel Z N/C USB-

4 Strobe Out Strobe Out DIGITAL GND

5 ANALOG GND ANALOG GND EXT-DC-IN

6 Channel Y N/C ± 25 V EXT-TRIG-IN

7 Channel R Channel Z +5V DC TACHO SUPPLY

TIP In some circumstances you may find a reference to channel numbers 
instead of X, Y, Z or R. Channel numbers can be cross referenced to
X= Ch(1), Y = Ch(2), Z= Ch(3), R = Ch(4).
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POWER /USB/TRIGGER

This socket connects the Dynamix 2500 data collector to either an external 
trigger, power adapter, or a USB interface. The external trigger enables the 
synchronization of the data acquisition process to external events, such as 
tachometer inputs for rotational synchronization for balancing applications, or 
for order normalization of frequency spectrum. You can use the trigger pulse also 
to collect running speeds of machinery. The pin assignment for the trigger is 
shown in Dynamix 2500 Data Collector Pin Assignments on page 19.

Using the Headphones

The Dynamix 2500 data collector lets you listen to the vibration signal as 
measurements are being recorded. You need to have the optional part, the headset 
adapter cable.

You can use either Connector A, or Connector B to listen to any data being 
collected. The accelerometer would be connected to the opposite connector. 
When collecting data, the headphone output is switched to listen to another 
input channel (X, Y, Z, and R) by using the shift + left and right arrows.

The headphone output always cycles through X, Y, Z, and R, but only outputs 
sound when set to a channel that is currently measuring data. The channels that 
are collecting data are controlled by which connector (A, or B) that the 
accelerometer is connected to.

See Dynamix 2500 Data Collector Optional Parts List on page 16.

You can control the volume using the keypad on the data collector. You can listen 
to any channel. 

The status bar on the top of the screen indicates the monitored channel and the 
headphone volume. You can listen to the following:

• Connector A: Channels X, Y, Z, and R 
• Connector B: Channels Y and Z

Table 6 - Headphone Controls

Keys Description

6(M) Toggles mute on and off for current channel

Shift, up arrow or shift, down arrow Adjusts the volume 0…10

Shift, left arrow or shift, right arrow Cycle through channels you are monitoring
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Connecting to the External Power Adapter

The external power adapter can be used to charge the internal battery and the 
battery pack. 

1. Connect the data collector to the DC output of the power supply to 
the in-line socket of the USB power splitter cable. 

2. Connect the Fischer plug into the POWER/USB/TRIGGER socket on 
top of the instrument.

3. When needed, use the USB splitter cable to connect to a computer.

The interface is configured as a Client to provide an automatic connection 
to a computer through the Microsoft ActiveSync software. This interface 
lets you to copy files and transfer data from the data collector to your 
computer.

See Install ActiveSync Software on page 108 for more information.

Figure 3 - The Dynamix 2500 Data Collector Connections for the
USB/Power Splitter Cable

WARNING: When you are powering or charging the data collector, place 
the power adapter in a well ventilated area. The data collector may 
overheat and cause a fire.

WARNING: Only the provided power supply may be used. Any other 
supply may cause permanent damage to the data collector.

WARNING: Connect the power supply only in a safe nonhazardous area.
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Status Indicators

The Dynamix 2500 data collector has four status indicators located in the  
upper-right side of the instrument nameplate.

Figure 4 - Status Indicators

Table 7 - Status Indicators

Status 
Indicator

Operation State Definition

Dual State 
Status

Red

Charging Battery Flashing When first connected to the power adapter, the 
Dynamix 2500 Data Collector tests the condition of 
the battery pack. Within 30 seconds, the status 
indicators should go to a solid state.

If the status indicator continues to flash, the 
instrument has diagnosed a fault in the battery pack 
and it will not charge the battery. The anomaly may 
be that the cell temperature is too high or there is a 
fault with the battery pack.

Solid The battery pack is OK. The power adapter is 
connected to the instrument and charging. The 
battery pack is maintained by a trickle charge from 
the power adapter for as long as it remains attached 
to the instrument.

Data Collection Solid • An alarm condition has been set.
• Input signal is out of range.
• ICP check has failed and there is an ICP fault 

condition.
• The power adapter is connected to the 

instrument.

Blue Communication Solid • Communicating to Emonitor through the USB 
connection.

Amber Data Collection Solid Acquisition sub-system is settling.

Green Data Collection Solid Input signal is stable and data is ready to be stored.

32146-M

Dual Status: Red and Blue

Green

Amber
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Strap Attachment

The strap can be fitted to either the left or right side of the Dynamix 2500 data 
collector. 

1. Feed the ends of the strap through the top and bottom corner pillars.

2. Loop the ends of the strap through the buckles and adjust the tightness to 
suit.

Battery Pack

The Dynamix 2500 data collector can be powered either from the battery pack or 
the external power supply. The internal back-up battery maintains the system 
settings is used while replacing the battery pack. This internal battery keeps the 
data collector on for a very short period of time. 

If you do not replace the battery pack quickly the data collector will shut down 
resulting in a hard restart. If this occurs, the following happens:

• Data you have not saved will be lost.
• Last system settings will be reset to defaults.
• You will not be taken back to your last the location when the restart occurs.

The most efficient way to replace the battery pack is to do one of the following:

• Connect to a power source then remove the battery.
• Save your data and turn off the data collector to remove the battery.

Check the Battery Level

You can check the level of the data collector’s battery at any time by looking at the 
top status bar on the screen. 

WARNING: To make sure proper and safe Dynamix 2500 data collector 
operation, only use the supplied battery pack.
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This table shows the typical battery life for a fully charged battery pack 

You can check the status of the battery also in the instrument by pressing the 
decimal (.) key. This function is available on most screens.

The Battery status display reports the status of the internal battery and the 
condition of the instrument’s back-up battery. The back-up battery charges while 
the instrument is connected to the external DC power adapter or when the 
instrument is powered on using the internal battery. 

Figure 5 - Battery Status Display 

The battery status appears in the upper-right corner of the caption bar, as 
illustrated below.

Figure 6 - Battery Pack Status Indicator

Table 8 - Battery Capacity

Mode State Typical Battery Life

On Performing typical data collection 8 hours minimum

Idle mode 14 hours minimum

Off Main battery & back-up battery 14 days minimum

Main battery removed & instrument 
running on back-up battery

2 days minimum

Main Battery Charge 
Time

100% 5 hours

70% 3 hours

IMPORTANT If you let the main battery discharge completely, the instrument will 
behave as if it has experienced a hardware reset. On restart the 
current date, time and status information will be lost.

Battery pack indicator

Indicates that the data collector is operating with the battery pack. 
When using a power supply, this changes to a plug and indicates 
that the battery pack is charging.

Battery pack status indicator 
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The battery status icons show the strength of the battery.  

Table 9 - Battery Status Icons 

Battery Icon Meaning

Battery status is good: >30% life remaining.

Battery status is low: >10% life remaining. 

Battery status is very low: <10% life remaining.

Battery is charging.

IMPORTANT The Dynamix 2500 data collector automatically notifies you 
when the battery status is at 30% or lower. To clear the 
notification, press the decimal (.) key. The notification 
periodically appears until the battery is recharged or the power 
adapter is attached.

To prevent any loss of data, we do not recommend that you use 
USB communication when the battery status is at 10% or 
lower.

Table 10 - Dynamix 2500 Extension Module Battery Icon Descriptions

Battery Icon Meaning

Battery status is good: >30% life remaining.

Battery status is low: >10% life remaining. 

Battery status is very low: <10% life remaining.

Battery is charging.
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Insert and Remove the Battery Pack

1. On the back of the instrument, use a flat head screwdriver to unlatch the 
release screws.

Figure 7 - Rear View of the Dynamix 2500 Data Collector

2. Remove the battery cover.

3. Slide the battery pack to the left and lift it out.

WARNING: To make sure proper and safe Dynamix 2500 data collector 
operation, only use the supplied battery pack.

WARNING: Only remove the battery in a nonhazardous environment:

• Avoid Battery Compartment Exposure.
• Do not open the battery compartment in a hazardous area, or in locations 

where contact with water or other contaminants may occur.
WARNING: To minimize the risk of serious injury or damage do the 
following:

• Do not expose the battery pack to temperatures in
excess of 60 °C (140 °F).

• Do not disassemble, incinerate, or short-circuit the battery pack.
• Danger of explosion if battery is incorrectly replaced.
• Replace the battery only with the same or equivalent type recommended 

by the manufacturer.
• Dispose of used batteries according to the manufacturer’s instructions.
• Do not open battery compartment in a hazardous / explosive area.

Release screws to access 
battery pack.

Once battery cover is removed, 
slide the battery to the left and 
lift out.

Reset switch
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Battery Maintenance

These are recommendations to extend the life of the battery pack:

• If the data collector is not in use and/or not regularly charged, it should be 
recharged at least every 25 days to prevent damage to the battery cells.

• If the battery pack is not installed recharge the battery pack every 12 
months to prevent damage to the battery cells. 

• Recalibrate the electronic state of charge meter around every 30th 
recharge. This prevents the state of charge from showing an incorrect 
battery charge percentage. To do this, fully discharge the battery pack and 
then fully charge it without any interruptions, ideally with the data 
collector off. It will take longer to charge the battery if the data collector is 
on while charging. 

• The battery capacity is reduced at temperature extremes, high and low. 

Calibration

After a 12-month period, you may notice that a calibration reminder message 
appears at the bottom of the Main Menu screen. This is just a reminder to get 
your instrument calibrated. To hide the reminder message, select Calib (F4) and 
the message will be hidden until the following month. 

We recommend that you return the Dynamix 2500 data collector annually to 
Allen-Bradley for calibration. For more information, see Rockwell Automation 
Support on the back cover.
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Notes:
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Chapter 2

Configuring the Dynamic 2500 Data Collector

This chapter describes what you need to do to configure the data collector.

Apply Power to the Data 
Collector

After connecting the data collector to AC power or installing the battery, a single 
press of the On/Off key applies power to the instrument. However, to power off 
the instrument you need to press On/Off for a period of one second. The 
instrument resumes operation at the last screen you viewed when you powered off 
the data collector.

Topic Page

Apply Power to the Data Collector 29

Installing the USB Drivers for the Data Collector 30

Updating the Operating System 34

Restarting the Data Collector 42

Dynamix 2500 Data Collector Main Menu 45

Dynamix 2500 Data Collector Setup Screen 48

Dynamix 2500 Data Collector Data Collection Screen 51

Setting Up the Dynamix 2500 Data Collector 55

Using Memory Cards 64

TIP The first time you turn on the Dynamix 2500 Data Collector or 
following a reset, the Instrument Setup screen automatically appears.
See Set the Date, Time and Date Format on page 50 for more 
information.
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Installing the USB Drivers 
for the Data Collector

You can communicate between the Dynamix 2500 data collector and your 
computer by installing specific USB driver files and communication software. If 
you want to load and unload routes to your data collector you must install 
Microsoft ActiveSync software and the USB drivers.

Install ActiveSync or Mobile Device Center Software

When using Microsoft Windows 2000 or Windows XP, use the ActiveSync 
software to communicate through the USB connection. You can download the 
ActiveSync software from
http://www.microsoft.com/downloads. Follow the instructions on the website 
to download and install ActiveSync software.

When using Microsoft Windows 7, use the Mobile Device Center software. You 
can download the Mobile Device Center software from
http://www.microsoft.com/downloads. 
Follow the instructions on the website to download and install the Mobile Device 
Center software.

TIP We recommend that you use ActiveSync software version 4.5 or later 
when using the Dynamix 2500 data collector.

TIP  Microsoft ActiveSync software automatically launches and asks to Set 
Up a Partnership. Select No and click Next. ActiveSync software then 
displays its Connected dialog.

See Install ActiveSync or Mobile Device Center Software on page 30 for 
more information.
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Install USB Drivers

You can communicate between the Dynamix 2500 data collector and your 
computer by installing specific USB driver files.

When you connect Dynamix 2500 data collector to a computer for the first time, 
the computer identifies new mobile device hardware. The instrument requires a 
USB driver installed on you computer. Once you have installed the driver, it will 
not be required to be installed again

Follow these steps to install the USB driver files.

1. From the Dynamix 2500 data collector product CDROM USB Driver 
folder, run the USB driver setup wizard.

2. From the Start menu, choose CMC USB Driver/Install.
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3. Apply power to the Dynamix 2500 data collector and connect the 
instrument to the computer using the 1441-PEN25-US USB/Power 
Splitter Cable.

The Found New Hardware Wizard dialog box appears prompts you, 
“What do you want the wizard to do?” 

4. Check Install the software automatically (Recommended) and click Next. 

5. Wait while the new hardware installation wizard proceeds to install the 
Dynamix 2500 data collector software.
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A Windows compatibility warning appears.

6. Click Continue Anyway.

The wizard completes the process.

7. Click Finish.

Dynamix 2500 data collector automatically connects to the computer. 
USB drivers are now installed and the instrument is able to communicate 
with your computer.

TIP If Microsoft ActiveSync software is already installed on the computer. 
ActiveSync software will automatically launch and asks to Set Up a 
Partnership. Select No and click Next. ActiveSync software then displays 
its Connected dialog. 

See Install ActiveSync or Mobile Device Center Software on page 30.
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Updating the Operating 
System 

Download the Dynamix 2500 .zip upgrade file from
http://www.rockwellautomation.com/support/. Choose Downloads > Firmware 
Updates > Condition Monitoring.

You can load the operating system/firmware from Dynamix 2500 data collector 
product CD by using the USB connection. Use the Dynamix 2500 OS Loader 
application on the product CD or at
http://www.rockwellautomation.com/support/firmware.html

To use the Dynamix 2500 OS Loader application, the following must be installed 
on your computer:

• Microsoft’s ActiveSync software

Communication is supported through the USB port using Microsoft 
ActiveSync software version, 4.5 or later.

If you have not installed ActiveSync software, see Install ActiveSync or 
Mobile Device Center Software on page 30 for more information.

• USB Drivers

If you have not installed the USB drivers for your Dynamix 2500 data 
collector, see Install USB Drivers on page 31 for more information.

IMPORTANT We recommend that you delete all older versions of the installer loader 
.msi files from your computer before updating the Dynamix 2500 data 
collector’s operating system.

IMPORTANT Whenever you rerun the OS Loader software, you will reload only the 
main OS firmware. The OS loader will back up licence files and data, but 
not the optional extension modules. Once you have updated the OS 
firmware, install the latest version of your optional extension modules.
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Before performing the 1.020 firmware upgrade, take note of the modules 
installed on the Dynamix 2500 data collector.

Install the Dynamix 2500 OS Loader Application

1. Double-click the Dynamix 2500 
Dynamix2500_OS_Loader_v1.02.13506.msi file on your computer. 

2. Click Next.

TIP To confirm which modules are installed and the version, press F3 (About) 
on the Main Menu.

Table 11 - Data Collector Modules

Cat. No. Module Version

1441-DYN25-MBAL Balancing Upgrade

1441-DYN25-MBMP Bump Test 

1441-DYN25-MFRF FRF - Frequency Response Function

1441-DYN25-MREC RuCD - RunUp CoastDown

1441-DYN25-MRUC Recorder
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3. Select an installation folder and click Next.

4. Click Next.

The loader is installed.

The installation is complete.

5. Click Close.
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Install the Dynamix 2500 Data Collector Firmware

This procedure details the steps necessary to reinstall or upgrade your data 
collector’s firmware by using the Dynamix 2500 OS Loader application.

Follow these instruction to install the firmware.

1. Apply power to the data collector.

2. Connect your Dynamix 2500 data collector to the computer by using the 
splitter cable USB connection.

3. Make sure the ActiveSync software is running.

4. From the Start Menu, choose Programs>Allen-Bradley>Dynamix 
2500>Dynamix 2500 OS Loader.

5. Click OK.

During the installation, the Dynamix 2500 data collector restarts several 
times and multiple screens are displayed. Disrupting or disconnecting the 
data collector from the computer causes the installation procedure to 
terminate and may leave the data collector in a corrupted state. 

You will be prompted to back up module data, for example, Run-up Coast-
down measurements, route database, and measurement data. You can 
choose to backup this data; it is automatically restored later in the firmware 
installation process. Any module data that is not backed up will be erased.

TIP We recommend that you upload your data to Emonitor before you update 
the operating system just in case there is an error with the firmware 
installation, such as a cable disconnect.
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6. Click Yes, if desired.

You will be prompted also to back up Routes. If backed up, these are also 
automatically restored later in the firmware installation process. Any 
Routes that are not backed up will be erased.

7. Click Yes, if desired. 

The loader goes through a series of backing up, deleting, and copying files.
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You will notice that the unit will reboot and ActiveSync will disconnect 
and reconnect. Let the loader run through its processes. Do not remove 
any cables or press any keys on the data collector.

8. Click OK.

Installation is complete. 

9. Click Exit.
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Module Licensing

Any modules that were licensed prior to the upgrade will still be licensed. Any 
modules that are installed, but which have not been licensed will appear grayed 
out as unavailable.

To activate grayed-out modules, contact your local Allen-Bradley distributor or 
Rockwell Automation sales representative. Use the table Data Collector Modules 
on page 35 to identify what modules you need to order.

IMPORTANT It will be necessary to reenter the date and time in the data collector. 

TIP To confirm that the correct revision was loaded, press F3 (About) on 
the Main Menu. The firmware revision should match the operating 
system file just loaded. 
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Upgrading the Emonitor Software

The Dynamix 2500 data collector, firmware revisions 1.010 and 1.020, are 
compatible with the Emonitor software, revision 3.4 and later. For instructions 
on how to upgrade your Emonitor software, refer to one of the Emonitor 
installation manual.

Figure 8 - Emonitor Installation Manuals

Publication Publication Number

Emonitor Gupta Single User Installation Manual EMONTR-IN001

Emonitor Gupta Multi User Installation Manual EMONTR-IN002

Emonitor Oracle Multi User Installation Manual EMONTR-IN003

Emonitor MSSQL Multi User Installation Manual EMONTR-IN004
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Restarting the Data 
Collector

You should restart the Dynamix 2500 data collector if the instrument locks up 
and does not respond to any key presses including the On/Off key. 

When you need to reset the data collector you can perform a hard or soft reset. A 
hard reset resets the defaults vales of the date, time, and time zone. A soft reset 
keeps the current values. A reset does not delete data or Routes.

Perform Soft Restart

When doing a soft restart, all files and programs present in memory remain in 
memory following the restart.

With the data collector on, simultaneously hold down the 2, 7, 8, and 9 keys for 
about a second. The data collector restarts and the Main Screen appears.

Perform Hard Restart

A hardware reset lets you to reconfigure the Dynamix 2500 data collector back to 
the factory default setup. Programs or data files stored in RAM are cleared, but 
any programs or files stored in internal memory and any registry changes will be 
maintained.

The reset switch is located behind the battery access panel on the underside of the 
instrument. The reset switch can only by pressed using a 1/16- in diameter pin or 
a straightened paper clip. 

TIP Most of the time, a soft restart will reset any anomalies you are having 
with the data collector.

Reset Switch
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Follow these steps to replace the battery.

1. Using a flat head screwdriver, remove the two latch screws on the battery 
access panel.

2. Remove the battery access panel.

3. Press the Reset button using a 1/16th inch diameter pin or a straightened 
paper clip.

4. Replace the battery access panel and tighten the two screws.

The Dynamix 2500 data collector automatically powers on.

Allow at least thirty seconds for the instrument to reconfigure and activate the 
display after the Instrument Setup screen appears.  

The Data Collector’s Engineer Mode

The Engineer Mode Menu lets you to perform various maintenance operations 
such as resetting the instrument to the default settings, or upgrading the 
Dynamix 2500 data collector’s firmware. 

IMPORTANT A hardware reset can also initiate the Engineer Mode Menu.

See The Data Collector’s Engineer Mode on page 43 for more 
information.

IMPORTANT The current date, time and some status information will be lost, and 
the backlight setting will be returned to the default setting following a 
hardware reset. 

See Set the Date, Time and Date Format on page 50 for more 
information.

IMPORTANT Any data held in internal memory is secure and will not be lost nor 
destroyed during a hardware reset.

ATTENTION: The Engineer Mode Menu can only be initiated 
manually. This menu should be used only by an experienced person 
who is familiar with these options.

ATTENTION: If you are not experienced and attempt to run options 2, 
3, and 4, expect unwanted behavior and hardware damage.
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Follow these steps to initiate the Engineer Mode Menu by performing a hardware 
reset.

1. Remove battery access cover.

2. Press the reset button while continually holding down the Right and left 
arrow keys until the menu appears. 

The Engineering menu appears.

3. Press a numeric key to choose an item from the Engineering Menu.

Table 12 - Engineer Mode Menu

Function Description

1 Force Clean Reboot During a normal start sequence, the instrument automatically 
updates the registry contents into nonvolatile memory so that any 
changes are permanently stored. 
Select this option to bypass the normal start sequence and revert 
back to a `clean’ or default setup.

2 Upgrade from SD Card This option is for hardware maintenance and testing.
Contact Rockwell Automation Technical Support at 
http://www.rockwellautomation.com/support.

3 Upgrade from RNDIS This option is for hardware maintenance and testing.
Contact Rockwell Automation Technical Support at 
http://www.rockwellautomation.com/support.

4 Force Internal Disk Format This option is for hardware maintenance and testing.
Contact Rockwell Automation Technical Support at 
http://www.rockwellautomation.com/support.

5 Run Windows CE Exit the Engineer Mode Menu and launch the Dynamix 2500 data 
collector’s operating system.

ENGINEERING MENU

Bootloader vx.xxxx

IP xxx.xxx.xx.x - 255.255.255.0

1. Force Clean Reboot

2. Upgrade from SD Card

3. Upgrade from RNDIS

4. Force Internal Disk Format

5. Run Windows CE
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Dynamix 2500 Data 
Collector Main Menu

This section introduces you to the screens that appear when operating the 
Dynamix 2500 data collector.

Main Menu

You use the Main Menu to navigate to the different programs and optional 
extension modules installed in the Dynamix 2500 data collector. The Main 
Menu is where you can access various tasks, such as collecting data, defining the 
setup options, and reviewing data.

Figure 9 - Dynamix 2500 Main Menu

For more information about the optional extension modules, see:

• Additional Resources on page 12.
• Install Optional Extension Modules on page 205.

The Main Menu includes two standard options:

• Data Collection

Select the Data Collection option to collect both Route and Offroute 
(unscheduled in the Emonitor software) data. You can view any data stored 
in the instrument.

See Dynamix 2500 Data Collector Data Collection Screen on page 51 for 
details on data collection settings.

• Setup Utility

Select the Setup option to define global options for collecting data.

See Setting Up the Dynamix 2500 Data Collector on page 55 for details 
on global settings.

To make a selection from 
the Main Menu, highlight 
the option using the arrow 
keys and press Enter.

Balancing, RUCD (Run Up Coast 
Down), Bump Test, Recorder, and 
FRF (Frequency Response Function 
are optional extension modules.

See Install Optional Extension 
Modules on page 205 for more 
information.
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Display the Operating System Version Number

You can view information about the Dynamix 2500 data collector.

Press F3 (About) on the Main Menu screen to view the operating system version 
number. The About screen displays the following:

• Data collector ID number
• Firmware revision
• Free space on the internal disk
• Free space on the Secure Digital (SD) card, if one is inserted in the 

instrument.

Figure 10 - Dynamix 2500 About Screen

To display additional information about the firmware build and to view the 
version of the Windows CE operating system, press F2 (Info) on the About 
screen.
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Change the Display Backlight 

The backlight of the display can be adjusted from most screens. On the Setup 
screen the Cont- and Cont+ appear automatically. On some of the screens that 
don’t display the buttons, you can press 0 to change the backlight.

1. For example, on the Setup screen, the Cont. - and Cont. + functions 
appear on the screen.

2. Press F2 (Cont. -) to lighten the display. Press F3 (Cont. +) to darken the 
display. 

3. Repeat until the display is adjusted properly.

Use these functions to change 
the display backlight.
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Dynamix 2500 Data 
Collector Setup Screen

The Setup dialog box lets you define global options for the Dynamix 2500 data 
collector. You select Setup Utility on the Main Menu to access the Setup dialog 
box.

The data collector automatically displays the Setup screen when you do the 
following:

• First apply power

• Perform a hardware reset.

Follow these steps to edit an option.

1. Use the up or down arrow keys to select the option.

2. Press the Right arrow key to open a list of choices.

This is an example of the timeout options.

3. Use the left arrow to make the choice.

To select an option, press the 
Up or Down arrow key.
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4. Press 0 to display the additional options on the Setup dialog box. 

The Extension Manager and Calibration buttons appear.

The Extension Manager lists the option extension modules installed on the 
data collector.

See Install Optional Extension Modules on page 205 for extension module 
details.

5. Select the choice by pressing the arrow keys or type in a value using the 
numeric key pad. 

6. Press the left arrow key to make your selection. 

When you are finished, press F4 (Apply) to return to the Main Menu.

For a list and description of the Setup Utility parameters, 
see Instrument Configuration Parameters on page 59.
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Set the Date, Time and Date Format

The Dynamix 2500 data collector keeps the current date format, date, and time 
even when the instrument is powered off. However, there may be times when you 
need to change these settings. For example, after restarting or resetting the 
Dynamix 2500 data collector, the date and time get set to 00:00:00. 

Follow these steps to set the date, time, and select a date format.

1. Select Setup Utility from the Main Menu and press Enter. 

The Setup screen appears.

2. To change the format of the date, highlight Date Format and press the 
Right arrow key to display the format choices.

3. Select the appropriate format and press the Left arrow key to save your 
choice.

4. To change the date and time, highlight Date/Time and press the Right 
arrow key to open the date and time window. 

5. Enter the current time and date.

6. When you get to the Year field, press the Right arrow key to save your 
entry. 

7. When you are finished, press Enter to return to the Main Menu.

TIP On powering on the Dynamix 2500 data collector for the first 
time or after a restart or hardware reset, the Setup screen 
automatically appears.
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Dynamix 2500 Data 
Collector Data Collection 
Screen

The basic operations of the instrument includes changing your display contrast, 
resetting the data collector, setting the date, time, and date format. 

The Data Collection screen lets you do the following:

• Navigate around the routes loaded in the data collector.
• Collect and store Route and Offroute data.
• Edit the data collection options.
• Navigate through the stored data and to review previously collected Route 

and Offroute data.

When you select Data Collection from the Main Menu, the Route Manager 
screen appears

All of the routes that you download from Emonitor to the data collector appear 
on the Route Manger screen. 

Follow these steps to open a Route.

1. Select the route and press Enter.

Displays the instrument 
configuration screen, which lets 
you access global data collection 
settings.

If you press 0, the Help button 
appears in the next level of 
function keys.
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The information for the first point taken appears. 

To access four additional functions for the Data Collection screen, press 0.

Follow these steps to move around in the Data Collection screen.

1. Select the hierarchy level, for example, Plant, Train, Machine, and 
Location.

The Dynamix 2500 data collector supports up to six hierarchy levels for 
each point. These levels are defined by the structure of the Route database 
in the Emonitor software. The number and labels of these levels vary 
according to the way your Route database was set up.

2. Display the next screen of information, for example, a list of location 
measurement points, press the Right arrow key. 

To highlight an item, press 
the Up or Down arrow key.

To view previously 
collected route data.

Collect and review Offroute data.

Displays the Instrument 
Configuration screen.Backlight adjustments
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The Select Location screen appears.

See Collecting and Reviewing Data on page 129 for more information.

TIP The Selection screen does not appear if you set the route 
Navigation mode to `DataPac’ in the Setup Utility menu. 
Instead, the Dynamix 2500 data collector automatically moves 
to the next point in the route when you press the Right arrow.

Task Action

Select an item. Highlight the item and press the Left arrow key.

Leave the screen without selecting an item. F4 (Esc)

Start collecting data. Enter

Review previously collected route data. F1 (Review)

Collect and review Offroute data. F2 (Offroute)

Use the Up and Down 
arrow keys to highlight the 
point.
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View Settings for Current Measurement Definition

You can review the measurement definitions for the current active measurement 
point from the online help.

1. Press F1 (Help) to access the online help. 

The Help Contents screen appears. 

2. Press F2 (Pt. Info.) to view the measurement definition.

The Current Point Info screen appears.

3. When you are finished, press F4 (Esc) to exit the online help or press F1 
(Contents) to return to the Help Contents screen.

TIP On some screens, Help is located on the second set of functions, 
press (shift) to display F1 (Help)
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Setting Up the Dynamix 
2500 Data Collector

Before you begin to take readings, you need to configure the instrument 
parameters by using the Setup Utility, Instrument Configuration and Data 
Collection screens.

Configure the Data Collector

Using the Setup Utility, you can configure the global options for your data 
collector.

Follow these steps to configure the data collector.

1. Select Setup Utility from the Main Menu and press Enter.

The Setup screen appears.

2. Review the default values and edit if necessary.

Use the descriptions in Instrument Configuration Parameters on page 59 
to help you configure these options. 

See Dynamix 2500 Data Collector Setup Screen on page 48 for help on 
editing the parameters.

3. When finished, press F4 (Apply) to return to the Main Menu.

For the Route data to be 
accurately time based, you must 
set the date and time before 
leaving this screen.
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Table 13 - Setup Screen Parameter Descriptions

Parameter Description Value

Route Mem Sets the location where the loaded route data is stored. Internal (default)
Storage Card

Timeout The number of minutes the Dynamix 2500 data collector can remain idle 
before it shuts itself off to conserve battery power. 
Press On/Off to reactivate the instrument following a timeout. The 
instrument returns to the point in the program where it was when it shut 
off. No stored data will be lost. 

Off (default)
5 min
10 min
15 min
20 min

Trigger Sets the Phase/Order input trigger synchronization:
• Laser Tach enables the internal Laser Tachometer when a Phase or 

Order measurement is collected.
• External uses the trigger input from the POWER/USB/TRIGGER 

connector as the trigger source. 

External (default)
Laser Tach

Dflt Units Defines the units of measurement for Offroute standard velocity 
measurements.
Important: Used only for Offroute standard velocity measurements.

English (ips) (default)
Metric (mm/s)

Date Format The format of the date displayed in the Dynamix 2500 data collector. MM/DD/YYYY (default)
DD/MM/YYYY
YYYY/MM/DD

Time Zone Sets the time zone.
Only used when using ActiveSync software data synchronization. The time 
zone on the instrument must match the time zone on the computer. If you 
are not using ActiveSync software then the time zone setting has no 
effect. 
Important: Always set your instrument to the correct time zone or your 
files will not be in sync by time zone.

List of 30 time zones

Date/Time Displays the date and time in the format you select in the Date and Time 
parameters.

Current data and time

Memory Configures the memory:
• Select cmd to exit this field without selecting an option.
• Delete all routes and data from memory.
• Initialize formats the memory. Deletes all files from memory including 

any route files and directories.
Important: These commands are performed on the memory location as 
set by Route Memory.

Select cmd (default)
Delete all routes
Initialize

Route Font You can select the font size for the Route. Big or Small

Envelope The type of envelope to use for high frequency and rolling element bearing 
analysis.
Determines which pre-defined measurement you can use to collect 
Offroute data.

gSE (default), collects an Offroute gSE point.
ESP, collects an Offroute ESP point

Navigation Determines how the instrument navigates through the routes in the Data 
Collection screens when the Right arrow key is pressed:
• Enpac- The instrument displays a Selection screen from which you 

select the item you want to collect or review. 
• DataPac - The instrument functions like a dataPAC 1500 in that it 

automatically advances to the next point in the route. 

Enpac
DataPac (default)
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Configure the Data Collection Options

The data collection options affect the measurement, the data collection process, 
and how the data displays on the Dynamix 2500 data collector. The instrument 
stores the data collection settings even when the instrument is powered off. 
However, you should check these options each time you start data collection.

Follow these steps to download a Route onto the data collector using the 
Emonitor software.

1. Using the Route Manager, select an appropriate route and press Enter.

Transducer Change Notification of a transducer change.
If set to Warn, a prompt appears on the screen warning you of the 
transducer change.

Warn (default)
Do not warn

Bias Check The bias of the transducer before taking the measurement. Manual (default)
Automatic

Module ICP The Module ICP option allows the manual control of turning off/on ICP 
power to transducers in application modules.

Never
Always
Auto

Language Sets the language for the user interface. Chinese
English
Francais
Deutsch
Italiano
Portuguese (Brasil)
Russkiy
Espanol (Spain, traditional)

Table 13 - Setup Screen Parameter Descriptions

Parameter Description Value
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The Data Collection screen appears.

2. Press 0 (Shift) to display the Config function. 

The Config function should remain on the screen for approximately three 
seconds after releasing the 0 key. 

3. Press F4 (Config) to display the data collection options.
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 The Instrument Configuration screen appears. 

4. Review the default values and edit if necessary.

Use the descriptions in Instrument Configuration Parameters on page 59 
to help you configure the data collection options.

5. When you are finished, press F4 (Apply) to return to the Data Collection 
screen.

Table 14 -  Instrument Configuration Parameters

Parameter Description Value

Freq. Units The frequency units for displaying spectra/FFT data in the 
data collector. 
This parameter is initially set to the default frequency (Hz or 
CPM) in Emonitor when you load a list.

Hz: displays spectra in Hertz, cycles per second.
CPM (default): displays spectra in cycles per minute.
Orders: spectra in orders of the operating speed.

This is used only when order normalized or phase data is 
collected using a tachometer or strobe to trigger data 
collection.

Fast 
Averaging

Sets the averaging display and overlap processing.

Value Description

On Default
The display is updated only when the data collector has collected and averaged all the data.
For example, if the number of averages is set to `20,’ then data is displayed only when 20 blocks have 
been collected and averaged. There is no progress indication during data collection, only a ̀ Collecting 
data...’ message.
This speeds up the data collection of the spectra using the percent overlap specified in Emonitor. The 
interim averages are not displayed.

Off The display is updated as often as possible while the data collector is collecting and averaging the 
data. For example, if the number of averages is set to `20’ then data might be displayed for averages 
1, 6, 12, 18, and 20. The averages that are displayed depends on the Fmax and number of lines 
selected. If each block is acquired very quickly then only the first and last updates may be seen. Data 
can be stored at any time once the spectrum has been displayed.
Important: The Off option applies only to spectral averaging, not time synchronous averaging. This 
means it has no effect on Phase points or other time synchronous averaged measurements.
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Auto Store Controls the number of key presses required to accept data. 

Time The number of seconds that the input signal must be steady 
for Auto Store to occur. 

2 s (default)
This parameter is used only when Auto Store is set to `On.’

Percent The fluctuation percent for Auto Store to occur. 30% (default)
This parameter is used only when Auto Store is set to `On.’

Auto Advance Determines whether the Dynamix 2500 data collector automatically moves forward to the next point in the list after 
collecting data for the current point. 

Acquisition Determines how the Dynamix 2500 data collector collects a signature when the measurement definition specifies just one 
average.

Table 14 -  Instrument Configuration Parameters

Parameter Description Value

Value Description

On The instrument automatically accepts both the overall and signature measurements and proceeds to 
the next point in the list.
The overall measurement is accepted based on an algorithm. The algorithm is based on a percent 
fluctuation over a period of time (seconds). 
If the overall stays with the % specified by Percent for the number of seconds specified with Time, 
the overall magnitude is accepted.
You must press Enter to accept the overall measurement, and then press Enter again to accept the 
signature measurement.

Off Default

Value Description

On The instrument automatically moves forward to the next point in 
the list after collecting data for the current point. No spectrum is 
displayed.

Off Default
The instrument displays a spectrum after collecting data for the 
current point.

Value Description

Single shot Measures a single average for the signature and then stops.

Continuous Default
Continuously measures the signature until you press Enter to stop the averaging. This will pause the 
acquisition. Press the Continue function to restart the acquisition. Press Enter a second time to store 
the data.
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Autoranging Sets the input range during data collection.

• If Autoranging is set to Fixed or Aggressive, the software integration is used on all FFT measurements. This is to give 
improved dynamic range and faster hardware settling times. 

• If hardware integration is required, set Autoranging to `Conservative.’
• For all autoranging settings (including Fixed), the input range is automatically increased and the data retaken if clipping 

occurs. This means that the final input range used will never be too low for the signal being measured. 

Table 14 -  Instrument Configuration Parameters

Parameter Description Value

Value Description

Aggressive Default
Limits the auto-ranging to 20 mV level and sets the range limits from 1% to 70% of range. 
When the input is under-range, the instrument recalculates the most appropriate setting and begin 
data sampling. The range will not be adjusted a second time or checked prior to data collection. 
Use Aggressive autoranging when faster data collection is desired. When using Aggressive 
autoranging, set Auto Store to `Off,’ or set Auto Store Time to `2’ seconds when Auto Store is set to 
`On.’

Conservative Allows auto-ranging to go as low as 2 mV and sets the range limits from 10% to 70% of range. 
The instrument perform a series of checks prior to sampling data. This will result in longer data 
collection times and potentially lengthy acquisition. 
When the input is under-range, the instrument recalculates the most appropriate range setting and 
sample data to make sure the range has been properly selected. In addition, the dynamic range will 
be adjusted several times prior to data collection.
Use Conservative autoranging when large variations in signal amplitude are present for proper input 
range selection but increases the settling time required.

Fixed No autoranging measurements are taken. Input range is set based on the transducer type and 
sensitivity.

For example, an accelerometer, the input range will be 5 V for 100 mV/G sensitivity or 500 mV for 10 
mV/G sensitivity.

Transducer Input Range (EUs)

Accelerometer 50 g

Velocimeter 50 ips

Displacement probe 200 mils

Volts, A.C. 2 V
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Mach. Speed Controls the amount of time auto-ranging will wait to be sure it has seen the peak signal value of the sample.

When faster data collection is desired, set Autoranging to `Aggressive’ and Mach. Speed to `Normal.’

Settling Delay The amount of time the instrument should delay data 
acquisition after applying power to an ICP accelerometer.
The specified delay applies only to the first ICP 
measurement after turning ICP on, for example, the first 
measurement at the start of a ROUTE or a measurement 
following a non-ICP measurement 
After the first measurement, data acquisition times are not 
affected. If ski slope anomalies occur, try increasing the 
settling delay by one or two seconds.

0.00…60.00 s
5.00 s (default)

Memory Configures the data collector’s memory.

Table 14 -  Instrument Configuration Parameters

Parameter Description Value

Value Description

Normal Sets the auto-ranging algorithm to only track signals above 120 rpm. Therefore, use this setting 
when the machine speed is greater than 120 rpm.
The normal speed setting guarantees the waiting time be no longer than 0.5 seconds. It will 
significantly improve auto-ranging times and therefore data collection times for any points that 
have low filters (<2 Hz) selected.

Slow Sets the auto-ranging algorithm down to the Low Pass Filter setting. (If none, it will track down to 
approximately 0.33 Hz or 20 CPM.) Therefore, use this setting when the machine speed is less than 
120 rpm.
The slow speed setting enables low frequency auto-ranging to accommodate collection of low 
frequency components. For slow speed equipment, this is necessary to be sure adequate sampling 
and collection of the peak signal. The slow speed setting allows the Dynamix 2500 data collector to 
auto-range on machines running as slow as 20 rpm. The auto-ranging algorithm makes an 
assumption about the speed of the machine that is being monitored to determine how long to wait 
for the peak signal value to be seen. With the slow speed setting, the wait-time is calculated as 1 
/ fhpf where fhpf is the high-pass filter cutoff in Hz for the current point. 
For example, if a 0.36 Hz filter is selected, the auto-ranging algorithm will wait for 1 / 0.36 = 2.78 
seconds to make sure it has seen the peak signal value.

Auto (default) Select to have the Dynamix 2500 automatically select Normal or Slow depending on the 
measurements speed setting specified by Emonitor.

Value Description

Select cmd: Default Exit this parameter without selecting an option.

Purge Marks all the points on the route as taken, sets the current reading to be 
the previous reading for each point, and deletes all the Offroute data.

Delete route Deletes the current route in memory.
If you have an internal or SD storage card, the route to be deleted 
depends on what you have chosen on the Setup Utility screen.

Delete all routes Deletes all routes and data in memory.
If you have an internal or SD storage card, the route to be deleted 
depends on what you have chosen on the Setup Utility screen.

Initialize Formats the active memory. Note this will delete all routes and data in 
active memory.

TIP Configure only when you open data collection. You must have a Route 
open for the memory option to display. A Route must be in active 
memory.
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Multi Meas 
View

Determines what is viewed on the screen while taking 
multiple measurement location.

First (default)
Last
All
None

Trigger Sets the trigger source. External (default)
Uses the trigger input from the POWER/USB/TRIGGER 
connector as the trigger source.
Laser Tach
Enables the internal Laser Tachometer when a Phase or Order 
measurement is collected.

Trig Level Sets the trigger level. Applies only to triggered measurements (rpm points, phase points, time-synchronous averaged points).

Hist. Data 
Collect

Determines how data is stored in the Dynamix 2500 data 
collector when collecting multiple measurements for a signal 
point:
• If you want to conserve space, you should select Always 

Overwrite.
• If you want multiple data sets to be stored and unloaded, 

select Always Append.

Always Append: adds the new data for a point to existing 
data.
Always Overwrite: replaces existing data with new data.
Always Ask (default): displays a dialog box before attempting 
to store the data.

Table 14 -  Instrument Configuration Parameters

Parameter Description Value

Value Description

Automatic Samples the trigger signal before collecting the triggered measurement and sets an appropriate trigger 
level automatically. When collecting data on a triggered point, a message displays on the screen while 
the trigger level is being sampled.
The length of time for which the trigger is sampled during autotriggering is dependent on two factors:
• The high pass filter selected for the point.
• The lower the high pass filter cutoff, the longer the trigger will be sampled.
Mach. Speed
If the Mach. Speed is set to `Normal,’ the maximum trigger sampling time is about one second. If the 
Mach. Speed is set to `Slow,’ the maximum trigger sampling time is about 10 seconds. The Normal 
setting supports autotriggering on machines running at speeds down to ~120 rpm. The Slow setting 
will support autotriggering on machines running at speeds down to ~6 rpm, depending on the width of 
the trigger pulse.

Fixed: Default The Dynamix 2500 data collector uses the signal level entered in the point setup information (either 
Route or Offroute) as the trigger point. 
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Using Memory Cards The Dynamix 2500 data collector can store program information and collect data 
internally and on a memory card. The data collector accepts a standard SDHC 
storage card up to 16 GB that is supported with a Microsoft Windows CE driver. 
The storage card can be inserted when the instrument is powered on or off. 

Insert and Remove a Storage Card
You insert the memory card into the collector through the base cover at the 
bottom of the instrument. The memory card can be inserted while the Dynamix 
2500 data collector is powered on or off.

Insert a Storage Card

Follow these steps to insert a storage card.

1. With the bottom of the Dynamix 2500 data collector facing you, press 
down the two latches of the base cover. 

2. Pull the base cover towards you.

3. With the memory card contact side facing up, gently slide the card into the 
instrument until it is firmly seated in place. 

4. Close the base cover. 

Remove a Storage Card

Follow these steps to remove a storage card.

1. With the bottom of the Dynamix 2500 data collector facing you, press 
down the latches of the base cover to open.

2. Press the card to release and gently remove the card.

IMPORTANT The Dynamix 2500 data collector is only certified for use with the Sandisk 
Secure Digital (SD) card SDSDx-yyy.

TIP Due to the limitations of the Windows CE operating system. The largest 
single file size can be 2 GB.

TIP The SD storage card must be initialized/formatted before you can use it 
in the data collector. The data collector does not initialize/format the 
cards.

WARNING: To prevent loss of route data, it is recommend that memory 
cards (SDHC) are properly formatted prior to use to FAT 32 using a 
computer before use.
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Setting Up Measurements

This chapter describes setting up the measurement definitions in the Emonitor 
software, how alarms are handled, lists, and inspection codes.

Measurement definitions define how to collect and store measurements. You can 
create several different types of measurement definitions at each location. The 
Emonitor software can then take advantage of the abilities of your data collector 
by combining some of the measurement definitions when you load them into the 
data collector. By combining measurements, the software can shorten the data 
collection time. 

Topic Page

Measurement Definition Options 66

Setting Up Collection Specifications 75

Setting Up Measurement Definitions 86

Setting Up Alarms, Lists, and Inspection Codes 104

IMPORTANT For complete information on all the Emonitor software features, tasks, 
and interface elements, refer to the software’s online help.
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Measurement Definition 
Options

From the Tools menu, choose Set Active Collectors to determine the definitions 
for measuring in the Emonitor software.

Figure 11 - Set Active Collectors 

In some cases, both the Emonitor software and the Dynamix 2500 data collector 
support only certain options. In other cases, the Emonitor software can support 
an option that the Dynamix 2500 data collector cannot support.

For example, the Emonitor software can apply a software high pass filter to the 
data after it unloads the data from the Dynamix 2500 data collector. This lets you 
use a filter that is not available in the data collector.

IMPORTANT If no data collectors are active, the selections that appear in the 
Measurement Definition pane are the ones available to all data 
collectors:

• If only the Dynamix 2500 data collector is active, then only the 
valid choices for the unit appear in the lists.

• If the data collector and other data collectors are active at the 
same time, you see the selections that are common to all data 
collectors that are active.

Therefore, you may not see all the selections available for the 
Dynamix 2500 data collector.

When using the Dynamix 
2500 data collector, select 
the Enpac 2500 (EP25) 
driver.
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Measurement Types

The Emonitor software and the Dynamix 2500 data collector support the 
following measurement definition types.

Measurement Filters

The Emonitor software and the Dynamix 2500 data collector each support 
certain measurement filters. Some of the filters are supported in both. You can 
define custom band filters (high pass, low pass, band pass) by creating a new band 
filter using the Band Filter function. You can choose to use a filter in the Dynamix 
2500 data collector by selecting the Analog or RSS (digital) option when you 
define a filter.

See Instrument Configuration Parameters on page 59.

Follow these steps to define a band filter.

Table 15 - Measurement Types

Item Description

Magnitude This measurement type is a single value representing the total energy of 
a measurement. For example, a vibration magnitude represents the total 
energy in a vibration spectrum. The Dynamix 2500 data collector can 
also collect magnitude+phase measurements, for the first through the 
eighth orders.

Numeric Manual entry or DC voltage measurement of an overall value such as 
temperature, pressure, flow rate, operating speed, or proximity probe 
gap readings.

Numeric Spectrum  Frequency domain measurement of frequency versus amplitude, usually 
for velocity or acceleration. The Dynamix can collect phase with 
spectrum measurement definitions.

Time Waveform  Time domain measurement of time versus amplitude, usually for 
displacement, velocity, or acceleration.

TIP The available measurement types in the Emonitor software depend on 
the active collectors you choose Set Active Collectors from the Tools 
menu. If you have two or more active data collectors, you may not see all 
the selections available for the Dynamix 2500 data collector.
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1. From the Setup menu, choose Band Filters.

2. Choose a Band Filter and click New.

3. Type a name and click OK.

Filters in the Emonitor software are referred to as software filters. Filters in data 
collectors are referred to as hardware filters.

Hardware filters alter the signal in the data collector. The Emonitor software 
filters alter the signal (data representing the signal) after you unload the data into 
the software. 

In general, if the filter you want to use is available in both the software and in the 
data collector, it is to your advantage to use the hardware filter in the data 
collector. 

Advantage of Hardware Filters

They can remove low frequency, high amplitude signal components that would 
dominate the dynamic range in the data collector. This results in improved 
amplitude resolution of the remaining signal range.

When collecting low frequency vibration data, applying an overall filter helps 
reduce long ranging times. In particular, overall filters with the highest low 
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frequency cutoff point decrease ranging time the most. Try to set your maximum 
frequency and lines of resolution such that the formula results in the highest value 
that would be practical in your application. 

See Instrument Configuration Parameters on page 59 for more information 
about filters.

Advantage of Software Filters

If there is no corresponding filter in the data collector, or you choose not to use it, 
the Emonitor software can apply a digital filter after you unload the data from the 
data collector.

gSE Filters

Use a gSE filter to detect bearing and other component defects. The gSE filters 
provide a demodulated measurement similar to the ‘envelope’ measurements in 
other instruments. You can use gSE filters with magnitude and spectrum 
measurement definitions.

These six gSE filters are available in the Dynamix 2500 data collector. If you 
select the Envelope filter, the Emonitor software automatically picks the 5 kHz 
gSE filter.

TIP These are two other ways you can reduce ranging time:

• Only use filters that are built into the data collector.
• Change the Autoranging in the Instrument Configuration menu to 

either Fixed or Aggressive. 

Table 16 - gSE Filters

Filter CPM

100 Hz gSE 6000

200 Hz gSE 12000

500 Hz gSE 30000

1000 Hz gSE 60000

2000 Hz gSE 120000

5000 Hz gSE 300000

IMPORTANT In Emonitor software, on the Data Collector dialog box, the Enpac 
Emulation parameter must be set to Yes.

See Data Collector Advanced Settings Parameters on page 112 
for settings descriptions.
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ESP Filters

Use an Envelope Spectrum Processing (ESP) filter to detect bearing and other 
component defects. The ESP filters apply a band pass filter, envelope the time 
domain signal, and then perform a frequency analysis on the result. ESP filters are 
built into the Dynamix 2500 data collector, and you cannot change them in the 
Emonitor software. You can use ESP filters with the magnitude and spectrum 
measurement definitions.

The following ESP filters are available with the Emonitor software and the 
Dynamix 2500 data collector:

• 0.6…1.25 kHz
• 1.25…2.5 kHz
• 2.5…5 kHz
• 5…10 kHz
• 10…20 kHz

High Pass Filters

Use a high pass filter to remove high vibration, low frequency signal components 
that would dominate the signal. For example, structural vibration or signal 
components generated by an integrator. 

The high pass filter excludes all frequencies below a defined frequency. It allows, 
or passes, frequencies above the defined frequency. You define these and other 
band filters using the Setup > Band Filter function in the data collector. You can 
use a high pass filter with the magnitude and spectrum measurement definitions.

If you select Analog as the data collector filter type, when you define a high pass 
filter, the data collector uses one of the following filters determined by the 
following formula.

IMPORTANT In Emonitor software, on the Data Collector dialog box, the 
Enpac Emulation parameter must be set to No.

See Data Collector Advanced Settings Parameters on page 112 
for Settings descriptions.

2 (max frequency)
number of lines

--------------------------------------------
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The Emonitor software uses a high pass filter with one of the low frequency 
cutoffs shown in this table. It uses the filter whose cutoff is greater than or equal 
to the result of the formula.

Order (Magnitude) Filters

Use order filters to define the bands around orders for magnitude and 
magnitude+phase measurements. You define these filters using Setup > Band 
Filter function in the data collector. You can use order filters with the magnitude 
and spectrum measurement definitions.

You can define and use order filters for the first through the eighth orders with 
the Dynamix 2500 data collector. If you specify the Maximum frequency in 
Orders filters, select Analog and Order normalize when you define the orders 
filters, then the data collector calculates the orders from an external trigger.

The Dynamix 2500 data collector then uses its own filters to calculate the 
magnitude and phase for the first through the eighth orders. The Emonitor 
software calculates the magnitude values (without phase) for additional orders 
after you unload the data. 

If you select None instead of Analog, the Emonitor software also calculates 
magnitude values after you unload the data.

Table 17 - Low Frequency Cutoffs

Integrated (A to V, A to D, V to D) Non-integrated (A, V, and D)

0.36 Hz (21.6 CPM) 0.18 Hz (10.8 CPM)

5.30 Hz (318 CPM) 2.67 Hz (160.2 CPM)

23.80 Hz (1428 CPM)

EXAMPLE

The Emonitor software uses the 5.30 Hz (318 CPM) filter for an 
integrated measurement. It uses the 2.67 Hz (160.2 CPM) filter for a 
nonintegrated measurement.

IMPORTANT If you want phase, remember to specify the Maximum 
frequency (in Collection Specification dialog box) in Orders, 
select Analog in the Band Filter Specification dialog box and 
Order normalize in the Collection Specification dialog box. The 
Emonitor software does not select these options by default. 

2 120,000 CPM
400 lines

------------------------------------------- 240000
400

------------------ 600 CPM 10 Hz= = =
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Default Filters

There are also four default filters in the Emonitor software that map to specific 
filters in the Dynamix 2500 data collector. The filters are High Frequency, 
Envelope, Smart HP, and Overall.

Table 18 - Default Filter Descriptions

Default Filters Description

High Frequency Typically this filter maps to a high frequency filter in the data collector and is 
available only for magnitude acceleration measurements. In the Dynamix 
2500 data collector, it maps to the 5 kHz gSE filter.

Envelope Typically this filter maps to one of the gSE filters in the data collector and is 
available for magnitude and spectrum acceleration measurements. In the 
Dynamix 2500 data collector, it maps to the 5 kHz gSE filter.

SmartHP (Smart High Pass) Typically this filter maps to a specific high pass filter in the 
data collector and is available for magnitude, spectrum, and time waveform 
measurements. In the Dynamix 2500 data collector, it maps to the filters 
shown in the table below, depending on the results of comparing the filter 
choice to the formula below.
The Emonitor software uses the following formula. 

The Emonitor software chooses an overall filter with one of the low frequency 
cutoffs shown in the table below. It uses the filter whose cutoff is less than 
the result of the formula.

Overall Typically this filter maps to a specific high pass filter in the data collector and 
is available for magnitude, spectrum, and time waveform measurements. 
In the Dynamix 2500 data collector, it maps to the unit filters shown in the 
table below, depending on the results of comparing the filter choice to the 
formula below. The Emonitor software uses the following formula.

2 (max frequency)
number of lines

--------------------------------------------

Integrated (A to V, A to D, V to D) Non-integrated (A, V, and D)

5.30 Hz (318 CPM) 2.67 Hz (160.2 CPM)

23.80 Hz (1428 CPM)

Example

The 
Emonitor software uses the 5.30 Hz (318 CPM) filter for an 
integrated measurement. It uses the 2.67 Hz (160.2 CPM) filter 
for a non-integrated measurement.

2 120,000 CPM
400 lines

------------------------------------------- 240000
400

------------------ 600 CPM 10 Hz= = =

2 (max frequency)
number of lines

--------------------------------------------
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the Emonitor software uses an overall filter with one of the low frequency cutoffs shown 
in the table below. It uses the filter whose cutoff is greater than or equal to the result 
of the formula.

RSS Overall 

The Dynamix 2500 data collector lets you to take a digital overall measurement, 
instead of analog. This set up makes measurement collection faster. Be aware that 
this Root Sum Squares (RSS) overall value is not as complete because it does not 
include the power in the signal from below the first spectral bin or above the 
highest spectral bin. The RSS overall values may not trend well with analog 
overall measurements.

To use the RSS filter, you must create a Band Filter in the Emonitor software.

1. Select Setup > Band Filter and click New. 

2. Choose RSS (digital) as the filter type.

Integrated (A to V, A to D, V to D) Non-integrated (A, V, and D)

0.36 Hz (21.6 CPM) 0.18 Hz (10.8 CPM)

5.30 Hz (318 CPM) 2.67 Hz (160.2 CPM)

23.80 Hz (1428 CPM)

EXAMPLE The Emonitor software uses the 5.30 Hz (318 CPM) filter for an 

integrated measurement. It uses the 2.67 Hz (160.2 CPM) filter for a 
non-integrated measurement.

IMPORTANT The available filters in the Emonitor software depend on the data 
collectors you select as active data collectors using Tools > Set Active 
Collectors:

• If you have two or more active data collectors, you may not see all 
the selections available for the unit.

• If you have no active data collectors, you see all the selections for 
every data collector, not just the selections for the unit.

2 30,000 CPM
400 lines

---------------------------------------- 60000
400

--------------- 150 CPM 2.5 Hz= = =
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Figure 12 - RSS filter

Measurement Units

The Emonitor software and the Dynamix 2500 data collector support many 
different measurement units. The measurement units that appear in the data 
collector are text that depend on the following definitions:

• Type of measurement definition
• Units for the measurement definition
• Transducer specification used in the collection specification for the 

measurement definition

The data collector collects data for english units, metric units, or decibels. It uses 
the units that you select in the Emonitor software. You can select units from a 
single system, for example, English g’s, in/sec, or you can mix units from different 
systems, for example, English g’s, in/sec and Metric m/s2, m/sec) in one list. 

The Dynamix 2500 data collector loads the exact text string from the Emonitor 
software. The signal detection type, for example, peak, rms and true peak is 
appended to the units on the data collector.

IMPORTANT Using the 0.36 Hz (21.6 CPM) low cutoff filter for integrated 
measurements or the 0.18 Hz (10.8 CPM) low cutoff filter for 
non-integrated measurements will always cause the Dynamix 
2500 data collector to go into a long autorange mode. Only use 
these filter settings when very low frequency data is required.

TIP The measurement units cannot be changed after you collect 
data for the measurement definition.

Click to use the RSS filter
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Setting Up Collection 
Specifications

Measurement definitions are controlled in part by the collection specification 
(Setup > Collection). You select the collection specification when you set up the 
measurement definition. You can create new collection specifications based on 
your specific measurement by choosing Setup > Collection.

Figure 13 - Collection Specification Dialog Box

The transducer specification used in the collection specification includes both 
the base unit and the calibration value.

Edit the Measurement Definitions

The Emonitor software does not allow you to change some of the information for 
a measurement definition after you collect data for that measurement definition. 
This prevents you from collecting and then comparing data with different 
measurement definition selections. You cannot edit the Data Type or Units 
columns in the Measurement Definition dialog box after you collect data You 
can, however, change the Collection, Filter, and the Storage columns for a 
measurement definition after collecting data.

The figures in a typical measurement setup in the following sections refer to 
making selections in these dialog boxes. For example, a table for STD (HZ) 2000 
collection specification would look like this.

Measurement 
Input Type

Measurement 
Window Type

Measurement 
Maximum 
Frequency

Measurement 
Zoom

Measurement 
Resolution

Measurement Signal 
Detection Type

Number and Type of 
Averages

Orders Track

Magnitude and Phase 
Measurement at 
Orders

Magnitude and Phase 
Measurement at 
Orders

IMPORTANT Changing the collection specification can make it difficult to 
compare data after the change with data before the change.

Table 19 - STD (Hz) 2000 collection specification

Transducer Window Signal Detection Fmax Lines Phase? Order Norm? Averages

Accelerometer Hanning Peak 2 kHz 400 No No 4 linear
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The table for the transducer specification in the STD (Hz) 2000 collection 
specification would look like this.

Measurement Input Types

The input type is part of the transducer specification (Setup > Calibration). The 
transducer is part of the collection specification (Setup > Collection). You select 
the collection specification when you set up the measurement definition.

The Emonitor software and the Dynamix 2500 data collector support the 
following input types.

Follow these to specify an input type. 

1. Select Setup > Calibration.

2. Choose the correct Dynamix 2500 data collector from the Collector list.

3. Assign Input types, Calibration, and appropriate Units to the transducer.

Figure 14 - Transducer Calibration dialog box

Table 20 - Transducer specification in STD (Hz) 2000 collection specification

Name Base Unit Input Type Units DC Offset

Accelerometer Acceleration ICP Accel g’s 0

Input Type Description

ICP Accel Use for ICP accelerometers requiring current from a power 
supply.

AC Coupled Use for AC voltage measurements and non-ICP accelerometers.

DC Coupled Use for DC voltage measurements. This includes numeric 
(process) measurements taken from a DC voltage output.

Manual Entry Use for numeric (process) measurements where you enter the 
value for the measurement with the data collector keyboard.
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Measurement Window Types

The measurement window type is part of the collection specification (Setup > 
Collection). Select the collection specification when you set up the measurement 
definition. 

The Emonitor software and the Dynamix 2500 data collector support the 
following measurement window types. In general, the Hanning measurement 
window provides the best compromise of frequency and amplitude accuracy for 
most predictive maintenance measurements.

Measurement Signal Detection Types

The signal detection is part of the collection specification (Setup > Collection). 
See Collection Specification Dialog Box on page 75. You select the collection 
specification when you set up the measurement definition.

The Emonitor software and the Dynamix 2500 data collector support the 
following signal detection types.

Measurement 
Window Types

Description

Hanning A general purpose window to use on random type data when frequency 
resolution is more important than amplitude accuracy. Use this setting 
for most of your machinery monitoring activities.

Rectangular The data collector does not apply a window. Use this only for transient 
signals that die out before the end of the time sample, or for exactly 
periodic signals within the time sample.

Flattop Use this when amplitude accuracy is more important than frequency 
resolution. In data with closely spaced peaks, a Flattop window may 
smear the peaks together into one wide peak. Use this setting for 
sinusoidal or calibration signals.

Hamming A general purpose window that is similar to the Hanning window. It 
provides better frequency resolution but decreased amplitude accuracy 
when compared to the Hanning window. You can use it to separate close 
frequency components.

Table 21 - Signal Detection Types

Signal 
Detection Type

Description

None Use for numeric measurements. None defaults to RMS when applied to 
magnitude or spectrum measurement definition.

RMS Use for detection of voltage and current. For the frequency domain, the dynamic 
signal is measured as the square root of the mean of the square of the signal. 
This is the RMS amplitude of a sine wave at the frequency of interest. For the 
time domain, the dynamic time signal is squared, integrated over some time 
period, and then the square root is taken.
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Measurement Maximum Frequencies

The measurement maximum frequency is part of the collection specification 
(Setup > Collection). See Collection Specification Dialog Box on page 75. 

Select the collection specification when you set up the measurement definition. 
The Emonitor software and the Dynamix 2500 data collector support the 
following maximum frequencies in Hz (CPM).

Peak Use for detection of acceleration, velocity, and high frequency energy. This is the 
peak (0 to maximum) amplitude of a sine wave at the frequency of interest and is 
calculated from the RMS value.

True Peak Use to detect impacts and random transients. The dynamic time signal contains 
the absolute value of the largest peak (positive or negative) within a specified 
time window. Returns a magnitude value only. If used with a spectrum 
measurement, the Emonitor software uses a Peak signal detection type instead. 
This value is not calculated but is measured directly.

 True Peak-Peak Use to detect impacts and random transients. The dynamic time signal contains 
the absolute value of the largest peak to peak distance within a specified time 
window. Returns a magnitude value only. If used with a spectrum measurement, 
the Emonitor software uses a Peak-Peak signal detection type instead. This value 
is not calculated but is measured directly.

Table 21 - Signal Detection Types

Signal 
Detection Type

Description

Table 22 - Maximum frequencies

Hz CPM Hz CPM Hz CPM Hz CPM Hz CPM

10 (600) 200 (12,000) 1100 (66,000) 3000 (180,000) 12,800* (768,000)*

20 (1200) 250 (15,000) 1200 (72,000) 3125* (187,500)* 13,000 (780,000)

25 (1500) 256* (15,360)* 1250 (75,000) 3200 (192,000) 15,000 (900,000)

32* (1920)* 300 (18,000) 1280* (76,800)* 4000 (240,000) 16,000 (960,000)

40 (2400) 320 (19,200) 1300 (78,000) 5000 (300,000) 18,000 (1,080,000

50 (3000) 400 (24,000) 1400 (84,000) 6000 (360,000) 20,000 (1,200,000)

64* (3840)* 500 (30,000) 1500 (90,000) 6250* (375,000)* 25,000 (1,500,000)

80 (4800) 600 (36,000) 1600 (96,000) 6400 (384,000) 30,000 (1,800,000)

100 (6000) 625 (37,500) 1700 (102,000) 7000 (420,000) 32,000* (1,920,000)*

120 (7200) 640* (38,400)* 1800 (108,000) 8000 (480,000) 40,000 (2,400,000)

125 (7500) 700 (42,000) 1900 (114,000) 9000 (540,000) 80,000 (4,800,000)

128(1) (7680)* 800 (48,000) 2000 (120,000) 10,000 (600,000)

150 (9000) 900 (54,000) 2500 (150,000) 12,000 (720,000)

160 (9600) 1000 (60,000) 2560* (153,600)* 12,500* (750,000)*

(1) These values are available in the Dynamix 2500 data collector only in Offroute data collection.
78 Rockwell Automation Publication 1441-UM001B-EN-P - September 2012



Setting Up Measurements        Chapter 3
You can either select a value from the drop down list, or you can enter a value in 
Maximum frequency in the Collection Specification dialog box. If you enter a 
value that does not match one of the values above, the Emonitor software uses the 
next higher maximum frequency. 

Measurement Resolution

The measurement resolution is part of the collection specification (Setup > 
Collection). See Collection Specification Dialog Box on page 75. 

Select the collection specification when you set up the measurement definition. 
The Emonitor software and the Dynamix 2500 data collector support these 
resolutions.

The values that appear in the Number of lines drop down list in the Collection 
Specification dialog box are those for spectrum measurements. The Emonitor 
software uses the corresponding number of time samples from the table above for 
time measurement definition.

You can calculate the number of time samples from the number of spectral lines 
using this formula.

You can calculate the total time required to collect a time waveform measurement 
from the Number of lines value and the Maximum frequency value in the 
Collection Specification dialog box (Setup > Collections).

Table 23 - Measurement Resolutions

Spectral Lines Time Samples

100 256

200 512

400 1024

800 2048

1600 4096

3200 8192

6400 16,384

12,800 32,768

25,600(1)

(1) The Emonitor software does not currently support 25,600 spectral lines and will 
not upload this data.

65536(2)

(2) The data collector is able to take the time samples Offroute but will not upload the 
data to the Emonitor software.

time samples spectral lines 2.56=
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If your Maximum frequency is specified in CPM, convert CPM to Hertz using 
the following formula.

Next, find the total collection time for the time waveform measurement using 
this formula.

Number and Type of Averages

The number and type of averages are part of the collection specification (Setup > 
Collection). See Collection Specification Dialog Box on page 75. 

Select the collection specification when you set up the measurement definition. 
The Emonitor software and the Dynamix 2500 data collector support the 
following number and types of averages for data collection.

Averaging is useful for reducing random errors. Random errors include 
background vibration due to some source other than the machine being 
measured. If you collect more averages, you have fewer random errors. However, 
collecting more averages requires more time.

Overlap processing (Percent overlap) speeds up the averaging process. The 
overlap amount determines how much of the time samples are overlapped for 
successive averages. The greater the overlap, the faster the sample can be collected. 
The disadvantage is that the greater the overlap, the less new data there is, and the 
greater the influence of random errors.

EXAMPLE If you had a Maximum frequency value of 7200 CPM and a Number of 
lines value of 400, you would:
1. Convert CPM to Hz.

2. Find the total collection time.

Averages Description

Linear Up to 4096 averages.

Time Synchronous Up to 255 averages, and requires a trigger.

Exponential Up to 99 averages. Uses exponential weighting. Use for measurements on a 
continuous signal that may be slowly varying. Also use to obtain a uniform 
statistical error over all frequencies.

Peak Hold Up to 99 averages. Holds the highest measured value in each bin (line).

Fmax (Hz)
Fmax (CPM)

60
-------------------------------=

collection time
spectral lines
Fmax (Hz)

-------------------------------=

7200 CPM
60

-------------------------- 120 Hz=

400 lines
120 Hz

--------------------- 3.3 seconds=
80 Rockwell Automation Publication 1441-UM001B-EN-P - September 2012



Setting Up Measurements        Chapter 3
Order Normalization for Orders Track Spectrum

There are two requirements for implementing Orders Track measurements. The 
Fmax value must fall within the range of 10 to 5000 Hz, and the machine speed 
may not vary by more than 10% during the measurement collection. 

For example, if you set up a machine that runs at 3500 rpm for an Fmax of 100 
Orders, the measurement will not work because the required Fmax is 15,000 Hz.

To Set Up Orders Track FFT Collection

The Dynamix 2500 data collector supports the specification and collection of a 
spectrum with an Fmax defined in terms of number of orders for a varying 
machine speed. For Orders Track data collection, you are required to use a trigger 
to continually determine machine speed. 

With orders tracking, the sampling rate is not fixed during the collection period. 
Instead, the time spacing between the samples may be constantly varying so that a 
fixed number of samples per shaft revolution is collected. The x-axis of the time 
waveform is no longer measured in seconds, but instead it is measured in degrees 
or shaft position. From this, the corresponding spectral information is no longer 
measured in Hz or CPM, but instead it is measured in orders. Orders tracking 
removes all non-synchronous frequencies from the spectrum. 

Follow these steps to set up route points using the Orders Track collection.

1. Create a collection specification in the Emonitor software that uses Orders 
for the maximum frequency (Fmax). 
Rockwell Automation Publication 1441-UM001B-EN-P - September 2012 81



Chapter 3 Setting Up Measurements
2. Also, check the Order Normalization checkbox to signify Orders Track to 
the Dynamix 2500 data collector.

3. Create a Spectrum measurement definition that uses the Orders Based 
collection specification.

4. Tag that measurement and load it to the Dynamix 2500 data collector with 
a list.

For Orders Track data collection, you are required to use a trigger to continually 
determine machine speed. 

Orders tracking analysis can be used effectively to diagnose the vibrations of 
variable speed machines. The orders tracking yields data in the revolution 
domain, not the time domain. In an orders spectrum, signals that are periodic in 
the revolution domain appear as peaks and orders or harmonic components 
remain fixed in their position through speed changes. This is a clear advantage 
when comparing the characteristics of variable speed machines over a period of 
time.

Using Frequency Items for the Diagnostic Frequency Cursor

Using the Dynamix 2500 data collector, you set up frequency items in the 
Emonitor software and download them to the Dynamix 2500 data collector. 
Then, you can review the data using the Diagnostic Frequencies cursor. This 
feature lets you to diagnose the peaks you see in the Dynamix 2500 data collector 
using the frequency items from the host software. 

Orders Track
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To load the Diagnostic Frequency labels, you must check the Load Frequency 
Labels checkbox in the Load Options dialog box. 

Setting Up Speed References

The Dynamix 2500 data collector can determine the speed using speed references 
in the Emonitor software. The speed reference value is used by the frequency 
items to calculate the Fmax of the dependent measurements. 

To set up speed references in the Emonitor software, double-click in the rpm 
column in the Location pane. 

The Machine Speed Setup dialog box appears. 

You can choose a frequency reference item as your machine speed reference. This 
allows for machine speeds to be stored and retrieved dynamically. The Dynamix 
2500 data collector supports two types of frequency types: speed reference and 
linear rotational.

If you want to use a collected measurement from the Dynamix 2500 data 
collector to set the machine speed, you have two options:

• Use a manual entry process measurement to enter machine speed by 
reading it from any instrument in your plant. The measurement can then 
be referenced for the machine speed, and would be updated every time you 
unload that measurement.
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• Use a measurement with Order normalization checked in the collection 
specification. The machine speed from an internal or external tachometer 
will be used for the machine speed. If the Order normalization checkbox is 
not checked, the Dynamix 2500 data collector will use a fixed Fmax value 
and will not calculate the Fmax based on the current speed of the machine.

The Emonitor software orders all the measurements in the route so that the 
dependent machine speed measurement is collected first. This way, the route is 
set up for the most accurate machine speed entry, and the measurements refer to 
the correct machine speed. The band alarms and frequency labels adjust to 
changes in the machine’s speed.

To set up the Speed Reference Frequency for the Dynamix 2500 data collector, 
double-click in the Definition column in the Speed Reference row in the 
Frequency Item pane. The Speed Reference Frequency dialog box appears.

There are three ways to obtain a speed references:

• You can enter a constant for the speed.
• You can use the value in the Machine Speed column for a location on an 

item in the Hierarchy Tree.
• You can use the value from a process measurement as the speed. 

Press F1 to find out more information about each option in the Speed Reference 
Frequency dialog box.

TIP The Orders normalization checkbox does not produce 
Orders Tracking measurements when used with speed 
references. 

Current spectrum measurement and Extract from 
current spectrum measurement are not supported in 
the Dynamix 2500 data collector 2500.
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You can set up the Linear to Rotational Frequency by double-clicking the 
Definition column in the Linear to Rotational row in the Frequency Item pane. 
This dialog box lets you to set up a rotational frequency item based on a linear 
speed.

Unsupported Measurement Selections

Each data collector supports only certain selections in the drop down lists in the 
Measurement Definition pane. the Emonitor software automatically displays the 
correct selections when you select one or more active collectors. You select the 
active collector or collectors by choosing Tools > Set Active Collectors in the 
Emonitor software. If you do not select the Dynamix 2500 data collector as the 
active collector, it can affect the selections in one of two ways:

• If you do not select any collectors, the Emonitor software displays all 
possible selections, not just those for the Dynamix 2500 data collector.

• If you select two or more different collectors, the Emonitor software 
displays only the selections that are available for both collectors.

As an example, there are certain filters available in the Dynamix 2500 data 
collector. Then there are three possible cases:

• You select the Dynamix 2500 data collector as the only active collector. the 
Emonitor software displays the correct filters in the measurement filter 
column of the Measurement Definition pane.

• You do not select any active collectors. the Emonitor software displays 
many more filters than are available for the Dynamix 2500 data collector.

• You select two or more active collectors. the Emonitor software may 
display only some, or none, of the filters that are available for the Dynamix 
2500 data collector.

For more information on setting the active collectors, see the Emonitor software 
online help.
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Setting Up Measurement 
Definitions

The Emonitor and the Dynamic 2500 data collector can collect and store a wide 
range of measurements. A few questions can arise when determining how the 
Emonitor software works with the Dynamix 2500 data collector for each 
different type of measurement definition:

• How does the Emonitor software handle measurement units and alarms 
available in the Emonitor software but not supported in the Dynamix 
2500 data collector?

• How many orders of magnitude and phase can the Dynamix 2500 data 
collector collect?

• How does the Dynamix 2500 data collector support collecting a spectrum 
when a magnitude measurement is in alarm?

The Emonitor software combines measurement definitions when it creates a load 
file from a list of measurement definitions. For example, the Emonitor software 
can combine the measurement definitions at a location so that the data collector 
collects all the measurements at one time. This makes data collection faster and 
more efficient because you do not have to start each measurement individually. 

The Emonitor software and the Dynamix 2500 data collector are designed to 
make collecting data as quick and efficient as possible. To shorten data collection 
time, the Emonitor software combines two or more measurement definitions at a 
location into a single measurement. This lets you collect two or more 
measurements by pressing a single key on the Dynamix 2500 data collector.

For more general information on setting up measurement definitions, see the 
Emonitor software online help.

Magnitude Measurement Definitions

The Emonitor software and the Dynamix 2500 data collector support magnitude 
measurement definitions. This topic lists the unique characteristics of the 
Dynamix 2500 data collector that you may need to know when setting up and 
collecting magnitude data.

Measurement Units Not Supported in the Dynamic 2500 Data Collector

• Magnitude measurement definitions with unit not supported by the 
Dynamix 2500 data collector map to units of USER (eus) in the data 
collector. This results in a process (DC) voltage measurement. 

• For a list of supported measurement units, see Measurement Units on 
page 74.

When you display a measurement definition in the data collector with an 
unsupported unit, it chooses the USER (eus) units. You can still collect and store 
data using unsupported units.
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Magnitude Alarms in the Dynamic 2500 Data Collector

• The Dynamix 2500 data collector supports above, below, in window, and 
out of window magnitude alarms.

• You must set Trigger to ‘Yes’ for any magnitude alarms you want to appear 
in the Dynamix 2500 data collector during data collection.

• For more on how the Emonitor software combines alarms before sending 
them to the Dynamix 2500 data collector, see Alarms and the Data 
Collector on page 104.

Collecting Magnitude Measurements in Multiple Frequency Bands

You can set up multiple measurement definitions at a location to collect 
magnitude values for individual frequency bands. Use band filters to define the 
different frequency bands in the measurement definitions. 

Make sure you select None in the Band Filter dialog box. This forces the 
Dynamix 2500 data collector to collect a spectrum measurement. After you 
unload the measurement, the Emonitor software calculates the magnitude values 
in the bands from the spectrum.

If your measurements include both magnitude and phase, the unit can collect up 
to eight orders. If your measurements include magnitude only, the unit can 
collect up to 200 orders.

Proximity Probe Measurements

Proximity probes measure the movement of a shaft within a bearing. You usually 
make two types of proximity probe measurements with magnitude measurement 
definitions. 

The dynamic or AC component indicates the changing (dynamic) distance 
between the probe and bearing shaft. The static or DC component indicates the 
average distance between the probe and the shaft. This is also referred to as the 
DC gap.

Follow these steps to setup a Dynamic (AC) Component.

1. Set up a displacement transducer in the Transducer Calibration dialog box 
with Input type set to AC Coupled and Units set mils or um.

Make sure you enter the Calibration value that converts the voltage to a 
displacement.

2. Set up a Collection Specification with Transducer set to the AC 
displacement and Signal detection set to Peak-peak. 
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3. Finish setting up the dynamic proximity probe measurement by setting 
Data Type to Magnitude and Units to mils or um.

You can use a Filter if desired.

Follow these steps to setup a Static (DC) component or gap.

1. Set up a displacement transducer in the Transducer Calibration dialog box 
with Input type set to DC Coupled and Units set to mils or um.

Make sure you enter the Calibration value that converts the voltage to a 
displacement. If you are using the DC Input Module to remove the AC 
component and attenuate the signal be a factor of 2.5, then you must 
divide your transducer’s calibration by 2.5.

2. Set up a Collection Specification with Transducer set to the DC 
displacement and Signal detection set to RMS.

3. Finish setting up the dynamic proximity probe measurement by setting 
Data Type to Magnitude and Units to mils or um.

You must set the Filter to None because any type of high pass filtering 
removes the DC component. 

Typical Magnitude Measurement Definitions

This figure shows the setup for a typical magnitude measurement definition

Figure 15 - Magnitude measurement definition

The following table shows the STD (Hz) 2000 collection specification.

The following table shows the transducer specification in the STD (Hz) 2000 
collection specification.

Table 24 - Collection specification for magnitude measurement definition

Transducer Window Signal Detection Fmax Lines Phase Order Norm? Averages

Accelerometer Hanning Peak 2 kHz 400 No No 4 linear

Table 25 - Transducer specification in STD (Hz) 2000 collection specification

Name Base Unit Input Type Units Calibration Value DC Offset

Accelerometer acceleration ICP Accel g’s 100 0
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This figure shows the setup for a typical set of measurement definitions with 
multiple frequency bands.

Figure 16 - Magnitude with Multiple Frequency Bands Measurement Definitions(1)

The filter specifications are shown in the table below:

Magnitude and Phase Measurements at Orders 

the Emonitor software and the Dynamix support collecting the magnitude and 
phase at orders. This topic describes the steps to set up measurement definitions 
to collect magnitude and phase with the Dynamix. This table describes items that 
you may need to know about collecting magnitude and phase at orders.

(1) The filter specifications used in the tables are not currently defined in the Emonitor software database. To 
define a new filter specification, choose Setup > Band Filters and click New.

Table 26 - Filter specifications for magnitude with multiple frequencies 

Name Low Cutoff High Cutoff Data collector filter type

0.8-1.2 Order 0.8 Orders 1.2 Orders None

1.2-3.5 Order 1.2 Orders 3.5 Orders None

3.5-8.5 Order 3.5 Orders 8.5 Orders None

8.5-50% Fmax 8.5 Orders 50% Max Freq None

50%-100% Fmax 50% Max Freq 100% Max Freq None

0.8-100% Fmax 0.8 Orders 100% Max Freq None

Item Description

Collecting phase • You must select Also collect phase data in the collection 
specification to collect phase.

• The data collector can collect phase only at the first through eighth 
orders.

Defining order filters You must select Analog when you define orders filters. The Dynamix 
2500 data collector automatically uses its internal order filters if you 
are collecting phase. 
If you are collecting only magnitude values and you do not select this 
option, the data collector collects a spectrum and the Emonitor 
software calculates the magnitudes after unloading.

Collecting magnitude and 
phase at orders

When collecting magnitude and phase at orders, the data collector 
always collects a spectrum measurement, and then calculates the 
magnitude and phase values from the spectrum.
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To Set Up Multiple Measurement Definitions for Magnitude and Phase

You create only one measurement definition for magnitude and phase at each 
order. The Also collect phase data checkbox in the Collection Specification 
dialog box determines whether you also want to collect phase as well as 
magnitude data.

follow these instructions to set up multiple measurement definitions for 
magnitude and phase.

1. Create a new measurement definition by selecting Magnitude in the Data 
Type column in the Measurement Definition pane.

2. Select the units for the measurement definition, using a dynamic unit such 
as g’s, m/s2, ips, mm/s, mils, um, or V.

3. Select the measurement filter. 

4. Collect the magnitude and phase at an order, select a band filter centered 
on the order. 

For example, select (create if necessary) a first order band filter with a Low 
cutoff of 0.8 Orders, and a High cutoff of 1.2 Orders.

See Measurement Filters on page 67 for details and the examples on the 
following pages.

5. Select the collection specification. 

Collecting magnitudes The Dynamix 2500 data collector can collect magnitude only at the first 
through the eighth orders. If you request additional orders, the Emonitor 
software calculates magnitude values at additional orders from the 
spectrum after unloading the data.

Collecting more orders 
than requested

The Dynamix 2500 data collector may collect more orders than 
requested, but it does not collect fewer than requested. Only the 
requested values are unloaded into the Emonitor software.

Displaying phase value The Dynamix 2500 data collector may display a phase value that differs 
from the value that appears in the Emonitor software by up to one 
degree.

Require trigger signal Phase and magnitude measurements at orders require a trigger signal. 
This can be from the internal laser tachometer or from an external 
trigger source such as a key phasor. 

IMPORTANT It is very important that order band filters be centered on the 
order. For example, 0.7…1.3 orders, 0.8…1.2 orders, 0.9…1.1 
orders, and so forth. If you do not center the band filters, 
magnitude and phase readings may not be accurate.

Item Description
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You must check the Also collect phase data checkbox in the Collection 
Specification dialog box so the data collector collects phase at orders.

6. Select the storage specification.

The first measurement definition is now complete.

7. If you want to create more than one measurement, copy the measurement 
definition by selecting the correct row and choosing Edit > Copy.

8. Move down to the next empty row in the measurement definition 
spreadsheet, and choose Edit > Paste to paste the copied measurement 
definition.

9. Edit the new measurement definition by changing the measurement filter.

10. Select a band filter centered on the next order.

11. Repeat steps 6 and 7 to create measurement definitions for the desired 
orders. 

You can then include these measurement definitions in a list and load it to 
the data collector. Remember that you must have a trigger signal to collect 
magnitude and phase at an order.

Typical Magnitude and Phase Measurement Definitions

The Measurement Definition pane for one through four orders might look like 
Magnitude and Phase Measurement Definitions on page 91. Note that all 
measurement definitions have the same units and collection specification.

Figure 17 - Magnitude and Phase Measurement Definitions

The following table shows the collection specification for Mag & Phase.

Table 27 - Collection specification for mag & phase measurement definitions

Transducer Window Signal Detection Fmax Lines Phase Order Norm? Averages

Accelerometer Hanning Peak 500 Hz 400 Yes Yes 4 linear
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The transducer specification in the Mag & Phase collection specification is 
shown in the table below.

The filter specifications are shown in the table below:

Numeric (Process) Measurement Definitions

The Emonitor software and the Dynamix 2500 data collector support numeric 
measurement definitions. This topic lists the unique characteristics of the 
Dynamix 2500 data collector that you may need to know when setting up and 
collecting numeric data.

Measurements Units Not Supported in the Dynamic 2500 Data Collector

• You can make a numeric measurement definition for any available 
measurement unit by setting Data Type to ‘Numeric.’

• Numeric measurement definitions with Input type set to ‘DC Coupled’ 
with units not supported by the Dynamix 2500 data collector map to units 
of USER (eus). The input type is part of the transducer specification that 
you select for the collection specification. This results in a process (DC) 
voltage measurement in the Dynamix 2500 data collector.

• For a list of support measurement units, see Measurement Units on 
page 74.

Full Scale Values for Numeric Measurements in the Dynamix 2500 data 
collector

• The full scale value in the Dynamix 2500 data collector for a numeric 
measurement is defined as ten times the value of the alarm or the baseline 
measurement.

• If no alarm or baseline measurement exists for the measurement in the data 
collector, the Dynamix 2500 data collector assumes a full scale value of 
10,000.

Table 28 - Transducer specification in mag & phase collection specification

Name Base Unit Input Type Units Calibration Value DC Offset

Accelerometer Acceleration ICP Accel g’s 100 0

Table 29 - Filter specifications in mag & phase measurement definitions

Name Low Cutoff High Cutoff Data collector filter type

1st Order 0.8 Orders 1.2 Orders None

2nd Order 1.8 Orders 2.2 Orders None

3rd Order 2.8 Orders 3.2 Orders None

4th Order 3.8 Orders 4.2 Orders None
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• A full scale value of 10,000 can be a problematic if you want to enter a very 
large or very small value for the numeric measurement. For example, you 
can not enter a value greater than the full scale value. If you enter a value 
that is very small compared to the full scale, the Dynamix 2500 data 
collector may round the value off. If you enter 0.01 with a full scale value of 
10,000, the Dynamix 2500 data collector stores it as a 0 (zero).

Temperature Measurements

You set up a temperature measurement definition by setting Data Type to 
Numeric and Units to rpm, CPM, or deg. C.

Follow these steps to set up temperature measurements.

1. Set up the temperature transducer in the Transducer Calibration dialog 
box with Input type set to DC Coupled and Units set to deg. F or deg. C.

Make sure you enter the Calibration value that converts the voltage to a 
temperature.

2. Set up the collection specification to include a Signal detection of RMS.

Machine Speed (rpm) Measurements

You set up a tachometer measurement definition by setting Data Type to 
Numeric and Units to rpm, CPM, or Hz.

Follow these steps to set up machine speed measurements.

1. Go to the Transducer Calibration screen.

2. Set the Input type to ICP Accel for either the internal laser tachometer or 
an external TTL device, for example, entach laser sensor, an optical trigger, 
or a strobe light with TTL output. 

3. Set the Input type to AC Coupled or DC Coupled if your speed sensor has 
an AC or DC voltage signal proportional to speed. 

4. Set Units to rpm, CPM, or Hz. 

Make sure you enter the Calibration value that converts the voltage to 
speed.

5. Set up a Collection Specification with Transducer set to the tachometer 
transducer you set up above, Window set to Rectangular, and Signal 
detection set to None.

Do not fill in any fields in the Resolution area or the Averaging area of the 
dialog box.
Rockwell Automation Publication 1441-UM001B-EN-P - September 2012 93



Chapter 3 Setting Up Measurements
6. Connect the speed sensor to the trigger connector on the Dynamix 2500 
data collector when collecting data.

Magnitude Alarms in the Dynamic 2500 Data Collector

You can use magnitude alarms with numeric measurements:

• The Dynamix 2500 data collector supports above, below, in window, and 
out of window magnitude alarms with numeric measurements.

• You must set Trigger to Yes for any alarms you want to appear in the 
Dynamix 2500 data collector during data collection.

For more on how the Emonitor software combines alarms before sending 
them to the Dynamix 2500 data collector, see Alarms and the Data 
Collector on page 104.

Typical Numeric Measurement Definitions

This figure shows the setup for typical numeric measurement definitions. The 
first two measurements are numeric (DC) voltage measurements, and the third is 
a numeric manual entry measurement.

Figure 18 - Numeric measurement definitions

The collection specifications appear in the table below. N/A means not applied.

This table shows the transducer specifications in the collection specifications.

Table 30 - Collection specifications for numeric measurement definitions

Transducer Window Signal Detection Fmax Lines Phase Order Norm? Averages

Temperature N/A RMS N/A N/A No No N/A

Tachometer N/A None N/A N/A No No N/A

Manual Entry N/A None N/A N/A No No N/A

Table 31 - Transducer specifications in numeric collection specifications

Name Base Unit Input Type Units Calibration Value(1) DC Offset

Temperature Temperature DC Coupled deg. F See note below. 0

Tachometer Frequency DC Coupled rpm See note below. 0

Manual Entry None Manual Entry None See note below. 0

(1) Make sure you enter the Calibration value that converts the voltage to a known unit such as speed.
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Spectrum Measurement Definitions

The Emonitor software and the Dynamix 2500 data collector support spectrum 
measurement definitions. There are unique characteristics of the Dynamix 2500 
data collector that you may need to know when setting up and collecting 
spectrum data:

• The Dynamix cannot collect phase with a spectrum measurement 
definition. 

• You can choose to have the Dynamix 2500 data collector collect a 
spectrum only if a magnitude measurement at the same location is in 
alarm. 

Set the Collect and store condition in the Edit Storage Specification dialog 
box to On Magnitude Alarm for the storage specification for the spectrum 
measurement definition.

Time Synchronous Averaging in the Dynamic 2500 Data Collector

Time synchronous averaging cancels out the effects of signals not related to the 
synchronizing trigger. Time synchronous mechanical effects include imbalance, 
misalignment, eccentricity of bent shafts, blade passing, and gear meshing:

• Time synchronous averaging requires the internal laser tachometer or 
external trigger.

• Set up a Collection Specification with the averaging Type set to Time 
Synchronous and enter the Number of averages. 

• Use a large number of averages (such as 20 or 30) to get the desired 
reduction in non-synchronous effects. 

For more on supported averaging in the Dynamix 2500 data collector data 
collector, see Number and Type of Averages on page 80.

Order Normalized Spectra in the Dynamic 2500 Data Collector 

Order normalized spectrum measurements have a frequency axis based on 
multiples of the running speed (orders). This quickly identifies the frequency 
relationship between each measured vibration amplitude and the running speed 
of the machine. It is particularly useful on variable speed machinery.

An order normalized spectrum measurement requires a trigger input to the 
Dynamix 2500 data collector.

IMPORTANT Do not check the Also collect phase data checkbox in the 
Collection Specification dialog box.
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To up a Collection Specification with Window set to Hanning, select the 
Maximum frequency in Orders, and make sure to select the Order normalization 
option. 

The Dynamix 2500 data collector may collect more orders than required. For 
example, if you set the Maximum frequency to 10 Orders, the Dynamix 2500 
data collector may collect more than ten orders. The Dynamix 2500 data 
collector always collects at least the number of orders you request in the 
Collection Specification.

The Dynamix 2500 data collector displays an order normalized spectrum:

• If the Collection Specification dialog box has Also collect phase data 
checked, and if the Maximum frequency is eight orders or less, the table on 
the instrument’s screen shows the magnitude and phase values at each 
order. 

• If the Collection Specification dialog box does not have the Also collect 
phase data checkbox checked, or if the Maximum frequency is more than 
eight orders, the table on the data collector shows magnitude values only. 
The instrument displays a maximum of eight orders in the table.

• If the table has eight orders or less, the arrow keys move the spectrum 
cursor. 

• If the table has more than eight orders, the arrow keys scroll the table 
values.

Proximity Probe Measurements

Proximity probes measure the position and motion of a shaft within a bearing. 
You can use a spectrum measurement definition to measure the dynamic or AC 
component of a proximity probe measurement. This indicates the motion of the 
shaft within the bearing at each frequency.

Follow these steps to set up a proximity probe.

1. Set up a displacement transducer in the Transducer Calibration dialog box 
with Input type set to AC Coupled and Units set to mils or um.

Make sure you enter the Calibration value that converts the voltage to a 
displacement.

2. Set up the Collection Specification to include the displacement 
Transducer, and set the Signal detection to Peak-Peak.

TIP The Averaging can be either linear or time synchronous, but should 
include at least four averages.
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You also need to select the window, frequency range, and averaging 
options. 

3. Finish setting up the dynamic proximity probe measurement by setting 
Data Type to Magnitude and Units to mils or um.

You can use a Filter if desired, but make sure it does not interfere with the 
frequency of interest.

Spectrum Alarms in the Dynamic 2500 Data Collector 

The Dynamix 2500 data collector supports band alarms with up to ten bands. 
You can have the data collector collect a spectrum measurement if a magnitude 
alarm is in alarm. 

1. Set the Collect and store condition in the Edit Storage Specification dialog 
box to On Magnitude Alarm for the storage specification for the spectrum 
measurement definition.

2. You must set Trigger to Yes for any alarms you want to appear in the 
Dynamix 2500 data collector during data collection. 

If you set Trigger to Yes for two or more alarms for the same measurement 
definition, the Emonitor software combines the alarms before sending the 
combined alarm to the Dynamix 2500 data collector.

For more on how the Emonitor software combines alarms before sending them to 
the Dynamix 2500 data collector, see Alarms and the Data Collector on 
page 104.

Typical Spectrum Measurement Definitions

This figure shows the setup for typical spectrum measurement definitions. The 
first is a standard spectrum, the second is an order normalized spectrum, and the 
third is a time synchronous spectrum.

Figure 19 - Spectrum measurement definitions

IMPORTANT The Dynamix does not support spectrum alarms. You can still set up the 
alarms for the spectrum measurement definitions. the Emonitor software 
tests the data against the alarms after you unload the data. 
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The following table shows the collection specifications (in the same order as the 
measurement definition table above).

The following table shows the transducer specification in the collection 
specifications.

Time Waveform Measurement Definitions 

The Emonitor software and the Dynamic 2500 data collector support time 
waveform measurement definitions. This topic lists the unique characteristics of 
the Dynamix that you may need to know when setting up and collecting time 
waveform data.

The Dynamix 2500 data collector cannot collect phase with time waveform 
measurement definitions. You can choose to have the instrument collect a time 
waveform only if a magnitude measurement at the same location is in alarm. 

The Dynamic 2500 data collector supports integrated time waveform 
measurements (single integration). This means you can collect a time waveform 
with velocity units using an accelerometer or displacement units using a velocity 
transducer.

The length of the time waveform depends on the maximum frequency you select 
in the collection specification. You can calculate the number of time samples from 
the number of spectral lines (Collection Specification dialog box) using this 
formula.

You can calculate the total time required to collect a time waveform measurement 
from the Number of lines value and the Maximum frequency value in the 
Collection Specification dialog box (Setup > Collection Specification).

Table 32 - Collection specifications for spectrum measurement definitions

Transducer Window Signal Detection Fmax Lines Phase Order Norm? Averages

Accelerometer Hanning Peak 2 kHz 400 No No 4 linear

Accelerometer Hanning Peak 10 orders 400 No Yes 4 linear

Accelerometer Hanning Peak 2 kHz 400 No No 4 time synch.

Table 33 - Transducer specification in spectrum collection specifications

Name Base Unit Input Type Units Calibration Value DC Offset

Accelerometer Acceleration ICP Accel g’s 100 0

TIP Set the Collect and store condition in the Edit Storage Specification 
dialog box to On Magnitude Alarm for the storage specification for the 
time waveform measurement definition.

time samples spectral lines 2.56=
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If your Maximum frequency is specified in CPM, convert CPM to Hertz using 
this formula.

Next, find the total collection time for the time waveform measurement using 
this formula.

If you had a Maximum frequency value of 7200 CPM and a Number of lines 
value of 400, you would:

1. Convert CPM to Hz.

2. Find the total collection time.

Time Synchronous Averaging in the Dynamic 2500 Data Collector

Time synchronous averaging cancels out the effects of signals not related to the 
synchronizing trigger. Time synchronous mechanical effects include imbalance, 
misalignment, eccentricity of bent shafts, blade passing, and gear meshing.

Time synchronous averaging requires the internal laser tachometer or an external 
trigger input to the data collector.

Set up a collection specification with the averaging Type set to Time 
Synchronous and enter the Number of averages. Use a large number of averages 
(such as 20 or 30) to get the desired reduction in non-synchronous effects. 

For more on supported averaging in the data collector, see Number and Type of 
Averages on page 80.

Fmax (Hz)
Fmax (CPM)

60
-------------------------------=

collection time
spectral lines
Fmax (Hz)

-------------------------------=

7200 CPM
60

-------------------------- 120 Hz=

400 lines
120 Hz

--------------------- 3.3 seconds=
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Typical Time Waveform Measurement Definitions

This figure shows the setup for a typical time waveform measurement definition.

Figure 20 - Time waveform measurement definitions

The following table shows the collection specification.

The following table shows the transducer specification in the collection 
specification.

Voltage Measurement Definitions 

The Emonitor software and the Dynamic 2500 data collector support 
measurement definitions with units of volts (AC or DC). You can collect several 
different types of voltage measurements. This topic shows the typical 
measurement definition setup for three voltage measurements.

Voltage is similar to other units in that you can collect magnitude, numeric, 
spectrum, and time waveform voltage measurements.

Typical Voltage Measurement Definitions

This figure shows the setup for three typical voltage measurement definitions.

Figure 21 - Voltage measurement definitions

Table 34 - Collection specification for time waveform measurement definition

Transducer Window Signal Detection Fmax Lines Phase Order Norm? Averages

Accelerometer Hanning Peak 2 kHz 400 No No 1 linear

Table 35 - Transducer specification in time waveform collection specification

Name Base Unit Input Type Units Calibration Value DC Offset

Accelerometer Acceleration ICP Accel g’s 100 0
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The following table shows the collection specifications. 

The following table shows the transducer specifications in the collection 
specifications.

Combine Measurement Definitions for a Location

You can use the Emonitor software to set up many different measurement 
definitions for data collection at a location. These can include magnitude, 
spectrum, time waveform, and numeric measurements. You can then select the 
measurement definitions you want to load to the data collector by creating a list 
of those measurement definitions. When you want to load the data collector, the 
Emonitor software builds a load file containing the measurement definitions in 
the list.

The Emonitor software combines measurement definitions at each location to 
make data collection more efficient. This lets you to collect two or more 
measurements automatically, without having to start each measurement 
separately. The rules for combining measurement definitions depend on several 
factors. In general, however, the Emonitor software can combine measurement 
definitions at the same location when these values are the same:

• Measurement units (part of the measurement definition)
• Measurement filter (part of the measurement definition)
• Transducer calibration and input type (from the transducer specification 

used in the measurement definition’s collection specification)

In addition, there are some specialized cases that allow or prevent the Emonitor 
software from combining measurement definitions from the same location when 
they meet the above conditions.

Table 36 - Collection specifications for voltage measurement definition

Transducer Window Signal Detection Fmax Lines Phase Order Norm? Averages

Voltage Hanning RMS 2 kHz 400 No No 4 linear

Voltage DC Rectangular None 2 kHz 400 No No 4 linear

TIP The `Voltage’ transducer is for Volts AC. The `Voltage DC’ transducer 
is for Volts DC.

Table 37 - Transducer specifications in voltage collection specification

Name Base Unit Input Type Units Calibration Value DC Offset

Voltage Voltage AC Coupled V 1000 0

Voltage DC Voltage DC Coupled Vdc 1000 0
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The Emonitor software does the following:

• Cannot (in general) combine a magnitude and a spectrum measurement if 
they have different measurement filters.

• Can combine an envelope acceleration magnitude measurement with a 
spectrum with the same units.

• Can combine a non-filtered measurement definition with a high pass, low 
pass, or band filtered measurement when the band filter is applied by the 
Emonitor software after the spectrum is unloaded.

• Can combine two signatures if they are the same type (time, fixed 
frequency spectrum, order normalized spectrum) and the same resolution.

Set Up Tri-axial Measurements

You can set up and collect tri-axial measurements with the Dynamix 2500 data 
collector if you have a tri-axial transducer and a special tri-axial cable for your data 
collector. This lets you to collect measurements in three directions without 
moving the transducer.

Tri-axial measurements require setting up separate locations, and measurement 
definitions for each of the three transducers. This section shows the method for 
setting up these measurements.

To Set Up Tri-axial Locations and Measurement Definitions

You must set up a different location for each axis of a tri-axial transducer. The tri-
axial data is multiplexed one direction at a time. 

Follow these instructions to set up tri-axial and measurement definitions.

1. Open the Database window by choosing Window > Database. 

2. Select the Measurement view and click OK.

3. Select the machine in the Hierarchy Tree for which you want to set up
tri-axial measurements.

4. In the Location pane, choose View > Pane Options to add the Lo. Channel 
column to the Location pane. 

5. Create a Location for the first tri-axial measurement and
set Lo. Channel to 1X.

6. In the Measurement Definition pane, create the measurement definition 
for that location. 

7. Select the location you just created. 
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8. Choose Edit > Copy to copy the location. 

9. Move to an empty row in the Location pane and choose Edit > Paste to 
paste the location into the spreadsheet.

10. Edit the new location to change the Direction and set Lo. Channel to 1Y.

11. Repeat steps 7 and 8 to copy and paste the third location into the Location 
pane. 

12. Edit the new location to change the Direction and set Lo. Channel to 1Z.

13. Now include these measurement definitions in a list. 

You can create a new list or recall the current list. The locations must be 
tagged to create a group list. 

14. Add the three locations to a group list by double-clicking the Group 
column in the Location pane. 

The current group number appears in the Group column. Make sure you 
assign the locations to the same group number. The group is then loaded 
with the list to the Dynamix 2500 data collector. 

This figure shows the typical measurement location setup for tri-axial 
measurements.

Figure 22 - Tri-axial measurement location setup

TIP The Location ID and Position must be the same for all three tri-
axial measurements.
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Setting Up Alarms, Lists, 
and Inspection Codes

This section describes the way the Emonitor software loads alarms, lists, and 
inspection codes into the Dynamix 2500 data collector. 

For more information on alarms, lists, and inspection codes, see the 
Emonitor software online help.

Alarms and the Data Collector

The Emonitor software and the Dynamix 2500 data collector support loading 
alarms with the list of measurement definitions to the data collector.

You select the alarms you want to load with a measurement definition in the 
Emonitor software by setting the Trigger column to Yes for the alarm. If you set 
Trigger to Yes for two or more alarms for the same measurement definition, the 
Emonitor software combines them to make a single alarm. If you select an alarm 
that the data collector can handle, the Emonitor software loads that alarm into 
the data collector when you load the list.

Selecting Alarms to Load to the Dynamic 2500 Data Collector

If you want to load an alarm to the data collector with a measurement definition, 
you must set Trigger to Yes in the Alarm spreadsheet in the Emonitor software.

Alarms with the Dynamix 2500 Data Collector

The data collector supports some alarms and there are substitutes for some of the 
unsupported alarms.

The data collector supports above, below, in window, and out of window 
magnitude alarms for magnitude and numeric measurements. You cannot select a 
magnitude out of window alarm in the Emonitor software. 

You must create one by combining an above and a below alarm for the same 
measurement definition. the Emonitor software creates an out of window alarm 
when it builds the load file if both alarms are active.

The data collector does not support spectrum (narrowband) alarms for spectrum 
measurements. You can still set up spectrum alarms with spectrum measurement 
definitions. The Emonitor software tests the measurements against the alarms 
after you unload the data.

For unsupported alarms, the Emonitor software tests the measurements against 
the alarms when you unload the data collector. This means that the Emonitor 
software always accurately indicates when a measurement is in alarm, regardless of 
the number or complexity of the alarm(s). This is true for all active alarms, 
regardless of their trigger status.
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Lists and the Data Collector

The Emonitor software and the Dynamix 2500 data collector support loading 
lists of measurement definitions to the data collector.

Inspection Codes and the Data Collector

The Emonitor software and the Dynamix 2500 data collector support loading 
inspection codes to the data collector. You can load inspection codes into the data 
collector only with a list.

You can use only the inspection codes loaded with the list with measurements in 
that list. This includes both measurements in a list and unscheduled 
measurements associated with that list.

You can load up to 100 inspection codes into the data collector. The Emonitor 
software numbers the inspection codes from 1-100. The data collector numbers 
the inspection codes from 00-99. The data collector displays the first 16 
characters of each inspection code.

Loading Inspection Codes to the Dynamix 2500 Data Collector

You can load and remove inspection codes. You must load the inspection codes 
when you load a list, do this by selecting Load inspection codes in the Load 
Options dialog box. If you do not select this option, no inspection codes are 
available for measurements from the list or for unscheduled measurements 
associated with the list.

You can remove the inspection codes from the Dynamix 2500 data collector by 
initializing the data collector.
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Notes:
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Loading and Unloading

The Dynamix 2500 data collector communicates with the Emonitor software to 
load and unload routes/lists.  

Set Up Communication There are many steps required to set up communication both in the Emonitor 
software and in your data collector. The steps include the following:

• Selecting the computer communication options in the Emonitor software.
• Selecting the Dynamix 2500 data collector as the current data collector.
• Setting up the data collector to communicate with the computer.
• Installing ActiveSync software to communicate through a USB port. 
• Connecting the data collector and the computer.

Most of the steps are completed from the Load/Unload dialog box. Click Set Up 
Collector and Set Up Computer to set up the Dynamix 2500 data collector and 
computer for communication.

Use the USB Connection

You use the USB port to load lists from The Emonitor software and unload data 
from the Dynamix 2500 data collector. This interface requires you to install 
Microsoft ActiveSync software:

• See POWER /USB/TRIGGER on page 20 for information on the splitter 
cable.

• See Installing the USB Drivers for the Data Collector on page 30.

Topic Page

Set Up Communication 107

Loading Lists to the Data Collector 113

Unloading Lists from the Data Collector 121

IMPORTANT For more information about loading lists and the Load/Unload dialog 
box, refer to the Emonitor software online help.
Rockwell Automation Publication 1441-UM001B-EN-P - September 2012 107



Chapter 4  Loading and Unloading
Install ActiveSync Software

You can download ActiveSync software from
http://www.microsoft.com/downloads. 

Follow the instructions on the website to download and install ActiveSync 
software.

Create the Connection from the Data Collector to a Computer

Connect the Dynamix 2500 data collector to your computer by using the USB 
Power Splitter cable.

Follow these steps to connect the data collector to a computer.

1. Plug one end of the USB Power splitter cable into the POWER/USB/
TRIGGER connector at the top of the Dynamix 2500 data collector. 

2. Plug the USB end of the power splitter cable into the USB port on your 
computer.

3. If the ActiveSync software or the Get Connected window is not open 
already on the computer, follow these steps.
a. Select Start > Programs > MicrosoftActiveSync software on the 

computer. 
The AcitveSync window opens.

b. In the ActiveSync software window, select Get Connected from the File 
menu.
The Get Connected window opens.

4. In the Get Connected window, click Next.

5. In the New Partnership window on the computer, click No in response to 
the question ‘Would you like to set up a partnership?

6. Click Next.

TIP We recommend that ActiveSync software version 4.5 or later is 
installed.

TIP Partnership should only be selected when you want the data collector to 
always be insync with the Emonitor software. It is recommend not to set 
up a partnership.
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The New Partnership window closes and the ActiveSync software window 
shows you are connected as Guest.

When you set up for communication in the Emonitor software, select Dynamix 
2500 data collector 2500 USB as your current data collector and USB as your 
communication device. 

Figure 23 - Load/Unload dialog box 

Device identity

Status

TIP If the connection fails, try it again, making sure you follow 
steps 3 and 4 in sequence. You may need to unplug the USB 
cable from your computer and reconnect it to the USB port. 

If the connection still fails, use the ActiveSync software 
Troubleshooter (Help > Microsoft ActiveSync Help) to identify 
and correct anomalies.

Click to set 
computer 
communication 
options.

Click to set data 
collector 
communication 
options.
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When the data collector is properly connected to the USB port, the cable 
connection icon in the Load/Unload dialog box changes from not 
connected to connected and the Dynamix 2500 data collector displays the 
message Busy... Communications in progress.

Set Up the Current Data Collector in the Emonitor software

You can have several active data collectors in the Emonitor software. However, 
you must select one specific data collector before you load a list. The data 
collector you select is called the current data collector. If you use several different 
models of data collectors, you may need to select the current data collector before 
unloading and loading. If you use only one model of data collector, you can select 
the current data collector only once and not change it again.

An icon of the Dynamix 2500 data collector appears in the Set Up Collector if it 
is the current data collector. 

Follow these steps to make the Dynamix 2500 data collector the current data 
collector and select the correct communication settings.

1. Select Tools > Load/Unload. 

The Load/Unload dialog box appears.

2. In the Load/Unload dialog box, click Set Up Collector.

The Set Up Data Collectors dialog box appears.

3. The Current column shows a Yes for the current data collector.

To make the Dynamix 2500 Data Collector the current data collector:

a. Move to the Current column for the Dynamix 2500 data collector.
b. Press Enter or double-click in the column to change the word from No 

to Yes. 

TIP If the cable connection icon does not change, try closing and 
reopening the Load/Unload dialog box.
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The previously selected data collector automatically changes to ‘No.’

4. In the Baud column, choose the enPAC 2500 USB (use this collector for 
the Dynamix 2500 data collector) and set the baud rate to the same rate 
you selected in the Dynamix 2500 data collector. 

The baud rate must be set in the data collector to 115200.

5. In the Protocol column, choose M81 as the Protocol.

6. Click Advanced.

The Advance Settings dialog box appears.

The Advance Settings dialog box lets you change some of the data 
collection characteristics of the Dynamix 2500 data collector.

See Data Collector Advanced Settings Parameters on page 112 for a 
description of the parameters.

TIP You must log in with a Supervisor- or Administrator-level user 
name and password to make any changes to these data collector 
settings. 

IMPORTANT Changing the configuration options for the data collector may 
prevent the Emonitor software from communicating with the data 
collector, or may cause the data collector to malfunction. 

Make sure you understand a configuration option before you 
change it.
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7. Click OK to close the Data Collector Advanced Settings dialog box.

8. Click OK when finished. 

Use the descriptions in this table to help you configure the parameters in the 
Advanced Settings dialog box.

Table 38 - Data Collector Advanced Settings Parameters

Parameter Description Values

Operating System Sets the operating system version of the data collector.

2CHEnable Enables the Emonitor software to download measurements 
configured for 2-channel collection.

Yes

No

Current Baud The baud rate for the serial communication.

or the USB this is the default.

Recommend setting this to 
115200.

Current Parity The combination of parity, data bits and stop bits. The first 
letter in the setting is the parity: None, Even, Odd. The first 
number is the number of data bits. The second number is the 
number of stop bits. N81 stands for no parity, 8 data bits, and 1 
stop bit. 

The Dynamix 2500 data 
collector uses only N81.

Datapac Enumulation Configures the Dynamix 2500 Data Collector to collect data the 
same as the Datapac.

Yes

No

Direction The default direction to be used for Offroute measurements. 0 - None

1 - Horizontal

2 - Vertical

3 - Axial

Log Display Display plots in log format in the data collector.  Yes

No

Machine Speed The default machine speed to use for Offroute measurements.

Phone Number Not Used

Position The default position label to use for Offroute measurements. 1 to 16 characters

Sync Trigger Level The amplitude level for externally triggering the measurement.

This parameter is used when you set Trig Level to `Fixed’ in the 
Instrument Setup screen.

See Configure the Data Collection Options on page 57.

Positive

Negative

Sync Trigger Slope The input signal slope to be used for externally triggering the 
measurement. 

This parameter is used when you set Trig Level to `Fixed’ in the 
Instrument Setup screen.

See Configure the Data Collection Options on page 57.

Positive

Negative
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Loading Lists to the Data 
Collector

After you connect the data collector to the computer, you can load one or more 
lists to the data collector. This section discusses preparing and initializing the data 
collector, loading inspection codes, selecting the list, and other load options.

Prepare the Data Collector before Loading

The Emonitor software can load data to either the data collector internal 
memory, or to an SD storage card. You control the destination for the data with 
the Route Mem parameter in the Setup screen in the data collector.

Follow these steps to prepare the data collector.

1. Make sure you have correctly connected the data collector to the computer.

2. Install a storage card, if needed.

3. Apply power to the data collector.

4. From the Main Menu screen, select Setup Utility and press Enter.

Sync Trigger Type Sets the trigger type. TTL

External

Trigger Range The maximum range (in Volts) that the trigger signal can 
produce.

V

Table 38 - Data Collector Advanced Settings Parameters

Parameter Description Values

TIP The communication message remains on the screen until you 
close the Load/Unload dialog box in the Emonitor software.

IMPORTANT When loading large lists to the Dynamix 2500 data collector, 
recommended practice is to connect the power supply to the data 
collector. This disables the automatic timeout feature (Instrument 
Setup), which could cause potential loss of data during the loading 
process.
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The Setup screen appears.

5. Select Route Mem and press the Right arrow to display the following 
choices:
• Internal - Load the data to the Dynamix 2500 data collector internal 

memory.
• Storage Card - Load the data to the SD storage card in the Dynamix 

2500 data collector.

6. Select the destination and press the Left arrow key to save your choice.

7. When finished, press F4 (Apply).

Initialize the Data Collector before Loading

If data already exists in the data collector but you do not need it anymore, you can 
delete the data by initializing the data collector’s memory using the Emonitor 
software. Make sure that you no longer need the data before deleting it. 

Before you initialize the Dynamix memory, make sure the Emonitor software and 
the data collector are properly connected. 

There are two ways you can initialize the Dynamix using the Emonitor software, 
either automatically before loading a list, or manually at any time. You can also use 
the data collector to initialize memory.

TIP You initialize the Dynamix 2500 data collector internal memory and 
memory card separately. This is determined by the Route Memory 
setting in the Setup screen.
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See Engineer Mode Menu on page 44 for details on how to initialize memory 
using the Dynamix 2500 data collector.

Follow these instructions to automatically initialize the data collector before 
loading a list.

1. Choose Tools > Load/Unload.

2. In the Load/Unload dialog box, click Load Options.

The Load Options dialog box appears. 

3. Check the Initialize data collector before loading checkbox.

4. Click OK.

You must have the Dynamix 2500 data collector connected to the computer. You 
can also use the unit to initialize memory. 

Follow these steps to manually initialize the data collector any time.

1. Choose Tools > Load/Unload.

2. Click DC. Functions in the Load/Unload dialog box. 

IMPORTANT Initializing the data collector memory erases the existing data. Be 
sure that you no longer need the data before deleting it.

Check to
automatically

initialize.

TIP If you are manually initializing the memory card, you must also 
have the SD card in the drive. 

See Insert and Remove a Storage Card on page 64.
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The Data Collector Functions dialog box appears. 

3. Click Initialize data collector.

A progress bar appears providing a status of the initialization.

4. Click Close, when initialization is complete.

Now frequency labels will be loaded with your lists. 

Loading Inspection Codes

The Emonitor software and the Dynamix support loading inspection codes with 
a list. The Dynamix stores inspection codes with a loaded list. You can only load 
inspection codes with a list.

Follow these steps to load inspection codes.

1. Select Tools > Load/Unload. 

2. Click Load Options.

The Load Options dialog box appears.

3. Check the Load Inspection Codes checkbox.

4. Click OK. 
Now inspection codes will be loaded with your lists.

Check to load 
inspection codes.
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Load Frequency Labels

With the Dynamix 2500 data collector and the Emonitor software, you can load 
frequency labels so that you can use the Diagnostic Frequency cursor. The 
frequency labels are the items in the Label column in the Frequency Output pane 
in the Emonitor software.

Follow these steps to load frequency labels.

1. Select Tools > Load/Unload. 

2. Click Load Options.

The Load Options dialog box appears.

3. Check the Load Frequency Labels checkbox.

4. Click OK. 

Override the Collect On Alarm Setting

With the Emonitor software you can collect and store a spectrum or time 
waveform when a magnitude measurement at the same location is in alarm. You 
do this by setting the Collect and store condition in the storage specification for a 
spectrum measurement definition to On Magnitude Alarm.

At some point you may want to collect a spectrum or time waveform even when 
the magnitude measurement is not in alarm. For example, you may want to 
collect a spectrum the first time you collect data for the machine. Instead of 
changing the storage specification, you can Override collect on alarm in the Load 
Options dialog box. 

Follow these steps to override the Collect On Alarm setting.

1. Select Tools > Load/Unload. 

Check to load 
frequency labels.
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2. Click Load Options. 

The Load/Unload dialog box appears. 

3. Check the desired option under Override collect on alarm:
• Collect spectrum measurements always - Collects all spectrum 

measurements, regardless of the settings in the storage specification for 
the measurement definition.

• Collect time measurements always - Collects all time waveform 
measurements regardless of the settings in the storage specification for 
the measurement definition.

4. Click OK. Now you can collect all the spectrum and/or time waveform 
measurements in the list.

Select the Lists

The Emonitor software and the Dynamix support loading more than one list at a 
time, so you may select more than one list to load. The size of the lists limits the 
number of lists you can load at one time.

Follow these steps to select the list.

1. Choose Tools > Load/Unload.

2. Make sure the data collector and computer are connected. 

3. Make sure you have selected the desired destination (internal memory or 
SD card) in the Dynamix 2500 data collector.

See Prepare the Data Collector before Loading on page 113.

4. Select the list types to show in the list display by clicking Filter in the 
Load/Unload dialog box. 

IMPORTANT You must turn these load options off before loading a list if you 
want to collect spectrum and/or time waveform only on alarm. 
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Lists appear in the order of the next collection date. A red checkmark may 
appear next to the list, indicating that the list has been loaded to a data 
collector.

5. Select one or more lists from the list display by clicking on the list name. 

Load Selected Lists to the Data Collector

After connecting the Dynamix and computer, selecting the correct 
communication settings, and selecting one or more lists, you are ready to load the 
data collector.

The Dynamix 2500 Data Collector lets you to unload more that one list at a time 
into the Emonitor software database. Simply select the desired lists before 
clicking Unload. 

For more information, see Select the Lists on page 118.. 

Follow these steps to load selected lists to the data collector.

1. Choose Tools > Load/Unload. 

The Load/Unload dialog box appears.

2. Select the desired list or lists. 

See Select the Lists on page 118 for more information.

3. Click Load in the Load/Unload dialog box. 

The following series of events occurs:

– The Emonitor software builds the load file and shows a progress bar. If 
you wish to stop the process, click Abort.

IMPORTANT When loading large lists to the Dynamix 2500 data collector, 
recommended practice is to connect the power supply to the 
unit. This disables the automatic timeout feature (Instrument 
Setup), which could cause potential loss of data during the 
loading process. 

TIP It may take some time for the Emonitor software to build load 
files for large lists. You can save time by using Quickload lists 
and choosing Tools > Update Quickload Files to build the load 
files when you are not using the computer. For more 
information on Quickload lists, see the Emonitor software 
online help.
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– The Emonitor software loads the file into the data collector and a 
second progress bar appears.

4. When finished, click Close.

Display the Data Collector Driver Version Number

The data collector driver is the software that allows the Emonitor software to 
communicate with the Dynamix. You can display the data collector driver version 
number in the Emonitor software.

Follow these steps to display the version number.

1. Select Tools > Load/Unload. 

The Load/Unload dialog box appears.

2. Make sure the correct data collector appears in the Set Up Collector.

3. Click D.C. Function.

The Data Collector Function dialog box appears.

TIP For details on displaying the data collector operating system version 
number in the Dynamix 2500 Data Collector, see Display the 
Operating System Version Number on page 46.
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4. Click About data collector driver.

This displays the driver version number.

5. Click OK to close the Data Collector Functions dialog box.

Unloading Lists from the 
Data Collector

Once you collect data you can unload it for storage in your the Emonitor 
software database by connecting the Dynamix and computer and transferring the 
information. You can unload unscheduled measurements to your the Emonitor 
software database at the same time as list data. You can automatically print 
reports after unloading data from the data collector.

Unload More than One List

The Dynamix 2500 Data Collector lets you to unload more that one list at a time 
into the Emonitor software database. Simply select the desired lists before 
clicking Unload.

For more information, see Select the Lists on page 118.

Clear Data from a List

The Dynamix 2500 Data Collector lets you to clear data from a list in the 
instrument after unloading it to your the Emonitor software database. You can 
collect the list again as needed:

• Check the Clear list on unload checkbox in the Unload Options dialog 
box. 

• Clear data from list function in the Data Collector Functions dialog box. 

TIP The SD storage card must be initialized/formatted before you can use it 
in the data collector. The data collector does not initialize/format the 
cards.

IMPORTANT When loading large lists to the Dynamix 2500 Data Collector, 
recommended practice is to connect the power supply to the Dynamix 
2500 Data Collector. This disables the automatic timeout feature 
(Instrument Setup), which could cause potential loss of data during 
the loading process. 

IMPORTANT For more information on unloading lists and unload options see the 
Emonitor software online help.
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Unload Lists in the Emonitor Software

Follow these steps to unload a list.

1. From the Tools menu, choose Load/Unload.

The Load/Unload dialog box appears.

2. Make sure the data collector and the computer are connected. 

3. Choose the desired list or lists.

4. In the Load/Unload dialog box, click Unload.

The following series of events occur:

– The Emonitor software unloads the file from the data collector and 
shows a progress bar, telling you that it is unloading the file and 
updating the database.

– When the unload is complete, the progress bar closes in the Emonitor 
software.

5. Click Close.

Unload Multiple Measurements Points in the Emonitor Software

With the Dynamix 2500 data collector, you can collect multiple readings for a 
single measurement definition. All of the data for each measurement definition 
can be unloaded to the Emonitor software database. 

Follow these steps to unload multiple measurement points.

1. In the Load/Unload dialog box, click Unload Options.
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The Unload Options dialog box appears.

2. Select Unload all readings.
3. Click OK. 

Unload Unscheduled (Offroute) Data from the Dynamix 2500 Data 
Collector

Unscheduled measurements are measurements that are taken with the Offroute 
function in the Dynamix. They are called Offroute measurements in the data 
collector. See the Emonitor software online help for more information on setting 
the Unscheduled Measurement Destination.

Follow these steps to unload the unscheduled measurements automatically when 
unloading a list.

1. In the Load/Unload dialog box, click Unload Options.
Rockwell Automation Publication 1441-UM001B-EN-P - September 2012 123



Chapter 4  Loading and Unloading
The Unload Options dialog box appears.

2. Check the Also unload unscheduled measurements checkbox.

3. Click OK.
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Unload Measurements using Smart Unscheduled Mode

You can collect Offroute measurements in the Dynamix 2500 Data Collector 
that match your existing measurement definitions in the Emonitor software. This 
is done by choosing one of the pre-defined measurement icons on the Offroute 
Measurement screen in the Dynamix. When you unload the data, the Emonitor 
software stores the data under the correct measurement definition.

See Collect Offroute Data using a Pre-defined Measurement on page 150.

If the Emonitor software can match the unscheduled data to an item in the 
Hierarchy Tree and a location, then it stores the unscheduled data in 
measurement definitions under that location. If the Emonitor software cannot 
match the data with an existing measurement definition, then it creates a new 
measurement definition and stores the data there.

If the Emonitor software cannot match an item in the Hierarchy Tree and a 
location, it stores the data in the unscheduled destination, set with Tools > Set 
Unscheduled Dest.

The Emonitor software tries to match the collection specification for the 
measurement definition. The rules for matching a collection specification are as 
follows.

TIP To have the Emonitor software put all unscheduled measurements in 
one location, open the Load/Unload dialog box and click Unload 
Options. Uncheck the Unscheduled location smart mode checkbox.

Table 39 - Rules for Matching a Collection Specification

All types Magnitude Spectrum Time Waveform

All these measurement 
parameters in the 
collection specification 
must match:

Transducer

Averaging type

Number of Averages

Percent Overlap

Order Normalization

Transducer

Averaging type

Number of Averages

Percent Overlap

Order Normalization

Fmax (or Frequency 
Span)

Number of lines

Transducer

Averaging type

Number of Averages

Percent Overlap

Order Normalization

Fmax (or Frequency 
Span)

Number of lines

Signal detection

Transducer

Averaging type

Number of Averages

Percent Overlap

Order Normalization

Signal detection
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If the Emonitor software cannot match the collection specification, it creates a 
new collection specification using a code. The new collection specification name 
has the form XXXXLMSWNNEp, where:

The parameters of the fields in the collection specification name are explained in 
the Emonitor software online help.

Automatically Print Reports after Unloading

You can select reports to automatically send to a printer after unloading data from 
the Dynamix. The reports contain information on the list of measurements 
unloaded. 

See the Emonitor software online help for more information on printing reports 
and plots. 

Follow these steps to automatically print reports after unloading.

1. From the Tools menu, choose Load/Unload.

The Load/Unload dialog box appears.

2. Make sure the Dynamix 2500 data collector appears in the Set up collector 
button. If not, see Use the USB Connection on page 107.

3. Click Unload Options.

XXXX maximum frequency

L number of lines

M transducer type

S signal detection

W window type

NN number of averages

E average type

p phase measurement flag
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The Unload Options dialog box appears.

4. Check the Print reports checkbox and then select the reports you want the 
Emonitor software to run automatically after unloading data.

5.  Click OK.

Quickload Files

The Emonitor software rebuilds a Quickload file before loading it to the data 
collector. These are the reasons why a Quickload file is created:

• The list is not stored with the ‘Use quickload file’ option selected.
• The measurement definitions in the list change.
• The inspection codes in the list change.
• The locations in the list change.
• The hierarchy level of items in the Hierarchy Tree that affect measurement 

definitions in the list change.
• The collection specification of a measurement definition in the list 

changes.
• The ‘Override collect on alarm settings (in the Load Option dialog box) 

are selected. 
• The list has been saved since last loaded.
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Load a list to the Storage Card

The Emonitor software can load lists to either the Dynamix 2500 data collector 
internal memory, or to an SD storage card. You control the destination for lists 
with the Route Memory parameter in the Setup Utility screen in the Dynamix 
2500 data collector:

• Set Route Memory to Internal to store lists and data in internal memory.
• Set Route Memory to Storage Card to store lists and data to the SD card.

TIP The Route Memory parameter is not applicable when unloading 
data. the Emonitor software can unload lists from both the 
Dynamix 2500 data collector internal memory and the SD card 
at the same time.
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Collecting and Reviewing Data

The Dynamix 2500 data collector lets you to collect a list of measurement 
definitions, data for points in a list (route) and for unscheduled data (points not 
defined in a route). Once you collect your data, you can review the data on the 
screen or save it to a storage card. You can then unload the data from the route 
into the Emonitor database for storage and analysis. 

Preparing for Data 
Collection

There are several things you should do before you start collecting data with the 
Dynamix 2500 data collector, assuming you have already loaded at least one list 
(route) into the data collector. This section discusses connecting the transducer 
and setting up the data collector options.

1. Make sure you have a fully charged battery pack. 

See Battery Pack on page 23 for information on battery life.

2. Check the date and time on the data collector. 

See Set the Date, Time and Date Format on page 50.

3. Connect the transducer to the Dynamix 2500 data collector.

See Connect a Transducer to the Data Collector on page 130.

4. Check the data collection options.

See Select the Data Collection Options on page 130.

Topic Page

Preparing for Data Collection 129

Collecting Route Data 131

Collecting Offroute Data 149

Reviewing Data 161

Capturing Screens 168
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Connect a Transducer to the Data Collector

Follow these steps to connect a transducer to the data collector.

1. Match the red dot on the connector to the red dot on the data collector.

2. Insert the transducer cable into either Connector A or B on the data 
collector.

Do not turn or twist the connector. 

• If you are using an external tachometer signal for phase measurements, 
connect your tachometer signal to the POWER/USB/TRIGGER 
connector on the data collector. 

• You must also set the Trigger parameter in the Setup Utility screen to 
External, otherwise the instrument uses the internal Laser Tachometer 
to collect the measurement. 

See Configure the Data Collection Options on page 57 for more information on 
setting the Trigger parameter.

Select the Data Collection Options

There are many options that options affect the measurement, the data collection 
process, and the data display. The Dynamix 2500 data collector stores these 
options even when its powered off. However, you should check these options 
each time you start data collection. The options are located in the Instrument 
Configuration screen. 

See Configure the Data Collection Options on page 57 for instructions on how 
to select the data collection options.

WARNING: To prevent damage to the cable and cable pins, take care 
when connecting the transducer to the data collector.
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Collecting Route Data This section explains how to collect list (route) data using the Dynamix 2500 
data collector. Using your predictive maintenance software, you can load a list to 
the data collector to organize your data collection, then collect data for the 
measurement definitions in the list (route). Once you have prepared the 
instrument for data collection you are ready to select a route and collect data.

Select a Route

The Dynamix 2500 Data Collection program operates on a route. This can be 
the Default Route or a route you create and unload with your computer software. 
Routes that you create with your computer software may contain multiple points, 
and each point may cause the instrument to perform multiple measurements.

For more information about Route management, see Dynamix 2500 Data 
Collector Main Menu on page 45.

Follow these steps to select a route.

1. Select Data Collection from the Main Menu and press Enter.

2. Select a route from the Route Manager screen and press Enter.

TIP If you do not use the predictive maintenance software to create and 
load lists to the data collector, Dynamix 2500 data collector 
automatically creates a route named Default Route for you to use to 
collect data.

TIP If the data collector does not have a route downloaded from the 
Emonitor software, it lets you create a default route. The default 
route contains only one measurement point.

Once you have selected a route, 
you can open the route by pressing 
Enter or the Right arrow.
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The Data Collection screen appears.

Depending on what you have configured in Emonitor, each of these 
parameters may offer more selections when you press the Right arrow. 

For example, if you select the Location parameter and press the Right 
arrow you will be taken to the Select Location Screen.
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Move through a List

There are several methods for moving through a list:

• If you set Auto Store to On in the Instrument Configuration screen, the 
data collector automatically goes to the next measurement in the list. 

• If you set Auto Store to Off, the data collector goes to the next 
measurement when you press Enter to accept the measurement. 

You can also move between items on a route in the Data Collection window 
without collecting data. You can skip a measurement point or an entire machine if 
necessary and continue with the list. You can exit Data Collection mode at any 
time by exiting the Data Collection screen. 

Follow these steps to move to another a measurement or machine.

1. Select the desired hierarchy level (Plant, Train, Machine, and Location). 

2. Press the Right arrow key. 
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A selection screen appears. A checkmark next to the item indicates that a 
measurement has been stored.

3. Select an item and press the Left arrow.

4. Continue collecting data and move through the list until you reach the end 
of the list.

TIP The Selection screen does not appear if you set 
Navigation to DataPac in the Setup screen. The Dynamix 
2500 data collector automatically moves to the next 
point in the route when the Right arrow key is pressed. 
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Start Data Collection

After setting the data collector options and selecting a route, you are now ready to 
start data collection. 

Follow these steps to start collecting data.

1. Once you have selected a list, you begin collecting data from the designated 
point on the route.

2. Connect the transducer and press Enter to start a measurement.

3. If necessary, press Enter again to collect a measurement depending on the 
Auto Store setting in the Instrument Configuration screen.

See Instrument Configuration Parameters on page 59.

You may notice that a Bias Check is taken if the parameter is set to Auto.

IMPORTANT The Dynamix 2500 data collector supplies power to ICP 
accelerometers through the A and B connectors. The ICP power `turns 
on’ prior to collecting the first measurement point and remains on 
until the following occurs:

• You reach the end of the route.
• The data collector advances to a measurement point that does not 

require ICP power.
• You exit the route menu.

Do not connect the channel to a BNC panel or non ICP device until the 
Dynamix 2500 data collector advances to a non ICP measurement 
point. Connecting the channel while collecting a measurement point 
that requires ICP power may cause undesirable results, damage to the 
equipment, or unexpected machinery trips.
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Bias Check

The Bias function checks the bias of the transducer before taking the 
measurement. There are two options for the Bias Check parameter, Automatic 
and Manual. 

When you are in the Route Hierarchy, you can check the bias voltage for ICP 
measurements manually by pressing 0 (Shift)+2 (B) to. 

This turns on the ICP supply (if it wasn't already) and measures the DC bias 
voltage for each channel used by this measurement.

Channel X for single channel points. Typically X and Y is for two-channel points, 
and X, Y, and Z for Triax points. 

The Bias check screen shows the voltages for each channel.

The Bias check results screen 
displays a red or green input 
indicator.

Green appears when the bias 
voltage is between 2V and 18V, 
which is regarded as normal.

Red appears if it is outside this 
range.

This can be useful when 
troubleshooting a cable or 
accelerometer.
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Select Inspection Codes

Inspection codes let you document operating conditions while collecting data. 
You must load the inspection codes into the Dynamix 2500 data collector when 
you load a list. Only those inspection codes loaded with a list are available for that 
list. 

Using the Emonitor software, you can load up to 100 inspection codes per list. 
The data collector lets you to store up to six inspection codes with each 
measurement point. The Emonitor software automatically unloads the 
inspection codes from the data collector when you unload the data.

Follow these steps to enter an inspection code while you collect data.

1. Press F3 (Notes) while in any measurement screen. 

The Notes screen appears.

2. Select a code by entering the inspection code number and press Enter. 

A checkmark appears to the left of the assigned inspection code:

• To clear the checkmark, highlight the inspection code and press Enter 
again.

• To save your changes and return to the measurement screen, press F2 
(OK).

• To cancel your changes and return to the measurement screen, press F3 
(Cancel).

TIP If you notice an unusual condition prior to data collection, such as bad 
belts, you can select an inspection code that applies to the current point 
on the route.
Rockwell Automation Publication 1441-UM001B-EN-P - September 2012 137



Chapter 5 Collecting and Reviewing Data
Manually Enter a Numeric Measurement

Using a route that is configured the Emonitor software, the data collector displays 
a field on the Collecting Data screen that lets you type in a value for a reading.

Follow these steps to manually enter a numeric measurement.
1. In the Emonitor Software, create a Manual route and upload to the data 

collector.

See the Emonitor User Manual publication, EMONTR-UM001 for 
information about creating routes and loading them into the data collector.

2. From the Data Collection screen, press Enter.
The Route Manager Screen Appears.

3. Select the manual route that you loaded to the data collector.
4. Press Enter to start your measurement for the current point. 

The Manual Entry Process Measurement screen appears.

5. Type a value between zero and the full scale.

6. Press Enter to accept the value. 

7. Press Enter to go to the next measurement and continue data collection.

• Press F1 (edit) to edit the value. 

• Press F2 (Retake), after you have 
changed the value.

• Press F3 (Notes) to view and Notes 
that you loaded from the Emonitor 
software.

• Press F4 (Esc) if you do not want to 
keep the current measurement.
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Collect a Process DC Voltage Measurement 

Once you have created a route in the Emonitor Software and uploaded it to the 
data collector you can begin to take the measurement.

See the Emonitor User Manual publication, EMONTR-UM001 for 
information about creating routes and loading them into the data collector.

Follow these steps to collect a Process DC voltage measurement.

1. Attach the DC voltage input to the data collector and correct location.

2. From the Data Collection screen, press Enter.
The Route Manager Screen Appears.

3. Select the process route you uploaded from the Emonitor software and 
press Enter to start your measurement for the current point.

The DC Volts Measurement screen appears.

The instrument continually updates the magnitude value for the 
measurement. 

TIP For DC process measurements, conservative autoranging is always used 
to minimize the effects of internal DC offsets.

For more information about Autoranging, see See Instrument 
Configuration Parameters on page 59.

A message appears 
stating that the data 
collector is acquiring 
data
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Alarms appear when there is an alarm condition, such as the removal of a 
sensor on Channel X.

4. Once the reading is steady and the input signal is not overloading the data 
collector, press Enter to accept the measured value.

Once the measurement is stored, you are taken back to the Route hierarchy.

IMPORTANT You do not need to press Enter if you set Auto Store to On in the 
Instrument Configuration screen. 

The data collector automatically ranges and collects the 
measurement.

See Instrument Configuration Parameters on page 59. 

TIP The green status indicator illuminates when the measurement 
is complete. See Status Indicators on page 22.
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Collect a Magnitude Measurement

Once you have created a route in the Emonitor Software and uploaded it to the 
data collector you can begin to take the measurement.

See the Emonitor User Manual publication, EMONTR-UM001 for 
information about creating routes and loading them into the data collector.

Follow these steps to collect a magnitude measurement.

1. Attach the DC voltage input to the data collector and correct location.

2. From the Data Collection screen, press Enter.
The Route Manager Screen Appears.

3. Select the magnitude route you uploaded from the Emonitor software and 
press Enter to start your measurement for the current point.

The Magnitude Measurement screen appears.

A graphic appears on the screen while the data collector ranges the data. 
The data collector continually updates the magnitude value for the 
measurement. 

4. Once the magnitude reading is steady and the input signal is not 
overloading the data collector, press Enter to accept the measured value. 

Once the data collector stores the measurement, the Data Collection screen 
displays the next point in the list (route).

IMPORTANT You do not need to press Enter if you set Auto Store to 
On in the Instrument Configuration screen. The data 
collector automatically ranges and collects the 
measurement.

See Instrument Configuration Parameters on page 59.
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Collect a Spectrum Measurement

One of the most useful ways to display vibration signals is in a spectrum. The 
spectrum displays the vibration signal level in relation to the frequencies at which 
the vibration occurs. 

To display a spectrum, the Dynamix 2500 data collector analyzes the frequency 
components of the signal and breaks this analysis down to a number of frequency 
bands where the signal level for that band is represented by a single value. These 
bands are calstatus indicator lines. 

A typical spectrum could have 400 lines although the data collector lets you to 
select a smaller or larger number of lines. The higher the lines, the higher the 
resolution, and the longer it takes the data collector to acquire the data for a 
spectrum.

Lines of resolution, Fmax, and number of averages all affect the length of time it 
takes to acquire and process a spectrum. You can control each of these setup items 
either in your computer software for route measurements or on the User screen 
for Offroute measurements.

See Create and Collect a User-defined Point on page 152 for more 
information about Offroute measurements.

Once you have created a route in the Emonitor Software and uploaded it to the 
data collector you can begin to take the measurement.

See the Emonitor User Manual publication, EMONTR-UM001 for 
information about creating routes and loading them into the data collector.
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Follow these steps to take a spectrum measurement.

1. Attach the transducer to the current location.

2. From the Data Collection screen, press Enter.
The Route Manager Screen appears.

3. Select the spectrum route you uploaded from the Emonitor software and 
press Enter to start your measurement for the current point.

Figure 24 - Spectrum

Table 40 - Tasks Associated with Ranging the Measurement

If you Then

Previously collected a magnitude measurement 
for the point

the spectrum measurement starts automatically 
after you press Enter to accept the magnitude 
reading

Set Auto Advance to On in the Instrument 
Configuration screen

the Dynamix 2500 data collector automatically 
goes to the next point in the list after it finishes 
collecting the spectrum

Set Auto Advance to Off then the Signature Measurement screen appears

Set Fast Averaging to On in the Instrument 
Configuration screen

the Dynamix collects the specified number of 
averages before displaying the spectrum on the 
screen

Set Fast Averaging to Off the Dynamix displays the spectrum while 
collecting the averages

View / add coded 
and type-in notes

Leave without 
storing data

Retake the 
measurement

Set cursor frequency 
as running speed

Point information:
Machine name
Point ID
Point description
Alarm condition

Cursor

Overall value

Current cursor frequency 
and amplitude

Alarm indicators

Previous measurement 
indicators

Percentage difference from 
previous measurement
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4. When finished viewing the spectrum, press Enter to proceed to the next 
point in the list.

See Review Data on page 164 for more information on cursor options.

Keying Description

Percentage changed The spectrum displays a percentage changed bar. It provides an overall 
value of the current measurement in comparison to alert and danger 
alarms. These colored arrows display if the point is in an alarm state 
(red), in an alert (yellow) or if there is no alarm (green). If the 
measurement amplitude extends beyond the display, an overall 
overflow indicator appears at the top of the bar.
This bar displays the percentage of change from the previous overall 
reading:
• A positive percentage indicates the measurement is greater than the 

previous reading. 
• A negative percentage indicates the measurement is less than the 

previous reading.
For example, -2% means that the reading is 2% down from the last 
reading, or 95% of the last reading; while +2% means that the 
reading is 2% up from the last reading, or 102% of the last reading. 

• A display of +100% indicates either a 100% increase.
For example, the new reading is twice the old reading, or that there 
is either no previous reading, or the previous reading was 0%.

Y-Axis Graph Scaling 
Adjustment

You can use the Up and Down arrows to manually adjust the y-axis 
graph scaling on the spectrum. This lets you re-scale the plot to get a 
closer look at low amplitude components:
• Up arrow decreases the Y-axis graph scale setting by ½ of its current 

setting.
• Down arrow doubles the Y-axis graph scale setting.

Harmonic Markers The H key displays harmonic markers for the current cursor position.
Harmonic markers rapidly locate integral orders in relation to their 
fundamental (1X). 
The H key cycles the three harmonic cursor modes:
• Simple, no harmonic cursors.
• Harmonic, displays the harmonics of the current cursor position. The 

spectral cursor acts as the fundamental marker, and is re-positioned.
• Fixed, the harmonics remain fixed and cursor can be moved 

independently.
The default is Simple (off).

Peak cursor The P key lets you quickly jump the cursor to the next highest peak to 
the right of the cursor.

Display Expansion The +/- key graphically expands or compresses the frequency domain 
display range horizontally around the cursor position. It reveals 
characteristics that may be hidden by the display mode or by the 
resolution without changing data collection parameters.
When using +/-, the spectrum’s fmax setting expands and the spectrum 
reforms to the new fmax. You can repeat to continue to expand up to 
the maximum resolution (based on the number of lines of resolution for 
the spectrum), after which the function switches to compression.
Dot (.) key immediately toggles the +/- key between display expansion 
and compression.
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Collect a Time Waveform Measurement
Time waveform plots display a short time sample of a raw vibration signal with 
vibration amplitude plotted over the time scale. Time waveform data appears on a 
plot similar to the spectrum display screen.
Follow these steps to collect a time waveform measurement.

1. Attach the transducer to the correct location.

2. From the Data Collection screen, press Enter to begin ranging the 
measurement. 

• If you set Auto Advance to On in the Instrument Configuration screen, 
the Dynamix 2500 data collector automatically goes to the next point in 
the list after if finishes collecting the time waveform measurement. 

• If you set Auto Advance to Off then the Time Waveform Measurement 
screen appears.

• Use the Left and Right arrow keys to move the frequency and amplitude 
cursor.

• Press the +/- key to expand and compress the time waveform spectrum 
plot. 

• Press the H key to display the harmonic cursors. 
• Press the P key while the harmonic cursors are displayed to move the cursor 

to the next significant peak.
See Review Data on page 164 for more information on cursor options.

3. When finished viewing the time waveform, press Enter to continue to the 
next point.

IMPORTANT If you previously collected a magnitude measurement for the 
point, the time waveform measurement starts automatically 
after you press Enter to accept the magnitude reading. 

If you set Auto Store to On in the Configuration screen on the 
data collector, you do not have to press Enter.
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Collect Magnitude and Phase Measurements at Orders 

The Dynamix 2500 data collector can collect multiple magnitude and phase at 
orders of the operating speed. You use a tachometer signal measuring the 
operating speed to collect phase data. 

Follow these instructions to collect a spectrum for calculating additional 
magnitude and phase values at orders of the operating speed.

1. Align the speed reference device, such as a tachometer, in the correct 
direction and attach the vibration transducer properly. 

2. From the Data Collection screen, press Enter to start ranging the 
measurement. 

The Dynamix 2500 data collector calculates the speed from the 
tachometer signal and adjusts the maximum frequency for measuring the 
spectrum so that all orders can be calculated from the spectrum:

• If you set Auto Advance to On in the Instrument Configuration screen, 
the Dynamix 2500 data collector automatically goes to the next point 
in the list after it finishes collecting the spectrum. 

• If you set Auto Advance to Off then the Signature Measurement screen 
appears.

TIP The message No signal appears if the Dynamix 2500 data 
collector cannot trigger off the tachometer signal to calculate 
the speed. If this happens, fix the speed device signal and 
connections. The Dynamix 2500 data collector resumes data 
collection once it can trigger off the tachometer signal. You 
must use a key hole or reflection tape to trigger the 
tachometer.
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• If you set Fast Averaging to On in the Instrument Configuration screen, 
the Dynamix collects the specified number of averages before displaying 
the spectrum on the screen. 

• If Fast Averaging is set to Off, the Dynamix displays the spectrum while 
collecting the averages. The number of averages appears in the middle of 
the screen.

3. Press 0 (Shift) to display more functions and press F4 (View)

4. Press Enter to continue to the next point. 

See Review Data on page 164 for more information about the Signature 
Spectrum.

Exceptions

Two exceptions exist for combining measurement definitions. The Emonitor 
software and the Dynamix 2500 data collector cannot combine magnitude + 
phase measurements with any other measurements. Nor can they combine 
manual entry measurements with any other measurements. Both types remain as 
individual measurements when loaded into the Dynamix 2500 data collector. 

The Emonitor software can calculate an overall value from a spectrum 
measurement. Under some conditions, this value may not be the same as the 
magnitude measurement for the same location. These are the common uses:

• The measurement filter is not the same for the magnitude and the 
spectrum measurement definitions. In this case the two measurement 
definitions are measuring different frequency ranges.

• The magnitude readings taken by the Dynamix 2500 data collector are 
broadband readings and are not based on the spectrum data.
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Collect Multiple Measurements for a Point

The Dynamix lets you to collect multiple readings for a single measurement 
point. When collecting data, it’s possible to take new data for a point that already 
has stored data and append it to the existing data records. If more than one data 
record has been collected for a point, you have the option to review each data 
record separately, or view all data records simultaneously as a waterfall plot.

Follow these steps to view points with historical data.

1. In the ROUTE hierarchy, select point you would like to review and press 
F1 (Review).

2. Use F2 (Next) to view the next point.

3. Use F1 (Previous) and F2 (Next) to scroll through points.
• If you set Hist. Data Collect to Always Append in the Instrument 

Configuration screen, the new data is appended to the existing data. 
• If you set Hist. Data Collect to Always Overwrite, the new data is replaced 

with the existing data. 

See Configure the Data Collection Options on page 57 for more 
information. 

4. Select the point that you need to collect additional measurements from 
and press Enter to start the measurement.

5. Once the Dynamix collects the measurement, press Enter to accept the 
measured value. 

If you set Hist. Data Collect Always Ask in the Instrument Configuration 
screen, the following dialog box appears. 

6. Do one of the following:
• Press F1 (Append) to append new data to the existing data. 
• Press F2 (Overwrite) to replace existing data with the new data. 
• Press F4 (Discard) to delete the new data and retain the existing data.

The Dynamix can store up to ten additional measurements for the same 
measurement point. The additional measurements will be unloaded to your 
database when you select Unload all readings in the Unload Options dialog box.

See Unload Multiple Measurements Points in the Emonitor Software on 
page 122. 
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Collecting Offroute Data The Offroute program lets you to collect data that is not part of a list (route). 
While collecting list data, you may notice some unusual conditions that you want 
to analyze further. You may also want to collect data for undefined points (points 
not in your database), or existing points that are not in your current list (route).

The Dynamix 2500 data collector always associates Offroute measurements with 
a list. If you have not loaded a list into the Dynamix 2500 data collector, the 
Offroute data is associated with the Default Route. Offroute measurements are 
stored at the current point. The current point is defined by where you leave the 
regular route to take an Offroute measurement. The Dynamix 2500 data 
collector labels the Offroute measurements as numbers. For example, the first 
Offroute measurement is labeled as 1. This number increments by one each time 
you collect an Offroute measurement.

To unload unscheduled measurements into the host software, you must have first 
loaded a list so that the unscheduled measurements can be unloaded with that 
list.

Methods for Collecting Offroute Data

There are two methods for collecting Offroute measurements with the Dynamix 
2500 data collector:

• Choose one of the pre-defined measurements on the Offroute 
Measurement screen. 

This method provides an easy way to collect Offroute measurements for 
the current point. 

Dynamix 2500 data collector provides seven pre-defined measurements for 
you to use to collect the Offroute data. You do not need to set any 
parameters if you use the pre-defined measurements. The Dynamix 2500 
data collector uses the measurement definitions for the current point. 

See Collect Offroute Data using a Pre-defined Measurement on page 150. 

• Create a user-defined measurement point. 

This method lets you to set up and collect any type of measurement. 

See Create and Collect a User-defined Point on page 152.
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Collect Offroute Data using a Pre-defined Measurement

The Dynamix 2500 data collector provides seven pre-defined measurements for 
you to use to collect Offroute data. These are the data collector’s pre-defined 
measurements.

You do not set any parameters when you use a pre-defined measurement. The 
Dynamix 2500 data collector uses similar settings as the measurement definitions 
for the current point.

Follow these steps to collect an Offroute measurement for the current point.

1. From the Main Menu, select Data Collection and press one of the Enter 
keys. 

The Data Collection screen appears.

2. Select the route and measurement point.

3. Press F2 (Offroute) to collect an Offroute measurement. 

Table 41 - Pre-defined Measurements

Measurement Description

Same  Uses the same setup as the current point.

Opposite Uses the opposite setup as the current point.
For example, spectrum is time, time is spectrum.

Accel  Acceleration spectrum point
10kHZ, 800 lines, 4 averages

Velocity  Accel velocity spectrum point 
2kHz, 400 lines, 4 averages

Accel Time Time point 
10kHz, 2046 points

High Res High resolution point (increase number of lines by a factor of two.
For example, the current point having 400 lines becomes 800 lines.

gSE Spike energy point
Envelope parameter in Instrument Setup must be set to gSE.
See Instrument Configuration Parameters on page 59.

ESP Standard Envelope Spectrum Processing (ESP) point
Envelope parameter in Instrument Setup must be set to ESP. 
See Instrument Configuration Parameters on page 59.
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The Offroute measurement screen appears.

4. Select the a pre-defined measurement icon to store an Offroute 
measurement at the current point.

5. Connect the a transducer and press Enter to start the measurement.

The measurement screen appears. 

6. For manual entry points, enter the magnitude value with the numeric key 
pad.

7. If desired, press F3 (Notes) to assign inspection codes to each point. 

The Dynamix 2500 data collector unloads inspection codes when you 
unload the unscheduled data to Emonitor. 

See Select Inspection Codes on page 137.

8. After the data collector collects the measurement, press Enter to accept the 
measurement.

The green status indicator illuminates when the measurement is complete 
and the Offroute screen appears. The measurement is stored as an Offroute 
measurement at the current point.

9. Press F4 (Esc) to return to the Data Collection screen.
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Create and Collect a User-defined Point

The Offroute program lets set up and collect any type of Offroute measurement 
point. The Dynamix 2500 data collector keeps the user-defined parameters until 
you collect another measurement point or press F2 (Default) on the Offroute 
User screen.

Table 42 - Types of Offroute Measurements

Type Description

Same The measurement configuration is based upon the most recently selected 
measurement in the Route Manager. The setup is the same as the active 
measurement. This lets you collect Offroute measurements that are identical to 
your active measurement, but from various sensor positions for analysis purposes.
If you have setup the active route to collect both FFT and time waveform data, the 
Offroute Same measurement is FFT only.
Measurement parameters are set to:
Overlap – 50%
Bin Zeroing – On

Opposite The measurement configuration is based upon the most recently selected 
measurement in the Route Manager, except it collects the Opposite data format. 
For example, if the active Route Point collects FFT spectrum data, the Opposite 
Offroute measurement collects time waveform data, and vice versa.
Measurement parameters are set to:
Overlap – 50%
Bin Zeroing – On

For Accel, Velocity, Accel Time, and gE pre-set measurement types, the following
standard settings are taken from the current selected Route measurement:

– Sensitivity
– Coupling
– Detection
– Window

Accel Performs a standard vibration Acceleration measurement.
These are the settings for the measurement parameters.

Parameter Value

Display Format Spectrum

Units - Accel Accel (G)

Input Channel X

High-pass frequency 1.1 Hz 

Fmax  10 kHz

Lines/Samples 800 Lines

Averages 4

Overlap 50%

Type Spectral

Ext. Trigger Slope Positive

Trigger Level  2 V

Bin Zeroing On
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Velocity Performs a standard acceleration to velocity vibration measurement.
These are the settings for the measurement parameters.

Accel Time Performs a standard vibration Acceleration measurement and collects waveform 
data.
These are the settings for the measurement parameters.

Table 42 - Types of Offroute Measurements

Type Description

Parameter Value

Display Format Spectrum

Units A -> V

High-pass frequency 1.1 Hz

Input Channel X

Fmax 1 kHz

Lines/Samples 400 Lines

Averages 4

Overlap 50%

Type Spectral

Ext. Trigger Slope Positive

Trigger Level  2 V

Bin Zeroing On

Parameter Value

Display Format Time

Units Accel (G)

High-pass frequency 1.1 Hz

Input Channel X

Fmax  8 kHz

Lines/Samples 256…32768 samples

Averages 4 (time sync)
If a trigger is defined for the active Route 
point, if no
trigger is detected only 1 average is 
taken.

Overlap 50%

Type Time

Ext. Trigger Slope Positive

Trigger Level  2 V
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Create a User-defined Point

Follow these steps to create a user-defined point.

1. Select Data Collection from the Main Menu and press the Enter key. 

The Data Collection screen appears.

2. Select the route and press Enter. 

The Dynamix 2500 data collector always associates Offroute 
measurements with a list.

3. Press F2 (Offroute) to collect an Offroute measurement. 

High Res. The measurement configuration is based upon the most recently selected 
measurement in the Route Manager
The setup is identical to the active measurement in the active Route, except the 
Lines/Samples setting is doubled (increased by a factor of 2) to a maximum of
25,600 lines (up to 12,800 for two-channel measurements and up to 6,400 for three
and four-channel measurements). 
For example, if the active Route Point’s Lines/Samples setting is 400 Lines, the 
High Resolution Offroute measurement’s Lines/Samples setting is 800 Lines.
This lets you take a high resolution look at your active Route measurement. 
Measurement parameters are set to:
Overlap – 50%
Bin Zeroing – On

gSE Performs a standard vibration Acceleration measurement and collects waveform 
data.
These are the settings for the measurement parameters.

Orbit Measures the path of a shaft center-line motion during rotation. Parameters for 
Offroute orbit measurements are configured in the Offroute Orbit Setup screen.

Table 42 - Types of Offroute Measurements

Type Description

Parameter Value

Units Enveloped Acceleration

Display Format Spectrum

Band High-pass frequency gSE BPF 5 kHz

Fmax  10kHz

Lines/Samples 400

Averages 4

Input Channel X

Overlap 50%

Ext. Trigger Slope Positive

Trigger Level  2 V

Bin Zeroing On

Type Spectral
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The Offroute measurement screen appears.

4. Press F2 (User). 

The Offroute User screen appears.

5. Select a parameter you want to change and press the Right arrow key to 
open the menu of choices.

6. Select your choice by using the arrow keys, or typing in a value using the 
numeric key pad.

7. Press the Left arrow key to save your choices.

Use the descriptions in this table to help you configure the parameters in the 
Offroute User screen.

Press F2 (User) to create a user-
defined point.
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Table 43 -  Offroute User Parameters

Parameter Name Description Values/Comments

Change Name Changes the name of the user-defined measurement point. 
Select the hierarchy level for which you want to change the name. A 
window opens at the bottom of the screen. Use the numeric key pad 
to enter a new name and press F2 (OK).

Select Level (default)
Default Locn
Default Point
1 Horiz
Default

Collection The type of data to collect with this measurement. Overall/Signature (default): collect both a magnitude 
reading and a signature.
Overall only: collect a magnitude reading only.
Signature only: collect a signature only.
RSS Overall: collect a digital overall measurement. 

Display Format The display format of the measurement. Spectrum (default)
Time
Phase
Order

Units The measurement units for the transducer.
The [S] designation refers to a static measurement that you must 
manually enter with the numeric key pad. All dynamic measurements 
and temperature process points require a transducer to make the 
measurement.

Accel (G) (default)
gSE
RPM
A->V (mm/s)
Vel (IPS)
Vel (mm/s)
A->D (mil)
A->D (µm)
V->D (mil)
V-D> (µm)
Disp (mil)
Disp (µm)
Volts
EU’s [S]
Temperature [S]
Current (A) [S]
Pressure (PSI) [S]
Flow (m3/s) [S]
Rot. Speed [S]
Linear Displ (mm)
Count [S}
Count Rate [S]
Volts [S]
Accel (G) [S]
Vel. (IPS) [S]
Vel (mm/s) [S]
Disp (mil) [S]
Disp (µm) [S]

Coupling The type of coupling that will be applied to the measurement. AC: couples the input voltage signal.
DC: couples the input voltage signal.
ICP: (default) selects a standard ICP accelerometer 
requiring a current source power supply
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Input channel Maps the input channel to the LEMO connectors on the top of the 
Dynamix 2500 data collector. Input channel X maps to Connector A 
(pin 2):
• Input channel Y maps to Connector B (pin 2); it is also linked to 

Connector A (pin 6).
• Input channel Z maps to Connector A (pin 3); it is also linked to 

Connector B (pin 7)

X (default)
Y
Z
X & Y
Z & Y
X, Y & Z
Input channel X, Y & Z (3 channels) and X, Y, Z & R (4 channels) 
are optional upgrades. You can activate the 3 and 4-channel 
functionality with the 4-channel activation, cat no, 1441-
DYN25-4C.

Detection The measurement (or calculation) performed on the input signal. RMS, Peak, Pk-Pk, True Peak, True Pk-Pk

Sensitivity The sensitivity of the transducer. The sensitivity value is included 
with the transducer’s documentation or it may be imprinted on the 
side of the transducer.

Default value is 100m V/EU (Engineering Unit)

Filter Sets the high pass filter to apply to the measurement. The high pass 
filter is useful in removing high vibration, low frequency signal 
components that would dominate the signal. 

Off (default)
Set Filter to Off if you do not want to use a filter.

10.8 Hz
21.6 Hz (default)
120 CPM
160 CPM
318 CPM
600 CPM
1428 CPM
4200 CPM

Fmax The maximum frequency for the measurement. 18000 CPM (default)

Lines/Samples The number of lines or bins in the spectrum measurement and the 
number of samples in the waveform measurement. This determines 
the measurement resolution.
The data collection time increases as you increase the measurement 
resolution.

For spectra: 100…25600 spectral lines.
For time waveforms: 256…65536 time samples.
400…1024 (default)

Table 43 -  Offroute User Parameters

Parameter Name Description Values/Comments

Detection Description

RMS The Dynamix 2500 data collector measures the dynamic signal as the square root of the mean of 
the square. Use this or the Peak setting for most acceleration and velocity measurements. Use 
this also for time waveform, voltage, and process (DC) voltage measurements.

Peak The Dynamix 2500 data collector measures the dynamic signal from zero to peak voltage. Use 
this or the RMS setting for most acceleration and velocity measurements.

Pk-Pk The Dynamix 2500 data collector measures the dynamic signal from the minimum peak to the 
maximum peak. Use this setting for most displacement measurements.

True Peak Use to detect impacts and random transients. The dynamic time signal contains the absolute 
value of the largest peak (positive or negative) within a specified time window. Returns a 
magnitude value only. If used with a spectrum measurement, Emonitor uses a Peak detection 
type instead. This value is not calculated but is measured directly.

True Peak Pk-Pk Use to detect impacts and random transients. The dynamic time signal contains the absolute 
value of the largest peak to peak distance within a specified time window. Returns a magnitude 
value only. If used with a spectrum measurement, Emonitor uses a Peak-Peak detection type 
instead. This value is not calculated but is measured directly.
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Window Type of window to be applied to the waveform measurement prior to 
computing the spectrum

Hanning (default), Hamming, Flat Top, Rectangular

Averages Sets the number of individual data sets to be incorporated into the 
average calculation.

Numeric value
4 (default)

Overlap The percentage of overlap during the averaging. It can be used to 
reduce the total time that it takes to collect the data.

Percentage

Type Sets the type of averaging for the measurement. Spectral (default)
Time Synchronous
Peak Hold
Exponential

Ext Trig Slope The input signal slope to be used for externally triggering the 
measurement.
+ve - Defines the trigger event to occur on a rising edge.
-ve - Defines the trigger event to occur on a falling edge. 

+ve (default)
-ve

Level The amplitude level for externally triggering the measurement. The 
level is a percentage of the trigger full scale range.

Numeric: 0.0 (default)

Bin Zeroing Enables/disables bin zeroing. When set to Off, the bins below the 
selected high pass filter are not zeroed. That is, data still appears but 
is attenuated by the filter shape.
Set bin zeroing to On when you want to be sure unwanted 
frequencies do not affect data. Set bin zeroing to Off when you want 
to be aware of the presence of unwanted frequencies.

On (default)
Off

Table 43 -  Offroute User Parameters

Parameter Name Description Values/Comments

Window Description

Hanning A general purpose window to use on random type data when frequency resolution is more important than 
amplitude accuracy. Use this setting for most of your machinery monitoring activities.

Hamming Another general purpose window with slightly different window characteristics than the Hanning 
window.

Flat Top Use this when amplitude accuracy is more important than frequency resolution. In data with closely 
spaced peaks, a Flat Top window may smear the peaks together into one wide peak. Use this for 
sinusoidal or calibration signals.

Rectangular The Dynamix 2500 data collector does not apply a window. Use this only for transient signals that die out 
before the end of the time sample, or for exactly periodic signals within the time sample.
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Collect a User-defined Measurement

Follow these steps to collect a user-defined measurement.

1. After setting up the measurement, connect the proper transducer.

2. Press Enter from the Offroute User screen to start the measurement. 

The measurement screen appears. The Dynamix 2500 data collector 
ranges and collects the data.

3. If desired, press F3 (Notes) to assign inspection codes to each point. 

The Dynamix 2500 data collector unloads the inspection codes when you 
unload the unscheduled data to Emonitor.

See Select Inspection Codes on page 137.

4. If you want to collect data again for this point, press F2 (Retake) to collect 
the measurement again.

5. Once the Dynamix 2500 data collector collects the measurement, press 
Enter to accept the measurement.

The green status indicator illuminates when the measurement is complete. 
The measurement is stored as an Offroute measurement at the current 
point.

The Offroute screen reappears.

6. Press F4 (Esc) screen to return to the Data Collection screen.

Storing Unscheduled Data When you unload unscheduled measurements from the Dynamix 2500 data 
collector, The Emonitor software stores it in the database. There are two 
methods for storing.

Follow these steps to use the Smart Unscheduled mode. 

1. Select Tools > Load/Unload.

2. Click Unload Options. 

3. Check the Unscheduled location smart mode checkbox. 
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This lets the Emonitor software to match up measurement definitions with the 
correct location based on certain rules.

See Unload Measurements using Smart Unscheduled Mode on page 125.

If you do not have the unscheduled location smart mode checked, Emonitor 
stores unscheduled data in the unscheduled destination in the hierarchy tree of 
the database. 

You set the unscheduled destination with Tools > Set Unscheduled Dest. 

See Emonitor online help for more information.

Enable smart unscheduled 
by checking this option.
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Changing Display View Use the View function to determine how to view FFT (Spectrum) and Time 
waveform data. 

Follow these steps to view FFT and Time data.

1. Press (Shift) to display a second set of functions.

2. Press F4 (View).

3. Select a view option and press F4 (Apply).

Reviewing Data There are several functions available for viewing, analyzing overall and signature 
data in the data collector. 

The data collection screen appears after you select a Route to review.

Review route 
measurements

#6 of 10 
measurements 
taken

Take Offroute measurements
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Review Route Data
Follow these steps to review previously collected route data.

1. From the Route Manager screen, select a route and press Enter.

2. Select a hierarchy level (Plant, Train, Machine, and Location).

3. Press the Right arrow key. 

A Selection screen appears. 

4. Select the item that you want to review and press the Left arrow key. 

5. Press F1 (Review) to view the data.

Review Offroute Data

Follow these steps to review previously collected Offroute data.

1. From the Route Manager screen, select a route and press Enter.

2. Press F2 (Offroute).
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The Offroute screen appears. 

3. Press F1 (Review) to review the Offroute data. 

The Review Data screen appears. 

4. Select a point to review and press Enter or F2 (Review). 

If the point has more than one measurement, you can press Enter, F2 
(Next) or F1 (Previous) to the next measurement.
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Review Data

The Review Data screen lets you view the four types of measurements.

• Spectrum
• Time waveform
• Magnitude and phase orders
• Overall value

Follow these steps to the review data.

1. From the Route Manager, select a route and press Enter.

2. Press F1 (Review).

The Review Data screen appears.

3. Press F2 (Next) or F1 (Previous) to move back and forth through the 
review data screens.

Current signal 
amplitude

Full scale range

Last recorded value

% changed from last 
recorded value to the 
current reading.
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Follow these steps to view the Current Point Info. screen.

1. From the Route Manager screen, select a route and Press Enter.

2. Press Enter to start the measurement.

3. Press 0 (Shift),

4. Press F1 (Help).

5. Press F2 (Pt. Info).
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Use Diagnostic Frequency Cursors with a Spectrum

When frequency items are loaded with a list from Emonitor, the Dynamix can 
display the frequency item that goes with the cursor. 

Use the Left and Right arrow keys to move to each diagnostic frequency.

See Load Frequency Labels on page 117 for more information.

Moving Around a Review Data Screen

These are the shortcut keys for moving around a Review Data screen.

Table 44 - 

Key Description

+/- You can expand and compress the Frequency/CPM axis by pressing the +/- key.
When the Dynamix 2500 data collector first displays a signature, it displays the 
entire frequency range or time length of the measurement. If the signature contains 
detailed resolution (400 lines or more for spectra, 512 samples or more for time 
waveforms), the data collector automatically compresses the data to show the 
entire measurement.

Left and Right 
arrows

Use the Left and Right arrow keys to move the frequency cursor and the Up and 
Down arrow keys to move the amplitude cursor. The cursor values appear above the 
signature data.

H Press the H key to display the harmonic cursors. Each time you press H, it toggles 
among three functions.

P  Press the P key to move the cursor to the next significant peak. 

Press H Function

Once Enables the harmonic cursors. Press the Left and Right 
arrow keys to move the harmonic cursors.

Twice The cursor line is displayed with the harmonic cursors. 
Press the Left and Right arrow keys to move only a single 
cursor, leaving the harmonic cursors locked in position.

Thrice Turn the harmonic cursors off; use only a single cursor. 
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Review Waterfall Spectra Data

When you collect more than one spectrum for a point, the Dynamix 2500 data 
collector can display the spectrum in a waterfall mode, one after the other.

Figure 25 - Waterfall Spectral Data

• Press the Left and Right arrow keys to move the frequency cursor within 
the spectrum plot. 

• Use the Up and Down arrow keys to move between the spectrum plots. 

TIP The Waterfall spectra data will not appear if you set Hist. Data 
Review to Always Single in the Instrument Configuration 
screen. 
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Delete a Measurement

You can delete a previously collected measurement from the data collector when 
the Delete function appears on the screen. 

Follow these steps to delete a measurement.

1. Review the previously collected route measurement point. 

The appropriate Overall or Signature screen appears.

2. Press F3 (Delete).

A dialog box appears to confirm the deletion. 

3. Press F2 (Yes) to delete the measurement point.

A warning appears that states that all historical data will be removed.

Capturing Screens You can capture Dynamix 2500 data collector screen images in a bitmap (.bmp) 
format and store them on the Secure Digital (SD) storage card.

Follow these steps to capture an image to an SD storage card.

1. Display the screen that you want to capture.

2. Press the 0 key and the 7 key.

The Print dialog box appears.

3. Press F2 (OK) to store the image in a.bmp format on the storage card. 
The Dynamix 2500 data collector stores the image in: \Storage 
Card\dumpn where ‘n’ is the number of the bitmap. This number gets 
incremented by one each time you store an image on the card.

4. Press F4 (OK) to return to the Dynamix screen.

Print Reports and Plots by Using the Emonitor Software

You can use the Emonitor software to print reports.

See Automatically Print Reports after Unloading on page 126.
168 Rockwell Automation Publication 1441-UM001B-EN-P - September 2012



Chapter 6

Multi-channel Measurements

This chapter describes setting up, collecting, and reviewing orbit, cross channel 
phase, dual channel, and other multi-channel measurements. 

Two Channel 
Measurements

The Two Channel functionality offers advanced data collection in route and 
Offroute collection. With two channels, you can take the following 
measurements:

• Orbits
• Simultaneous 2-channel magnitude, time waveform and spectra
• Cross channel phase

Predictive Maintenance Program

An effective predictive maintenance program is typically based on the collection 
and analysis of routine vibration data, supplemented by other technologies, such 
as oil analysis, thermography, and motor current analysis. The detection of most 
common machine faults and the location of faulty components can be 
accomplished with a single-channel data collector measuring vibration, combined 
with a personal computer-based trending analysis software package. In many 
cases, however, a more thorough analysis requiring a dual channel acquisition 
capability is necessary to accurately identify specific faults.

Having access to two channels of information in simultaneous data acquisition is 
key to root-cause failure analysis. Making the measurements independently (and 
asynchronously) and calculating the relationship does not work well because of 
the effects of signal variations, outside disturbances, and noise in the system.

Topic Page

Two Channel Measurements 169

Orbit Measurements 170

Cross Channel Phase Measurements 182

Collect a Cross Channel Phase Measurement 188

Dual Channel Measurements 192

Collect an Offroute Dual Channel Measurement 193

Collect a 4-channel Measurement 197

Collect Multi-channel Measurements 198

Collect a Tri-axial Measurement 202
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One key parameter is the measure of relative phase between two points on a 
machine, which is easily calculated as a cross channel measurement. Phase 
measurements across a coupling can easily show misalignment. Phase 
measurements can also be used around a bearing to determine if it is cocked. 

It is even possible for a significant loss of mass, such as a thrown blade, to result in 
little or no change in vibration amplitude, but a very clear shift in phase. With the 
two-channel cross phase feature, there is no need for a reference mark on the 
shaft. Therefore, there is no need to stop the machine, nor is there a need for any 
triggering equipment - unless the requirement is to measure phase relative to a 
known reference such as a shaft keyway.

Orbit Measurements You can set up and collect orbit measurements with the Dynamix 2500 data 
collector using the two input channels and displacement transducers. Because 
sensor orientation is not loaded and unloaded with routes, the Dynamix 2500 
data collector assumes the trigger input comes from top dead center. From there, 
it calculates the relative sensor angles to be 90 degrees apart. The difference 
between Channel 1 and Channel 2 is always 90 degrees.

Understanding an Orbit Plot

Another set of key measurements with a two-channel collector results in an orbit 
plot. An orbit plot is derived from the output of two non-contact pickups 
(proximity probes) mounted radially, 90 degrees apart at the bearing.

Figure 1 - Relative Sensor Angles

If viewed in real time, the signals produce a trace on the screen of a Lissajous 
pattern, corresponding to the total shaft motion, which is really the orbit of the 
shaft in the bearing.

A filtered orbit can help exclude any frequencies not related to running speed or 
its harmonics. The slight elliptical shape of the 1X orbit plot shown in 1X Orbit 
Plot on page 171 shows a small unbalance condition.

In this case, a 1X filter was applied to the measurement for isolating potential 
running speed related anomalies. It is important to note, however, that other non-
1X related frequencies may be present that are missed if a filtered orbit is used.
170 Rockwell Automation Publication 1441-UM001B-EN-P - September 2012



Multi-channel Measurements        Chapter 6
Figure 2 - 1X Orbit Plot

If the machine has unbalance only, the displayed orbit will be dominated by a 
once-per-revolution signal and have a circular or elliptical shape.

To get a better impression of the actual shaft motion and to identify other 
common machine anomalies, such as misalignment, shaft whirls, rubs, and 
looseness, all signal frequencies are required up to several orders of shaft speed. 
The orbit shape then becomes more complex, and it may be highly elliptical, 
non-elliptical, or it may have several inner and outer loops.

Inner loops presented in a Lissajous orbit plot can indicate a hit and bounce type 
condition. This phenomenon occurs when the shaft comes in contact with the 
bearing surface and bounces off.

In early stages of contact, a flat spot in the orbit plot will be presented. As the 
condition becomes more severe, the number of loops present will increase and 
become tighter. Detailed analysis of the orbit plot can indicate exactly where the 
shaft is coming into contact with the bearing in question. This figure shows a 
non-filtered orbit plot of the same shaft as discussed above.

Figure 3 - Non-filtered Orbit Plot

In the Filtered plot, only 1X frequency information appears in the orbit. In this 
case, the rub condition presented would have been overlooked if only a 1X orbit 
was taken. In general, a filter of OVERALL in the Emonitor software specified 
for the orbit plots will give the most useful information. 

To adequately define an orbit of a machine shaft, it is first necessary to know the 
approximate shaft speed and how many orders of the shaft speed are to be 
included in the measurement. A spectrum analysis (FFT) of the signals can be 
used to determine the number of orders.

Unless the measurement is synchronized with a trigger (or a once-per-rev phase 
reference pulse), it is not possible to relate the orbit shape to the rotational 

Inner loops
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position of the shaft. There is a mark on the orbit to show the location of the 
shaft at the time of the trigger event.

Assuming pickups are located 90 degrees apart and there is a phase reference 
pickup providing a once-per-revolution pulse to trigger the data collection, you 
can use orbits to distinguish common faults in machines equipped with plain 
bearings.

A typical machine with normal to moderate unbalance, and no other major 
faults, shows a simple orbit, corresponding mostly to the once-per-rev 
component, which really dominates. 

See1X Orbit Plot on page 171 on.

Misalignment tends to add significant levels of vibration to the shaft at once-per-
revolution, but also at higher orders of running speed. The once-per-revolution 
component from misalignment is not in phase with the unbalance component. 
The effect is to make the orbit plot less circular and more elliptical or even non-
elliptical, for example, a banana-shape or a figure-eight pattern.

See Resonance and Excessive Bearing Wear on page 172. 

Resonance and excessive bearing wear also tend to produce elliptical orbits. If the 
contribution is due to resonance, this condition can be pinpointed if the orbit 
changes noticeably with changes in running speed.

Figure 4 - Resonance and Excessive Bearing Wear

If a shaft comes close to a bearing surface or actually contacts it, the orbit takes on 
a different set of characteristics. Shaft rub tends to flatten the orbit, associated 
with the increased resistance to the radial movement of the shaft as it comes close 
or contacts the bearing surface, once per revolution. The orbit of a shaft with rub 
has a shape similar to whirl, except that the internal loop remains fixed and does 
not rotate, as it is occurring at an exact submultiple of the shaft rotation speed. 
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Figure 5 - Complex Orbit

As a rub becomes more severe or continuous, then the orbit becomes more 
complex and possibly erratic, with bearing structural resonances being excited 
and multiples of subsynchronous frequencies showing up.

Mechanical looseness caused by excessive wear tends to produce an orbit similar 
to that of a rub. Subsynchronous effects show up as secondary loops. However, in 
this case, shaft movement may be in a forward direction, rather than the reverse 
direction that is typical of a rub.

Figure 6 - Typical Orbit Plot 

See the Emonitor software online help for more information.

Set Up Orbit Measurements Definitions in the Emonitor Software

The Emonitor software and the Dynamix 2500 data collector support orbit 
measurement definitions. This topic lists the unique characteristics of the data 
collector that you may need to know when setting up and collecting orbit data:

• Set up a location in the Location pane for the two input channels. 
The Location IDs must be different. Set the Lo. Channel for the first 
location to 1. Set the Lo. Channel for the second location to 2.

• Set up a Collection Specification with Transducer set to Displacement.
• Set up a time measurement definition and a numeric measurement 

definition for both locations. 
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The measurement definitions must be the same for both locations. The 
time measurement definition must be the first measurement definition in 
the spreadsheet. Make sure the numeric measurement definition has the 
same units, collection specification, and storage as the time measurement 
definition.

• Make sure to set Data collector filter type to Analog when you define the 
order filters.
See Measurement Filters on page 67 for more information.

• Assign the same group number to the locations to collect the measurement 
properly.

To set up the orbit measurements in the Emonitor software, follow these steps.

1. Select the machine in the Hierarchy Tree for which you want to set up 
orbit measurements.

2. In the Location pane, create the first location and set Lo. Channel to 1.

3. In the Measurement definition pane, create the time measurement 
definition by setting Data Type to Time.

4. Set Collection to the collection specification that you created for the orbit 
measurement. 

5. Select the appropriate order Filter. 

6. Select the measurement definition that you just created.

7. Choose Edit > Copy to copy the time measurement definition.

8. Move to an empty row in the Measurement Definition pane and choose 
Edit > Paste to paste the new measurement definition into the spreadsheet.

9. Edit the new measurement definition. Change Data Type to Numeric and 
the Filter to None.

10. In the Location pane, select the location that you just created. 

11. Choose Edit > Copy to copy the location.

TIP If the Lo. Channel is not in the Location pane, choose 
View > Pane Options to add the column. 

Press F1 in the Pane Options dialog box for assistance.

TIP An Order-based filter may be used for isolating 
mechanical defects related to operational running 
speed. However, in order to see all potential defects, 
non-harmonic related, an Overall filter must be applied. 
See Non-filtered Orbit Plot on page 171.
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12. Move to an empty row in the Location pane and choose Edit > Paste to 
paste the new measurement definition into the spreadsheet.

13. Edit the new location. 
Make sure you change the Location ID and set Lo. Channel to 2.

14. Now include these locations in a list. 
You can create a new list or recall the current list. The locations must be 
tagged to create a group list.

15. Double-click the Group column in the Location pane to add the two 
locations to a group list.
The current group numbers appears in the Group column. 

16. Assign the locations the same group number. The group is then loaded 
with the list to the Dynamix 2500 data collector.

Figure 7 - Typical Orbit Measurement Setup.

17. Connect the data collector to the computer and load the list to the 
Dynamix 2500 data collector.
See Loading Lists to the Data Collector on page 113 for details.

18. Select the route and collect the orbit measurement.
See Collect Orbit Measurements on page 178.
See Select a Route on page 131 assistance in selecting a route.

Filter selection is crucial to collecting 
proper data. An Overall filter is 
recommended for analyzing all 
frequencies. A 1st Order is recommended 
for isolating anomalies related only to 
unbalance. 

IMPORTANT To view the orbit measurements in an orbit plot in the Emonitor 
software, you must enter the orientation of the sensors from 
which data is being collected for each channel in the Lo. 
Sensor Orientation column.
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Set Up Offroute Orbit Measurements

1. Select Data Collection from the Main Menu and press the Enter key. 

The Data Collection screen appears.

2. Select the route and measurement point.
See Select a Route on page 131 for more information.

3. Press F2 (Offroute) to collect an Offroute measurement. 
The Offroute screen appears.

4. Select the Orbit icon to store an Offroute orbit measurement at the 
current point. 
The Offroute Orbit Setup screen appears.

5. Select the parameter and press the Right arrow to display the choices.
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6. Select the parameter with the arrow keys, or type in a value.

7. Press the Left arrow to save your choice. 
Use the descriptions in Offroute Orbit Parameters on page 177 to help you 
configure the options in the Offroute dialog box.

When you are finished setting up the parameters, you can collect the 
Offroute measurement.
See Collect Orbit Measurements on page 178 for more information. 

TIP The Units, Transducer, Filter, and Sensitivity apply to 
both channels. The two input channels are X and Y.

Table 1 -  Offroute Orbit Parameters 

Parameter Description Values/Comments

Units Sets the measurement units for the 
transducer. 

Disp (mil)

Disp (µm)

Transducer The transducer used to collect this 
measurement.

Prox Probe

Accel

Sensitivity The sensitivity of the transducer.

The sensitivity value is included with the 
transducer’s documentation or it may be 
imprinted on the side of the transducer.

200 mV/EU (default)

Trigger Determines whether the trigger is on or off.

When Trigger is set to Off the rpm value must 
be entered during data collection.

On

Off

Ext Trig Slope The input signal slope to be used for externally 
triggering the measurement

+ve

Defines the trigger event to occur on a rising 
edge.

-ve

Defines the trigger event to occur on a falling 
edge.

+ve

-ve

Level The amplitude level for externally triggering 
the measurement.

The level is a percentage of the trigger full 
scale range.

2.0 (default)
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Collect Orbit Measurements

Once you have selected the route and have finished setting up the orbit Offroute 
parameters, you can begin collecting the data. 

Follow these steps to collect data.

1. Attach the transducer to the correct location.

2. Press Enter to start ranging your measurement for the current point.
The Dynamix 2500 data collector ranges and collects the data.
The measurement screen appears.

IMPORTANT If Trigger (Offroute Orbit parameter) is set to Off, the Specify rpm 
dialog box appears when collecting an Offroute orbit measurement. 

You must specify the rpm:

• Press F2 (dBase) to use the rpm downloaded with the route.
• Press F3 (Type In) to manually enter the rpm value
• Press F4 (Spec) to take the rpm from a spectrum.

If you press F4 (Spec), a spectrum appears on the screen. Position the 
cursor on the peak that represents the machine running speed and 
press F2 (OK).

The rpm value that is specified is used to set the Fmax appropriately 
and the order filtering frequency.

The bDase function 
appears only if a rpm 
value is downloaded 
with the route. 
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3. Use the Up and Down arrows to expand and compress the orbit.

4. Press 0 (Shift) and F4 (View).

5. Select the View option to display the Time Waveform, x1, x2 or x3. 

6. Select Timewave and Press F4 (View) to display the time plot.
The following screen appears.

View Options

The View options for orbit points are the following:

• Orbit View (default)
• Point Info
• Time X Time Y
• 1x
• 2x
• 3x
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Follow these steps to display the view options for orbit measurements.

1. Press 0 (Shift) to display the second set of functions.

2. Press F4 (View). 

3. Select an options and click Apply.

4. Use the Left and Right arrows to move the frequency cursor. 

5. Use the Up and Down arrows to move the amplitude cursor.
The Y-axis and X-axis are synchronized, which means the cursors are in the 
same position on each trace in the spectrum. The X and Y axis will move 
together, and magnify as the display is expanded.

6. Press the +/- key to expand and compress the time waveform spectrum 
plot.

7. If desired, press F3 (Notes) to assign inspection codes to each point. 
The Dynamix 2500 data collector unloads the inspection codes when you 
unload the unscheduled data to the Emonitor software.
See Inspection Codes and the Data Collector on page 105 for more 
information.

8. Once the Dynamix 2500 data collector collects the measurement, press 
Enter to accept the measurement. 

9. When you are finished viewing the data, press Enter or press F4 (Esc) to 
return to the Data Collection screen.

Review Route Data

Follow these steps to review route data.
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1. From the Route Manager screen, select the route you want to review. and 
press Enter.

2. Press F1 (Review). 
The Review Orbit screen appears. 
See Review Orbit Data Screen on page 182 for more information.

Review Offroute Data 

1. From the Route Manager screen, select the route you want to review. and 
press Enter.

1. Press F2 (Offroute). 

The Offroute screen appears.

2. Press F1 (Review) to review the Offroute data. 
The Review Data screen appears. 
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3. Select the point that you want to review and press F2 (Review). 
For information on signature data, see Reviewing Data on page 161.
For information on orbit data, see Review Orbit Data Screen on page 182. 

Review Orbit Data Screen

The Review Orbit Data screen lets you view the data in an orbit plot. 

See Understanding an Orbit Plot on page 170 for more information about 
orbit plots.

• To expand or compress the orbit, press the Up and Down arrows.
• To view the data in a time waveform, select Time X & Time Y from the 

View menu.
• Use the Left and Right arrows to move the frequency cursor.
• Use the Up and Down arrows to move the amplitude cursor. 

The cursor values appear above the signature data. 

Cross Channel Phase 
Measurements

The Emonitor software and the Dynamix 2500 data collector support cross 
channel phase measurement definitions. This topic lists the unique characteristics 
of the Dynamix 2500 data collector that you may need to know when setting up 
and collecting cross channel phase data:

• Set up a location in the Location pane for the two input channels.
• Set the Lo. Channel for the first location to 1. 
• Set the Lo. Channel for the second location to 2.

IMPORTANT The Y-axis and X-axis are synchronized, which means the cursors are 
in the same position on each trace in the Signature Data screen. The 
X and Y axis will move together, and magnify as the display is 
expanded.
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• Set up a Collection Specification with Transducer set to Accelerometer.
• Check the Also collect phase data checkbox and set Channel phase to Dual 

Channel.
• Set up a magnitude measurement definition for both locations. 

Phase Tables

Phase is displayed as a table of magnitude/phase pairs of up to 8 orders. In a dual 
channel display, the top trace displays the first channel and the lower trace is the 
second. Boost values and cursor moves are applied to both traces, whether 
displayed or hidden.

Use the up/down arrows to scroll through the phase table values. When you are 
finished collecting and viewing the cross channel phase measurement data, press 
Enter to store your data.

The measurement definition is the same for both channels.

Multi-channel Cursor, Display Expand, and Full Scale 
Adjustments

For multi channel measurements, the cursor operates simultaneously on all traces 
(even if one is hidden). This is also true for Full Scale adjustments using the Up 
and Down arrows (amplitude axis). You can use the + and - keys to adjust the 
display and expand (frequency/time axis).

Independent Autoranging

For two channel measurements, autoranging is performed simultaneously on 
both channels. This lets you use two probes of differing sensitivity. You can 
analyze two axes of differing amplitudes while ensuring optimum gain setting for 
each channel.
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In all cases, the same filters, integrator, and Fmax are used on both channels. 
However, input range and coupling are independent.

For cross channel phase, dual time and dual spectrum measurements, if the 
collection specification is Overall and Spectrum or Overall Only, then the overall 
value is calculated from the spectrum as an RSS overall. There is no support for 
two channel analog overalls.

Triggerless Operation

Most two channel measurements use a trigger to establish running speed. 
However, the running speed can be manually entered, or taken from a spectrum 
by positioning the cursor on the 1X spectral peak.

Orbits typically require a trigger. If you don’t define a trigger, the display shows a 
random moving cursor around the trace and has no useful meaning. Therefore, 
the cursor is not displayed when operating in triggerless mode with orbits. With 
orbits, the specified rpm value is used to set both the Fmax and the frequency 
used to configure the orbit input filters.

Set Up Cross Channel Phase Measurement Definitions in the 
Emonitor Software

To set up the cross channel phase measurements in the Emonitor software, follow 
these steps.

1. Select the machine that you want to set up cross channel phase 
measurements.

2. In the Location pane, create the first location and set Lo. Channel to 1.

3. In the Measurement Definition pane, create the magnitude measurement 
definition by setting Data Type to Magnitude. 

4. Set Collection to the collection specification that you created for the cross 
channel phase. Select a band Filter, for example, 1st Order.

5. In the Location pane, select the new location that you just created. Choose 
Edit > Copy to copy the location.

6. Move to an empty row in the Location pane and choose Edit > Paste to 
paste the new location into the spreadsheet.

7. Edit the new location. Make sure you set Lo. Channel to 2.

8. Include these locations in a list. You can create a new list or recall the 
current list. The locations must be tagged to create a group list.
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9. Add the two locations to a group list by double-clicking the Group column 
in the Location pane. 
The current group number appears in the Group column. Make sure you 
assign the locations the same group number. The group is then loaded with 
the list to the Dynamix 2500 data collector.
Cross Channel Phase Measurement Definitions on page 185 shows a 
typical setup for a cross channel phase measurement.

Figure 8 - Cross Channel Phase Measurement Definitions

10. Connect the data collector to the computer and load the list to the 
Dynamix 2500 data collector.
See Load Selected Lists to the Data Collector on page 119 for details.

11. Once you have prepared the Dynamix 2500 data collector for data 
collection, select the route and collect the cross channel phase 
measurement. 
See Collect a Cross Channel Phase Measurement on page 188.

Set Up an Offroute Cross Channel Phase Measurement

The Cross Channel Phase Offroute measurement is configured by creating a user-
defined measurement point. The Dynamix 2500 data collector keeps the user-
defined parameters until you collect another measurement point or press F2 
(Default) on the Offroute User screen.

See Create and Collect a User-defined Point on page 152 for more information.

1. Select Data Collection from the Main Menu and press the Enter key.

The Data Collection screen appears.

2. Select the route. The Dynamix 2500 data collector always associates 
Offroute measurements with a list.
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3. Press F2 (Offroute) to collect an Offroute measurement. The Offroute 
screen appears.

4. Press F2 (User). The Offroute User screen appears.

5. Select Display Format and press the Right arrow key to display the format 
choices.

6. Select Phase and press the Left arrow key to save your choice.

7. Select Input Channel and press the Right arrow key to display the input 
channel choices.

Press F2 (User) to create a 
user-defined point.
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8. Select X&Y and press the Left arrow key.

9. Change the other parameters as needed.
See Offroute Orbit Parameters on page 177 for assistance.

10. You are now ready to collect the cross channel phase measurement.
See Collect a Cross Channel Phase Measurement on page 188.
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Collect a Cross Channel Phase Measurement

A cross channel phase measurement displays the spectra for input channels X&Y, 
and the relative phase angle between the two input channels. The phase 
difference between the two inputs is measured. 

This is known as relative phase. Spectra for both input channels are stored, and 
the relative phase between the two channels is displayed as a table of magnitude/
phase pairs of up to 8 orders of running speed.

1. Connect the proper transducer and attach it to the correct location.

2. Press Enter to start the measurement. 
The Specify rpm dialog box appears.

• Press F2 (dBase) to use the rpm downloaded with the route.
• Press F3 (Type In) to manually enter the rpm value.
• Press F4 (Spec) to take the rpm from a spectrum 

The data collector ranges and collects the data and the measurement screen 
(phase table) appears.

TIP If you press F4 (Spec), a spectrum appears on the screen. 
Position the cursor on the peak that represents the 
machine running speed and press F2 (OK).

This function appears only if a rpm 
value is downloaded with the route. 
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View Options

The View options for a cross channel phase point are the following:

• Two Chan Cross Phase: Default View
• Point Info
• Two Chan Cross Phase: Phase Details
• CH 1(X) FFT: Default View
• CH1 (X) FFT: No Overall
• CH2 (Y) FFT: Default View
• CH2 (Y) FFT: No Overall

The Y-axis and X-axis are synchronized, which means the cursors are in the same 
position on each trace in the Signature Data screen. The X and Y axis will move 
together, and magnify as the display is expanded:

• Press the Left and Right arrow keys to move the frequency cursor. 
• Press the Up and Down arrow keys to move the amplitude cursor.
• Press the +/- key to expand and compress the spectrum plot. 
• Press F3 (Notes) to assign inspection codes to each point. 

The Dynamix 2500 data collector unloads the inspection codes when you 
unload the unscheduled data to the Emonitor software.
See Inspection Codes and the Data Collector on page 105.

3. Once the Dynamix 2500 data collector collects the measurement, press 
Enter to accept the measurement. 
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Review Cross Channel Phase Data

The data for you to review is displayed at the top of the Data Collection screen.

Review Route Data

1. From the Route Manager screen, select the route you need to view and 
press Enter.

2. Press F1 (Review).

Review Offroute Data 

1. From Route Manager screen, select the route to review and press Enter.

2. Press F2 (Offroute). 

IMPORTANT The Y-axis and X-axis are synchronized, which means the 
cursors are in the same position on each trace. The X and Y axis 
will move together, and magnify as the display is expanded.
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The Offroute screen appears.

3. Press F1 (Review) to review Offroute data. 
The Review Data screen appears. 

4. Select the point that you want to review and press F2 (Review). 
See Review Data on page 164 for more information on the Signature Data 
screen. 

IMPORTANT The Y-axis and X-axis are synchronized, which means the 
cursors are in the same position on each trace in the Signature 
Data screen. The X and Y axis will move together, and magnify 
as the display is expanded.
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Dual Channel 
Measurements

The Emonitor software and the Dynamix 2500 data collector support dual 
channel measurements definitions. 

Set Up Dual Channel Measurement Definitions in the Emonitor 
Software

Follow these steps to set up a dual channel measurement.

1. Set up a location in the Location pane for the two input channels. 

The Location Ids must be different. Set Lo. Channel for the first location 
to 1. And set Lo. Channel for the second location to 2.
The measurement definitions must be the same for both locations. 

2. Assign the same group number to the locations to collect the 
measurements properly.

Follow these steps to set up the dual channel measurements in the Emonitor 
software.

1. Select the machine in the Hierarchy Tree for which you want to set up the 
dual channel measurements.

2. In the Location pane, create the first location and set Lo. Channel to 1.

3. In the Measurement Definition pane, create the measurement definition.

4. In the Location pane, select the new location that you just created. Choose 
Edit > Copy to copy the location.

5. Move to an empty row in the Location pane and choose Edit > Paste to 
paste the new location into the spreadsheet.

6. Edit the new location. Make sure you set Lo. Channel to 2.

7. Include these locations in a list. You can create a new list or recall the 
current list. The locations must be tagged to create a group list.

8. Add the two locations to a group list by double-clicking the Group column 
in the Location pane. 

IMPORTANT Make sure the measurement definitions are not similar to 
either the orbit measurement definitions or the cross channel 
phase measurement definitions. You may get unexpected 
results.
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The current group number appears in the Group column. Make sure you 
assign the locations the same group number. The group is then loaded with 
the list to the Dynamix 2500 data collector.
This figure shows a typical setup for a dual channel measurement.

Figure 9 - Dual Channel Measurement Definitions

9. Connect the data collector to the computer and load the list to the unit.
See Load Selected Lists to the Data Collector on page 119.

10. Once you have prepared the unit for data collection, select the route and 
collect the dual channel measurement. 

Collect an Offroute Dual Channel Measurement

The Dual Channel Offroute measurement is configured by creating a user-
defined measurement point. The Dynamix 2500 data collector keeps the user-
defined parameters until you collect another measurement point or press F2 
(Default) on the Offroute User screen.

See Create and Collect a User-defined Point on page 152 for more information.

1. Select Data Collection from the Main Menu and press the Enter key. 

The Route Manager screen appears.

2. Select a route. 

3. Press F2 (Offroute) to collect an Offroute measurement. 
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The Offroute screen appears.

4. Press F2 (User). 
The Offroute User screen appears.

5. Select Display Format and press the Right arrow to display choices.

6. Choose a Display Format and press the Left arrow to save your choice.
See Offroute User Parameters on page 156 for details about the Offroute 
User screen.

Press F2 (User) to create a 
user-defined point.

Select a display format.
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7. Select Input Channel and press the Right arrow to display the input 
channel choices.

8. Select the channel and press the Left arrow key.
See Connector A and Connector B Inputs on page 19 for complete 
information on the connectors and related channels.

9. Change the other parameters as needed.
See Offroute User Parameters on page 156 for assistance.
You can also set the Acquisition parameter in the Instrument 
Configuration screen to Single Shot or Continuous.
– In Single Shot mode, the unit halts when the data collector has settled 

and the data is stable. 
– In Continuous mode, the unit constantly analyzes and displays the 

moving signals until you store the data by pressing the Enter key.
See Instrument Configuration Parameters on page 59.

10. You are now ready to collect the dual channel measurement.
See Collect a Cross Channel Phase Measurement on page 188.
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Magnitude and Phase 
Offroute Measurement

Follow these steps to collect a magnitude and phase measurement Offroute. 

1. From the Route Manager screen, select the route that you setup in the 
Emonitor software as magnitude and phase.

2. Press Enter.

3. Press F2 (Offroute).

4. Press F2 (User).

5. Set Collection to Sig Only.

6. Set Display Format to Phase.
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7. Press Enter to start taking the measurement.

8. Point the data collector.

Notice that the Laser Tach is operational. 

9. When the measurement stabilizes, press Enter to store the reading.

Multi-channel Measurements You can collect measurements from a combination of X, Y, Z, R channels. When 
collecting data the multiple measurements are collected simultaneously and 
displayed on the Spectrum Display screen.

Collect a 4-channel Measurement

The 4-channel activation, catalog number 1441-DYN25-M4CH, is available as 
an upgrade for the Dynamix 2500 data collector. A cable assembly is required 
also, catalog number 1441-DYN25-CBL2CH.

These are the 4-channel functions.

• Simultaneous 4-channel magnitude
• Simultaneous 4-channel time waveform
• Simultaneous 4-channel spectra
• Offroute measurements

See Install Optional Extension Modules on page 205 for complete information 
on how to install an extension module.

TIP You press F1 (Config) on the Route Manager screen to set the trigger. You 
can also set the trigger on the Instrument Configuration screen by 
pressing 0 on the Data Collection screen:

• Set the trigger to Laser Tach if using the internal trigger.
• Set the trigger to External if using a external trigger device.

ATTENTION: When the laser on the data collector is active, viewing the 
laser beam can expose your eyes beyond the maximum permissible 
exposure recommendations and cause harm.

IMPORTANT The data collector supports the 4-channel functionality. Currently the 4-
channel route function is not supported in the Emonitor software. A 
future release of the Emonitor software will have this capability.
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Collect Multi-channel Measurements

For multi-channel measurements, the cursor operates simultaneously on all 
traces, even when hidden. This applies to adjustments using the Up and Down 
arrows (amplitude axis), and the +/- adjusts the display/expand(frequency/time 
axis).

See Connector A and Connector B Inputs on page 19 for complete 
information on the connectors and related channels.

Taking a two or more channel point requires two or more sensors, using 
Connector A and B. A multi-channel measurement displays a spectral for each 
channel. On the Offroute User screen, you can configure Offroute multichannel 
measurements.

Follow these steps to take a multi-channel measurement.

1. Connect the transducer and attach it to the correct location.

2. Select the Display format as Spectrum or Time.

3. Select the Input Channels X & Y & Z &R.

4. Press Enter to start the measurement.
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The Dynamix 2500 data collector ranges and collects the data. By default, 
all traces are displayed on the measurement screen. 

Item Description

Overall value The measurement’s overall value displays in the upper left corner.

Cursor position/
amplitude

Use the Left and Right arrows to move the time waveform’s cursor. 
The cursor position and amplitude display in the upper right corner.

Percent Changed 
Bar

Provides information about the overall value of the measurement in 
comparison to alert and danger alarms (yellow and red arrows, 
respectively) and to the previous measurement (green arrow).

The current measurement value is represented by the colored bar, 
which appears red if the point is in alarm, yellow if it is in alert, and 
green if there is no alarm.

If the measurement amplitude extends beyond the display, an `overall 
overflow’ indicator appears at the top of the bar as a small, gray 
arrow. 

The bar also displays the percentage of change from the previous 
overall reading. A positive percentage indicates the measurement is 
greater than the previous reading. A negative percentage indicates 
the measurement is less than the previous reading.

Input channel

Scale

Cursor
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View Options

Use the view menu to apply measurement view display. 

1. Press 0 (Shift) to display more functions.

2. Press F4 (View).

3. Select a view option and press F4 (Apply).
Each X, Y, Z and R measurement can be displayed independently as 
follows.

This is the channel Y measurement.
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4. Once the Dynamix 2500 data collector collects the measurement, press 
Enter to accept the measurement. 

Table 2 - Screen Navigation Functions Descriptions

Screen Function Description

Y-Axis Graph Scaling Adjustment You can use the Up and Down arrows to manually adjust the y-
axis graph scaling on the spectrum. This lets you re-scale the 
plot to get a closer look at low amplitude components:
• Up arrow decreases the Y-axis graph scale setting by ½ of its 

current setting.
• Down arrow doubles the Y-axis graph scale setting.

Harmonic Markers The H key displays harmonic markers for the current cursor 
position.
Harmonic markers rapidly locate integral orders in relation to 
their fundamental (1X). 
The H key cycles the three harmonic cursor modes:
• Simple, no harmonic cursors.
• Harmonic, displays the harmonics of the current cursor 

position. The spectral cursor acts as the fundamental marker, 
and is re-positioned.

• Fixed, the harmonics remain fixed and cursor can be moved 
independently.

The default is Simple (off).

Peak cursor The P key lets you quickly jump the cursor to the next highest 
peak to the right of the cursor.

Display Expansion The +/- key graphically expands or compresses the frequency 
domain display range horizontally around the cursor position. It 
reveals characteristics that may be hidden by the display mode 
or by the resolution without changing data collection 
parameters.
When using +/-, the spectrum’s fmax setting expands and the 
spectrum reforms to the new fmax. You can repeat to continue 
to expand up to the maximum resolution (based on the number 
of lines of resolution for the spectrum), after which the function 
switches to compression.
Dot (.) key immediately toggles the +/- key between display 
expansion and compression.
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Collect a Tri-axial Measurement

The Tri-axial functionality offers advanced data collection in Route and Offroute 
with three channels of data collected simultaneously on X, Y and Z. Tri-axial 
measurement points can be setup by using the Emonitor software then 
downloaded to the instrument. 

1. Once the Dynamix 2500 data collector collects the measurement, press 
Enter to accept the measurement. 

2. When you are finished viewing the data, press Enter to proceed to the next 
point.

Overall value
Percentage 
change

Cursor
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View Options

These are the View menu options:

• Triax: Default View
• POINT Info 
• Triax: No Overall
• Ch1 FFT: Default View
• Ch1 FFT: No Overall
• Ch2 FFT: Default View
• Ch2 FFT: No Overall
• Ch3 FFT: Default View
• Ch3 FFT: No Overall

See Set Up Tri-axial Measurements on page 102 for more information.

Follow these steps to configure an Offroute tri-axial measurement.

1. From the Route Manager screen, select a route and press Enter.

2. Press F1 (Config).

3. Select either Single Shot or Continuous operation.
Single Shot halts when the instrument front end has settled and the data is 
stable, where as in Continuous mode the instrument constantly analyzes 
and displays the moving signals until you store the data by pressing Enter.

4. From the Offroute main menu, press F2 (User).
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On the Offroute User screen, you can configure Offroute tri-axial 
measurements.

5. Select the Display format as Spectrum or Time.

6. Select the Input Channel to X & Y & Z. 

7. Press Enter to start the measurement.
The Collecting Data screen appears.

TIP Tri-axial measurements can significantly speed-up route based data 
collection. A special tri-axial transducer kit is required. Contact your local 
Allen-Bradley distributor or Rockwell Automation sales representative.
204 Rockwell Automation Publication 1441-UM001B-EN-P - September 2012



Chapter 7

Installing Optional Extension Modules

The data collector uses the Extension Manager to install and uninstall extension 
modules. These extension modules are licensed and ordered separately from the 
basic entry level product.

Install Optional Extension 
Modules

The installation Secure Digital (SD) cards that you receive work with any 
Dynamix 2500 data collector. Once you have installed an extension module on a 
the data collector, the card is locked so that it can be used only with that 
instrument. 

You can uninstall extension modules, if required. When uninstalling an extension 
module, you have the option to free up the license so that it can be used to install 
the extension module on another data collector. This allows the extension 
module to be transferred between units.

Follow these steps to install an extension module.

1. Open the base cover at the bottom of the Dynamix 2500 data collector.

2. Place the extension module SD card contact-side-up into the unit until it is 
firmly seated in place. 

3. Close the base cover.

4. Apply power to the data collector.

Topic Page

Install Optional Extension Modules 205

Uninstall an Extension Module 207

Manage Extension Modules 209

IMPORTANT One installation SD card is required for each instrument that needs to 
be upgraded.

IMPORTANT When ever you re-run the OS Loader software, you will re-load only the 
main OS firmware. The OS loader will backup licence files and data, but 
not the optional extension modules. Once you have updated the OS 
firmware, install the latest version of your optional extension modules.

See Updating the Operating System on page 34, for more information.
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5. From the Main menu, select Setup Utility and press Enter.

6. Press 0 (Shift) to display the second set of functions.

The Extension Manager function remains on the screen for about three 
seconds after releasing 0 (Shift Key). 

7. Press F1 (Extn Mgr).

The Extension Manager screen appears.

8. Press 0 (Shift) to display the Install Extension function.

9. Press F2 (Install) to install the new extension module.

When the installation is complete, a confirmation prompt appears.

Extension Manager
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10. Press F4 (OK).

The new extension module appears in the list.

11. Press F4 (Esc) to exit the Extension Manager screen.

Uninstall an Extension 
Module

Follow these steps to uninstall an extension module.

1. Press 0 (Shift) from the Setup Utility screen to display the Extension 
Manager function. 

The Extension Manager function remains on the screen for about three 
seconds after releasing 0 (Shift). 

2. Press F1 (Extn Mgr). 

Extension Manager
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The Extension Manager screen appears.

3. Select the extension module you want to uninstall and press F3 (Select). 

F3 (Select) toggles the selection on and off.

A checkmark appears next to that extension module.

4. Press F1 (Uninstall). 

A confirmation message appears.

5. Make sure your installation card is inserted into the unit.

TIP You must have the correct extension module card inserted to remove that 
option. If the wrong card or no card is inserted then a message displays 
telling you to insert the correct card.

This screen lists the 
extension modules 
currently installed and the 
on the unit.
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See Insert and Remove a Storage Card on page 64 for more information.

6. Press F2 (Yes) to uninstall the extension module.

7. Press F4 (Esc) to exit the Extension Manager screen.

Manage Extension 
Modules

The Dynamix 2500 data collector lets you to hide installed extension modules 
from the Main menu. You may need to hide an advanced extension module icon 
from an inexperienced user, for example, RuCD and FRF. Also, you can use the 
Extension Manager to also show previously hidden icons.

Follow these steps to hide or show an extension module icon on the Main Menu.

1. Press 0 (Shift) on the Setup Utility screen to display the Extension 
Manager function.

The Extension Manager function should remain on the screen for 
approximately three seconds after releasing 0 (Shift).

2. Press F1 (Extn Mgr). The Extension Manager screen appears.

IMPORTANT The extension module is uninstalled and the license on the card is 
released so that the card can be used to install the extension 
module on another Dynamix 2500 data collector. 

If the installation card is not inserted in the data collector and no 
card is found or the card does not have the extension module 
license for the unit, you are prompted to insert the correct 
installation card or continue without freeing the license.

IMPORTANT Once an extension module is hidden, its icon is not represented on the 
Main Menu or displayed in the Dynamix 2500 data collector About 
screen.
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The Extension Manager displays a list of installed extensions module. 

The F2 function key toggles between Hide and Show depending if the 
highlighted extension module is hidden or not.

3. Select the extension module that you want to hide or show and press F2 
(Show/Hide). 

4. Press F4 (Esc) to exit the Extension Manager.

TIP You have to exit and re-enter the Extension Manager after hiding an 
extension module to have the Show function appear.

TIP If you want to show or hide multiple extension modules 
simultaneously, highlight each extension module and press F3 
(Select).

A checkbox appears next to each selected extension module. If 
you select multiple extension module and some are hidden while 
others are shown, F2 (Show/Hide) reflects the status of the 
highlighted extension module. 

The extension modules that 
are hidden are shown in 
[square brackets].
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Symbols
+/- key 18

Numerics
0 (Shift) key 18
2CHEnable 112

A
accel measurement 150
accel time measurement 150
acquisition 60
active collector 85
ActiveSync 30, 34, 108
add application to data collector 205
alarms

in the data collector 104
magnitude 87
numeric measurements 94
overriding collect on alarm 117
selecting alarms to load 104
setting trigger for loading 87
spectrum in the data collector 97
supported in data collector 104
Trigger 104

auto advance
display spectrum in data collector 60
instrument configuration parameter 60

auto reports on unload 126, 168
auto store

instrument configuration parameter 60
moving through a list 133

autoranging 61
averages 158
averaging

exponential 80
host software 80
linear 80
Offroute 158
peak hold 80
time synchronous 80, 95, 99

B
band filters 87
bands in host software 87
battery

capacity 24
checking 18, 24
inserting 26
removing 26
status icons 25

battery status icons 25
baud rate

setting in host software 111
bin zeroing 158
bitmap, screen captures 168

C
calibration 27
capturing screens 168
Change Name 156
collecting data

cross channel phase measurements 188
dual channel measurements 198
lists 131
magnitude and phase measurements 146
magnitude measurement 141
numeric measurements 138, 139, 141, 142
off route pre-defined measurements 150
Offroute 149
orbit measurements 178
preparing 129
process (DC) voltage measurement 139, 141
settings 130
spectrum measurement 142
time waveform measurement 145

Collection 156
collection specification

averaging 80
for magnitude and phase 91
input types 76
maximum frequency 78
measurement resolution 79
numeric measurement 94
options 75
overview 75
phase 89
signal detection type 77
spectrum measurement definitions 98
time waveform 100
transducer specification 76
unable to change 75
voltage measurements 101
window types 77

collection time, TWF 80
communication

installing ActiveSync 30, 108
overview 107
setting up 107
USB 107

configure
cross channel phase measurements 185
data collection parameters 57
dual channel measurements 193
instrument parameters 55
Offroute user parameters 155

connecting
Dynamix 2500 and computer using USB port 

107
hardware to data collector 19

contrast, changing display 47
cross channel phase measurements

collecting data 188
measurement definintions 182
reviewing data 190
setting up 185

Current Baud 112
current data collector, selecting 110
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Current Parity 112
cursor

peak 166

D
data

reviewing 164
data collection configuration

overview 130
settings 57

Data Collection screen 51
data collector

active 85
alarms 104
choosing current 110
display contrast 47
driver version number 120
hardware resetting 42
magnitude alarms 87
operating system version number 46
rebooting 42
selecting active 85
spectrum alarms 97

Data Collector Advanced Settings 
parameters

2CHEnable 112
Current Baud 112
Current Parity 112
Datapac Enumeration 112
Direction 112
Log Display 112
Machine Speed 112
Operating System 112
Phone Number 112
Position 112
Sync Trigger Level 112
Sync Trigger Slope 112
Sync Trigger Type 113
Trigger Range 113

Datapac Enumeration 112
date

format 50
setting 50

Date Format 56
Date/Time 56
decimal key 18
default filters 72
deleting data 168
deleting lists

automatically before loading 114
manually 115

Detection 157
Dflt Units 56
Diagnostic 83
diagnostic frequencies

loading 83
overview 82

Diagnostic Frequency cursor 166
loading 83

viewing 166
diagram

battery 26
hardware connection 19
hardware reset 42

digital overall 73
Direction 112
display

changing contrast 47
Display Format 156
Down arrow key 18
dual channel measurements

collecting data 198
measurement definitions 192
setting up 193

Dynamix 2500
assembling strap 23
basic operations 51
battery pack 24
external connectors 19
main screens 45
online help 11
status indicator 22

E
Engineer Mode Menu 43
Enter/Read/Fire/OK key 18
Envelope 56
envelope filters 69, 70
ESP

filters in host 70
off route pre-defined measurement 150

exponential averaging 80
Ext Trig Slope 158, 177
Extension Manager 205

uninstall application 207

F
ƒ1 through ƒ4 overview 18
Fast Averaging 59
FFT

See spectrum measurements
Filter 157
filters

band 87
default in host software 72
ESP 70
gSE 69
high pass 70
in host software 67
order 71
Overall in host software 73

firmware 34, 37
Flattop window

host software 77
off route measurement 158

Fmax
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Offroute user-defined option 157
See maximum frequency

Freq Units 59
frequency items 82
frequency labels

loading 83
full scale value, numeric measurements 92

G
gSE

filters in host 69
off route pre-defined measurement 150

H
Hamming window

host software 77
off route measurement 158

Hanning window
host software 77
off route measurement 158

hardware connection, diagram 19
help

accessing in Dynamix 11
high pass filters 70
high resolution measurement 150
hist data collect 63

I
initializing

automatically before loading 115
before loading a list 114
manually 115

Input channel 157
input type

AC coupled 76
DC coupled 76
Emonitor 76
host software 76
ICP accel 76
manual entry 76

inspection codes
entering 137
loading 105, 116, 137
overview 105

install ActiveSync 30, 108
Instrument Configuration parameters

Fast Averaging 59
Freq. Units 59

instrument configuration parameters
acquisition 60
auto advance 60
auto store 60

percent 60
time 60

autoranging 61
hist data collect 63

mach. speed 62
memory 62
multi meas view 63
setting delay 62
trig level 63
trigger 63

Instrument Setup parameters
Date Format 56
Date/Time 56
Dflt Units 56
Envelope 56
Language 57
memory 56
Navigation 56
Route Mem 56
Time Zone 56
Timeout 56
Trigger 56

Instrument Setup screen 48

K
keys

+/- 18
0 (Shift) 18
decimal 18
function keys overview 18
numeric 18
ON/OFF 18

L
Language 57
Left arrow key 18
Level 158, 177
linear average 80
Lines/Samples 157
lists

clearing in memory 121
deleting 114
in the data collector 105
inspection codes 116
loading 113, 119
Quickload 119
selecting 118
unloading 121

load files, creating 101
loading

alarms 104
frequency items 117
inspection codes 116
lists 119
Quickload files, rebuilding 127

locked up 42
Log Display 112

M
mach. speed 62
Machine Speed 112
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machine speed setup 83
machine speed, taking measurements 93
magnitude alarms 94
magnitude alarms in data collector 87
magnitude and phase measurements

collecting 146
overview 67, 89
reviewing 164
setting up 90

magnitude measurements
collecting 141
in bands 87
magnitude vs. overall values 147
proximity probes 87

Main Menu screen 45
manual entry 138, 139, 141, 142
maximum frequency

host software 78
measurement definitions

combining 101
cross channel phase measurements 182
dual channel measurements 192
ESP filters 70
filters 67
gSE filters 69
high pass filters 70
input types 76
magnitude and phase 67
magnitude in bands 87
maximum frequency 78
numeric 67, 92
orbit measurements 173
order filters 71
order normalized spectrum 95
resolution 79
setting up in host software 86
signal detection 77
spectrum 67, 98
time synchronous spectrum 95, 97
time synchronous TWF 99
time waveform 67, 98
tri-axial measurements 102
units 74
unsupported selections 85
voltage 100
window types 77

memory 56, 62
clearing 56, 62
deleting routes from active memory 56, 62
initialize active memory 56, 62

memory card
inserting and removing 64
overview 64

module licensing 40
multiple readings

unloading 122

N
Navigation 56
Note Codes

See inspection codes
numeric keys 18
numeric measurements

(DC) voltage 139, 141
full scale value 92
manually entering 138, 139, 141, 142
measurement definitions 67
RPM 93
setting up in host software 92
temperature 93

O
off route measurements

unloading 123
off route pre-defined measurements

collecting 150
Offroute 125
Offroute Measurement screen 151
Offroute measurements

collecting 149
methods for collecting data 149
overview 149
pre-defined 150

Offroute Orbit parameters
Ext Trig Slope 177

Level 177
Sensitivity 177
Transducer 177
Trigger 177
Units 177

Offroute Orbit Setup screen 176
Offroute pre-defined measurements

accel 150
accel time 150
ESP 150
gSE 150
high resolution point 150
opposite 150
Same 150
Velocity 150

Offroute User parameters
Averages

Overlap 158
Type 158

Change Name 156
Collection 156
Detection 157
Display Format 156
Ext Trig Slope 158

Level 158
Filter 157
Fmax 157
Input channel 157
Lines/Samples 157
Sensitivity 157
Units 156
Window 158

Offroute user parameters
averages 158
bin zeroing 158
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Offroute user-defined measurements
collecting 159
setting up 154

online help system
Dynamix 11

Operating System 112
operating system 34
opposite measurement 150
orbit measurements

collecting data 178
measurement definitions 173
reviewing data 181

orbit plots, understanding 170
order filters 71
order normalize

definining orders filters 71
spectrum measurements 95

OS Loader 35, 37
Overlap 158
overriding collect on alarm 117

P
parts list 15
peak cursor 166
peak hold averaging 80
peak signal detection, in host software 78
percent 60
phase measurements

collecting 146
setting up in host software 89
setting up order filters 71
tachometer signal 146

Phone Number 112
Position 112
powering down 29
powering up 29
printing

overview 168
reports automatically on unload 168

protocol, communication setting in host 
software 111

proximity probes
magnitude measurements 87
spectrum measurements 96

Q
Quickload files

rebuilding 127
saving time 119

R
rebooting data collector 42
Rectangular window

host software 77

off route measurement 158
reports

print automatically after unload 126
resetting data collector 42
resolution 79
Review Orbit Data screen 182
reviewing data

cross channel phase 190
orbits 181
signature 164
waterfall spectrum 167

Right arrow key 18
RMS signal detection, in host software 77
Route Mem 56
routes

collecting data 131
moving through 133
See also lists
selecting 131

RPM measurements 93
RSS filter 73

S
Same measurement 150
saving screens 168
screen capture

keys 168
overview 168

screens in data collector
 164
Data Collection 51, 132
help 11
Instrument Configuration 59
Instrument Setup 48
Main Menu 45
Notes 137
Offroute Measurement 151
Offroute User 155

Secure Digital (SD) card
See memory card 64

Sensitivity 157, 177
serial number

data collector 46
Set Active Collectors command 85
Set Up Collector 110
setting date and time 50
settling delay 62
Setup parameters 55
signal detection 77
skipping measurements 86
skipping measurements and machines 133
smart unscheduled mode 125, 159
spectral lines 79
spectrum alarms in data collector 97
spectrum measurements

collecting 142
measurement definitions 67, 98
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order normalized 95, 97
proximity probes 96
time synchronous 95, 97

spectrum, display in data collector 60
speed references 83
status indicators 22
Sync Trigger Level 112
Sync Trigger Slope 112
Sync Trigger Type 113

T
tachometer signal 146
temperature measurements 93
time 60
time samples

calculating 79
calculating time needed for collection 98

time synchronous averaging 80, 95
time waveform

collection time 80
measurement definitions 67
measurements 98
time synchronous averaging 99

time waveform measurements
collecting 145
reviewing 164

Time Zone 56
time/date

display 50
setting 50

Timeout 56
Transducer 177
transducer specification 75

input type 76
magnitude measurement definitions 88
numeric measurement definitions 94
spectrum measurement definitions 98
voltage measurements 101

tri-axial measurements
measurement definitions 102
setting up 102

trig level 63
Trigger 56, 104, 177
trigger 63
Trigger Range 113
Trigger to Yes in host software 87
true peak signal detection 78
true peak-peak signal detection 78
turning off 29

turning on 29
Two Channel 169

Offroute Orbit Setup screen 176
overview 169
Review Orbit Data screen 182

Type 158

U
uninstall application extension 207
Units 156, 177
units

in host software 74
Offroute user-defined option 156

unloading
lists 121, 122
multiple lists 119, 121
multiple readings 122
unscheduled data 123

unscheduled measurements
See also Offroute
storing in host software 159
unloading 123

unscheduled smart mode 125, 159
Up arrow key 18
update 34, 37
USB

communication with PC 107
User-defined point

screen 155

V
Velocity measurement 150
version number

data collector driver 120
data collector operating system 46

voltage measurements
collecting 139, 141
setting up 100

W
waterfall display 167
Window 158
window type

collection specification 77
flattop 77
Hamming 77
Hanning 77
rectangular 77
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Rockwell Automation Support

Rockwell Automation provides technical information on the Web to assist you in using its products. 
At http://www.rockwellautomation.com/support, you can find technical manuals, technical and application notes, sample 
code and links to software service packs, and a MySupport feature that you can customize to make the best use of these 
tools. You can also visit our Knowledgebase at http://www.rockwellautomation.com/knowledgebase for FAQs, technical 
information, support chat and forums, software updates, and to sign up for product notification updates.

For an additional level of technical phone support for installation, configuration, and troubleshooting, we offer 
TechConnectSM support programs. For more information, contact your local distributor or Rockwell Automation 
representative, or visit  http://www.rockwellautomation.com/support/.

Installation Assistance

If you experience a problem within the first 24 hours of installation, review the information that is contained in this 
manual. You can contact Customer Support for initial help in getting your product up and running.

New Product Satisfaction Return

Rockwell Automation tests all of its products to ensure that they are fully operational when shipped from the 
manufacturing facility. However, if your product is not functioning and needs to be returned, follow these procedures.

Documentation Feedback 

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this 
document, complete this form, publication RA-DU002, available at http://www.rockwellautomation.com/literature/.

United States or Canada 1.440.646.3434

Outside United States or Canada Use the Worldwide Locator at http://www.rockwellautomation.com/support/americas/phone_en.html, or contact your local Rockwell 
Automation representative.

United States Contact your distributor. You must provide a Customer Support case number (call the phone number above to obtain one) to your 
distributor to complete the return process.

Outside United States Please contact your local Rockwell Automation representative for the return procedure.

http://www.rockwellautomation.com/support
http://www.rockwellautomation.com/knowledgebase
http://www.rockwellautomation.com/support/
http://www.rockwellautomation.com/locations/
http://www.rockwellautomation.com/support/americas/phone_en.html
http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
http://www.rockwellautomation.com/literature/
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